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C H A P T E R
1 Introduction

The Data Navigation and Analysis Application

The Data Navigation and Analysis (from here on DNA) soft-
ware is an application designed for the Windows™ environ-
ment. DNA is a program that graphically renders data from 
acoustic and vibration measurements. It can be used with 
various measurement instruments, from simple sound level 
meters to the most sophisticated real-time spectrum analyz-
ers. Its goal is to help people involved in such measurement 
operations from the measurement execution to the final doc-
ument printout.

DNA will support Larson Davis Models 2800, 2900, 3000+ 
and 3200 real-time spectrum analyzers, the models 720, 812, 
814, 820 and 870 Sound level meters. DNA will also support 
the Model 824 and HVM100.

What can be done with DNA

The purpose of this software is to assist in bringing the mea-
surement data from your analyzer/Sound Level Meter to the 
final printed document. In the following list we summarize 
the features in DNA.
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DNA can read almost all the data that can be measured with the 
supported instrument models. Data can be gathered manually, 
stored in instrument memory and downloaded to a computer. 
Data can also be taken with the instrument controlled by the 
computer in order to overcome the instrument’s memory limita-
tions. With the instrument controlled by the application, long 
unattended measurements can be performed. Measurement and 
instrument setups are fully supported.

Documents can be designed in the same way as with other Win-
dows applications and a list of simple drawing tools is avail-
able. Images can be easily imported from other applications. 
Graphs can be defined to display your measurement data. Cre-
ate OLE (Object Linking and Embedding) objects inside your 
document.

Post process your measurement data. Recalibration, statistical 
analysis, signal editing, and frequency weighting are the main 
operations performed by the application.

Measurement data is stored inside the document. An unlimited 
number of measurements can be stored in a single document. 
All the document’s data (measurements, page layout, images 
data, etc.) are stored in a single disk file.

Once the document is ready, it can be printed on any device 
connected to your computer (printers, fax). Data and graphs can 
be exported to other applications via the clipboard. Documents 
can also be sent by electronic mail.

About this Manual

The DNA software consists of two main types of application 
windows. DNA also supports several Larson Davis analyz-
ers and sound level meters. To accommodate all of the dif-
ferent types of instruments, DNA has different analyzer 
windows for the different types of instruments. Chapters 3 
through 7 address these different types of analyzer windows. 
Not all chapters will apply to your instrument. Find the 
chapter that is appropriate for your instrument and use that 
chapter as a reference. The instruments that are supported by 
each chapter are reported in the chapter title.

Getting the data

Build the 
document 

Post process the 
data

Archive data

Export data
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How to run DNA

DNA must first be installed on your computer. Chapter 2 
gives a step-by-step installation procedure. Check that the 
required hardware is installed, and follow the installation 
procedure carefully. Note the different setup procedures for 
the different operating environments. Once the software is 
installed, open the Program Manager group named Larson 
Davis Programs and double-click the DNA icon, or from the 
Start menu find the DNA item and select it.

To exit from DNA select Exit from the File menu.
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C H A P T E R
2 Installation

Package contents

The DNA software is composed of this manual, one com-
pact disk, or one or more disks holding the program files, 
and the hardware key needed to run the application.

Hardware and Software required

DNA requires the following hardware and software configu-
ration:

• A personal computer IBM-PC or compatible.

• A floppy disk drive.

• A CD ROM Drive 

• A serial port and a parallel port

• A hard disk with at least 4MB free.

• One of the following operating systems:

• Windows 95

• Windows

• Windows NT (Intel version) version 3.51 or later.

• Windows

The software must be installed on a hard drive; it cannot be 
run from a floppy disk or CD ROM. It is recommended that 
at least 8 Megabytes be available for systems running Win-
dows 95 and 16 Megabytes for systems running Win-
dows NT.
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To install from floppy disks, transfer all files to a temporary 
folder on the hard drive, and run setup.exe.

Installation procedure

The DNA application comes with a setup program. This pro-
gram is a 32 bit application and thus requires a 32 bit operat-
ing system.

For Windows NT and Windows 95

Step 1  Insert CD ROM into CD ROM drive.

Step 2  Execute the D:\DNA.exe application.

Step 3  The CD-ROM browser will appear.

Step 4 Select  “Install Software”

During the installation process two subdirectories will be 
created and named Weight and Template. The Weight direc-
tory holds weight curve data files. The Template directory 
holds document template files and graph template files.

Copy protection

This software is protected with a hardware key.

In order to run DNA, the hardware key must be inserted in 
one of the parallel ports of  your computer.

Installation of the hardware key To install the hardware key follow this procedure:

Step 1 Turn off your computer.

Step 2 Find a parallel port on the back of your computer.

Step 3 If there is an unused parallel port, insert the dongle 
into that port. If the parallel port is used by the 
printer, disconnect the printer cable from the com-
puter.
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Step 4 Connect the dongle to the parallel port and recon-
nect the printer cable on the back of the dongle. Be 
sure to firmly secure both the dongle and the 
printer cable.

Step 5 Turn on the computer.

Step 6 If the software is not yet installed, do it now. The 
hardware key is not required to install DNA.

Step 7 Run the DNA software.

If the correct hardware key is not inserted, then the DNA 
application will start in DEMO-MODE.

The current running mode can be checked with the “About” 
command in the? (help) menu.

Using the analyzer instead of the Hardware Key

A single hardware key can be a big restriction, especially for 
those users that need to have the analyzer connected to the 
application for long term measurements. It can become diffi-
cult when the analysis needs to continue at the office with 
another copy of the application.

The new protection scheme uses the analyzer as a key to 
enable the application. In this way, it is possible to have one 
copy of DNA on a computer (Office computer) enabled by 
the hardware key, and a copy on another computer (Portable 
computer) enabled by the analyzer. The application uses the 
analyzer’s serial number, previously validated by the hard-
ware key, to enable the normal program execution.

To enable the new protection scheme follow this procedure:

Step 1 Connect the hardware key to the portable com-
puter (the one that will be enabled by the ana-
lyzer).

Step 2 Run DNA.

Step 3 Connect the analyzer to the portable computer.
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Step 4 Execute a connection between the software and 
the analyzer. The program validates the analyzer’s 
serial number as the security key on the portable 
computer.

Step 5 Remove the hardware key from the portable com-
puter and reconnect it to the Main computer.

NOTE: When DNA is again run on the portable computer, it 
will start in DEMO mode, because no hardware key is pres-
ent. It will then be possible to execute a connection with the 
analyzer whose serial number has been previously validated. 
DNA will then be enabled as if the hardware key were con-
nected.

The validated serial number will last for 20 days. After that, 
the validation procedure must be repeated. It is possible to 
validate more than one analyzer on a single computer.
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C H A P T E R
3 2800 - 2900 - 3000+ - 3200 
Analyzer Window

Introduction

The analyzer window serves as the interface between the 
document window and the analyzer. In the analyzer window 
the connection with the instrument is established, the mea-
surement setup is prepared, and the actual measurement is 
performed on-line with the instrument. Data can also be 
stored in the instrument’s memory and downloaded into the 
document.
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Figure 3-1 Analyzer Window example

To open the analyzer window click on the 2800/2900/3200 
menu item in the document window's menu bar. If you have 
more than one analyzer driver interface (for example 2800/
2900/3200 and 824) the application will insert a menu item 
called Analyzer. The Analyzer menu item will contain a
command for each driver interface.

Since the analyzer window is a separate executable file, it
may be run without launching the main application. In this 
case it is not possible to perform measurements or download 
data from the instrument memory since there is no open doc-
ument ready to receive the measurement data. In any case, 
only one instance of the analyzer window can be run at one 
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time. If the menu command is re-selected, the running 
instance is reactivated and displayed.

Using Setups

The Analyzer Window's Setups are handled with commands
located in the Setup menu. Setups are loaded and saved to 
disk in the same way as other Windows applications. In the 
analyzer window, however setups are being saved and 
recalled, instead of documents.

Opening a Setup To open an existing Setup, click on the Open button in the 
toolbar or use the Open command under the Setup menu.

The standard open document window enables selection of a 
file to open. From the open window, disks and folders can be 
accessed to find the required file.

Saving a Setup To save the current Setup, click on the Save button in the 
toolbar or use the Save command under the Setup menu. 
With this command the Setup is saved in the same file from 
which it was loaded. If the current Setup has never been 
saved then the Save As dialog box is opened. From the Save 
As dialog box a file name can be specified.

To save the current Setup in a file different from the original 
one, use the Save As command under Setup menu.

The standard Save As dialog box is opened, where a file 
name can be specified and the disk and folder can be 
selected to store the file.

Reading the Setup from the 
Analyzer 

Each time the connection with the analyzer is established, or 
the instrument type is changed, the analyzer window will 
read the complete setup from the analyzer.

The setup displayed in the analyzer control panel always 
reflects the setup inside the analyzer.
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Writing the Setup to the 
Analyzer

NOTE: The setup being loaded must be 
of the same type as the instrument cur-
rently selected in the analyzer.

There is no need to manually send a setup to the analyzer. 
When you want to change a setup, simply open the desired 
setup and it will be uploaded immediately to the analyzer.

Establishing the connection

Before establishing a connection with the analyzer, the com-
munication parameters in the Analyzer window and on the 
instrument must be properly set.

Computer Communication Parameters

To set the communication parameters on the computer side, 
execute the Connect command under Analyzer menu. In the 
dialog window the communications port, the baud-rate and 
the stop bits can be selected.

The communications parameters are disabled while estab-
lishing a connection with the instrument.

Figure 3-2 Analyzer Connection window

The number of stop bits used by the analyzer depends on the 
type of serial option you have installed. The baud rate and 
stop bits on both sides of the connection must match.
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Analyzer

To set the communication parameter on the instrument press 
the SYSTEM key, then the I/O “soft-key”?. The baud rate 
can then be selected. 

Once these operations have been performed, the connection 
can be established with either the Connect button in the Con-
nection dialog, or with the corresponding button on the tool-
bar.

If the Create log file box is selected, the application creates a 
file (named CAPTURE.TXT) where all communication data 
flow between the analyzer and the computer is recorded. 
This option can be useful to solve communication problems.

When the analyzer is connected, information about the ana-
lyzer can be obtained with the About Analyzer... command 
under the ? menu.

Figure 3-3 Analyzer information window

The other commands under the Analyzer menu can be used 
to directly control the instrument. The Disconnect command 
will terminate the current analyzer session.

The Run, Stop, Reset and Store commands are direct com-
mands that have the same meaning as the corresponding 
analyzer buttons. The Control Panel selection will open or 
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close a floating window where analyzer settings can be 
changed on the fly.

The File Handler command will open a dialog box where 
direct manipulation of the analyzer's files can be made. This 
window has the same function as the analyzer’s FILES win-
dow.

The Sync Clock command synchronizes the analyzer's clock 
with the computer time.

Connecting through a modem

In version 3.00, or greater, it is possible to use a modem to 
connect to an instrument at a remote site.

Using the modem To use the modem to connect to a remote instrument the 
device chain must be composed of a PC, a modem con-
nected to the PC (local modem), a telephone line, a modem 
connected to the instrument (remote modem) and the ana-
lyzer itself.

To establish a connection three links must exist: the PC must 
be able to communicate with the local modem, the local 
modem must be able to communicate with the remote 
modem and the remote modem must be able to communicate 
with the analyzer.

Link 1 - PC to Local Modem

At least one modem must be installed in the Windows™
environment. The application can then use that modem in 
the same way as other windows applications. This commu-
nication should be transparent to the user as windows should 
take care of all the details.

Link 2 - Local Model locale to the Remote Modem

This connection should be transparent as well.

Link 3 - Remote Modem to the Analyzer

This is the link where problems are most likely to occur.
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Typically, if there is a problem communicating with the ana-
lyzer, the problem is that the analyzer does not recognize the 
modem. It does not understand the commands that come 
from the modem and it is not able to respond to the modem.

Modem setup for the analyzer’s modem must be performed 
using a computer and a communication program like Hyper-
Terminal.

The following procedure must be followed until a satisfac-
tory outcome is achieved.

Setup of the remote modem with HyperTerminal 

Step 1 Connect the remote modem to the COM port of a 
computer. Start Windows™ HyperTerminal and 
establish a connection with the remote modem. 
After reading the following sections, and consult-
ing the modem manual, the proper commands that 
need to be sent through the HyperTerminal con-
nection can be determined.

Step 2 After issuing the commands to change the internal 
settings of the modem, remove the modem from 
the computer and connect the modem to the ana-
lyzer. Try to establish a connection through the 
DNA software with the analyzer through the 
modem.

Step 3 If the connection is not successful, repeat step1 
and step 2. Each time, change the communications 
settings in the remote modem until the proper set-
tings are determined. 

There are three types of problems that may be experienced.
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Cable problems The standard 2900 cable (CBL022) is a null modem 
cable, and thus can only be used to connect directly to a 
PC.

There are two possible solutions. The easiest method is to 
use the cable that comes with the modem or another stan-
dard cable. If another cable does not work, a Null-
Modem adapter may be inserted between the LD cable 
and the modem.

Communication speed The communication speed in the analyzer is fixed. The 
communication speed of the modem must be set at the 
same baud-rate as the analyzer, otherwise the 2900 will 
emit a long series of RS232 errors. Use the procedure 
described earlier with HyperTerminal to change the set-
tings in the remote modem.

Usually every modem has a command to change the set-
tings of the modem. It may not be the same for all 
modems. Consult the modem’s manual for information 
on changing the settings in the modem.

In some cases the communication speed of the two 
modems can be locked together to operate at the same 
baud rate.
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WARNING! After the modem connection is working properly, the ana-
lyzer will continue to report errors during the connection. 
The modem will send the standard result code (RING, CON-
NECT, etc....) and the analyzer still cannot understand these 
commands. These error messages are normal, and will be 
present at all times during modem communication.

Once the connection is established the modem becomes 
transparent. The analyzer will receive commands from the 
PC and respond with the appropriate data just as it would if 
it were directly connected to the PC.

Controlling the analyzer

Once the connection has been established, the analyzer is 
put into remote mode and its control is handled by the ana-
lyzer window. The analyzer keyboard is disabled until the 
connection is terminated. If manual control of the analyzer is 
needed before terminating the connection, or after an appli-
cation crash, press the LOCAL key on the analyzer. 

Analyzer control is handled through a window called Ana-
lyzer Control Panel.

Handshaking signal Some commands to control modem behavior may also 
need to be set. In some cases the “Ignore DTR” command 
may need to be set. In other cases “DSR always active” 
may need to be set. These settings will vary from modem 
to modem. In order to find the proper settings, several 
combinations may need to be investigated.

Once the correct setup has been established, it must be 
stored inside the modem as the default setup. If the setup 
is not stored inside the modem, the first time the modem 
is turned off the settings will be lost. To store the active 
modem setup, the AT&W command must be sent to the 
modem through the HyperTerminal connection.
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Figure 3-4 Analyzer's Control Panel

There are several tabbed sections in the Control Panel that 
hold the analyzer's settings. These settings are always in 
sync with the settings on the analyzer itself; every parameter 
that is modified in the Control Panel is immediately sent to 
the analyzer.

Four buttons are present in the Control Panel that can be 
used to send the RUN, STOP, RESET and STORE com-
mands to the analyzer.

Calibration

Calibration of the analyzer can be accomplished through the 
Analyzer Control Panel.

Step 1 Select the Units tab in the Control Panel.
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Step 2 Select the desired unit for each channel.

Figure 3-5 Control Panel - Units page

The calibration value can be displayed in either dB/V or in 
mV/Pascal.

Step 3 To start the calibration process, click the Calibra-
tion button.

The calibration window is opened for channel 1 of the ana-
lyzer.

Figure 3-6 Calibration window
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Step 4 Set the calibrator frequency and its level in dB.

The window continuously displays the level at the calibrator 
frequency for the current channel. When this value is stable 
click the CALIBRATE button

It is also possible to set the calibration value manually either 
as dB/V or as mV/unit.

When the calibration process for a channel is completed, or 
the calibration is manually set, and the CALIBRATE button 
is pressed, the window automatically switches to the next 
channel.

Click on Skip Channel to leave the current channel 
unchanged and switch on the next channel.

In the Analyzer Control Panel, the unit’s name can be 
changed by clicking on the appropriate button.

In the Unit's Name dialog window, the name and the fre-
quency correction can be set.

Figure 3-7 Unit's name
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Some values cannot be changed and thus are disabled.

Display

The analyzer window displays data in real time. The win-
dow itself can be divided into panes, each pane containing 
one graph. This allows different aspects of the analyzer's 
data to be displayed at the same time.

Displayed graphs are of four types: spectrum, SLM, time 
history and sonogram. Spectrum and SLM graphs always 
display data from the same instantaneous spectrum. The 
time history displays the changes of a single value along the 
time axis.

The spectrum graph can display values versus frequency or 
versus time (in cross mode). The SLM graph displays a 
series of bars with the values from the SLM portion of the 
analyzer. The analyzer must be set to the SLM mode to dis-
play the SLM values. It is possible to display data from two 
channels at the same time.

In the time history graph, the abscissa (X) axis always rep-
resents time. Its amplitude must be selected by the user. In 
this graph up to 4 traces can be displayed simultaneously.
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The Sonogram displays a graph with time on the X axis and 
frequency on the Y axis. The color scale represents the dB 
level. 

Figure 3-8 Example of graph with context menu

To set up the graphs, select the pane to be altered. Click 
inside the desired pane with the right mouse button. Select 
the appropriate command from the context menu. The first 
three commands in the menu are used to select the type of 
graph that is to be displayed. The Properties command will 
open a dialog window where the parameters for that graph
can be set. The Value window command opens or closes a 
window with values from the selected graph. The Properties 
window can also be opened by double-clicking with the left 
mouse button inside a pane.

The properties window is structured the same way for all 
graph types. The first page, called General, enables the set-
ting of the general aspects of the graph. The second page 
holds the parameters for the graph's horizontal axis. The 
third page holds the parameters for the vertical axis. The 
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fourth page holds the settings that control the way the traces
are displayed.

The following figure will show an example for each prop-
erty page. They are from a spectrum graph, but they are the 
same for the other graph types.

Figure 3-9 Spectrum properties - General page

In the General tab dialog box the following parameters can 
be set:

Click on this button to change the pen used to draw the 
graph's border.

Click on this button to set the graph's background color.

Click on this button to change the font used to draw the 
graph heading.

Border

Background

Header Font
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Figure 3-10 Spectrum properties - Horizontal axis page

In the Horizontal axis tab dialog box the following parame-
ters can be set:

Main grid Click on this button to set the pen used to draw the main 
grid line.

Sub grid Click on this button to set the pen used to draw the sec-
ondary grid line.

Autorange Select this check-box to use an amplitude for the axis that 
reflects the current analyzer settings. If this box is cleared 
then the axis limits can be set manually.

Start Enter into this field the axis start value to use when the 
autorange feature is disabled.

Stop Enter into this field the axis last value to use when the 
autorange feature is disabled.

Step (FFT only) Enter into this field the axis labeling division interval. 
This value is not always available. For example with 
octave band spectrum the axis division is performed auto-
matically by the application.
 3-16 DNA User Manual Data-Navigation-Analysis



Figure 3-11 Spectrum properties - Vertical axis page

The Vertical axis tab dialog box holds the same values as the 
horizontal axis. See the previous list for an explanation.

In the Vertical axis page you set:

Click on this button set the pen used to draw the main 
grid line.

Click on this button set the pen used to draw the second-
ary grid line.

Enter into this field the values which define the axis 
amplitude and the label step.

Click on this button to change the font used to draw the 
axis labels.

The last tab dialog box holds the parameters to control trace 
display. For the spectrum graph type there are two possible 

Font Click on this button to change the font used to draw the 
axis labels.

Main grid

Sub grid

Start, Stop and Step

Font
Data-Navigation-Analysis 2800 - 2900 - 3000+ - 3200 Analyzer Window  3-17



traces. The first is always present, while the second can be 
disabled.

Figure 3-12 Spectrum properties - Trace page

The last page holds the parameters to control how the spec-
trum is represented.Click on the check box next to Trace 2 to 
enable a second trace on the spectrum display.

For every trace you must set:

Select the channel to display.

Set the pen used to draw lines or bar contour trace.

to change the bar color.

Select in this list how the trace is drawn. You can choose 
among lines, bars and bar contour.

In the SLM graph type values are represented independent 
from each other. The desired value to be viewed must first 
be selected. The display settings for this value can then be 

Display

Pen

Bar color

Draw with
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modified and subsequent values can then be selected and 
modified.

Figure 3-13 SLM properties - Trace page

The parameters in this page are:

Select the bin value to modify. The list includes all 12 
values measured in the SLM section of the analyzer.

Set this check-box to display the currently displayed 
value in the Select bin box. Clear it if the currently 
selected bin is not to be displayed.

Select the channel from which the currently selected bin 
is to be displayed from.

Click on this button to change the current bin bar color.

Select bin

Enable

Display

Bin color
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Figure 3-14 Time History properties - Trace page

In the time history graph up to four traces can be displayed 
simultaneously. For each trace the following parameters 
must be set:

Set this check-box to enable the selected trace display

Select the combo box value to set the desired channel for 
the trace.

Select the value that is to be represented by the trace. The 
listed values depend on the current analyzer settings.

Click on this button to set the pen used to draw the 
selected trace.

Value window 

It is possible to associate a value window with each pane. 
This value window is a numeric display representing the 
instantaneous values being sent by the analyzer. The font for
each value window can be selected by the user to improve
the readability of the display. To change the font, click inside 

ON

Channel

Value

Pen
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the value window with the right mouse button. The context 
menu displays two commands, one to set the value font and 
one to set the header font.

Figure 3-15 Example of Value window connected to a SLM 
graph

The type and number of values displayed depends on the 
type of graph in the connected pane.

Measurement download

The Larson Davis analyzer models 2800, 2900 and 3200, 
can store measurement data in the analyzer's memory. Since 
these analyzers can have several megabytes of memory they 
can store a great number of measurements. These analyzers 
have an internal file system to store the data. Each file can 
store up to 1000 records (measurements). The number of 
files that can be created depends on the analyzer's memory 
size. There are no folders or directories inside the instru-
ment.
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To download measurement data, use the “Download from 
analyzer” command from the Measurement menu in the ana-
lyzer window.

Figure 3-16 Download from analyzer dialog box

In the dialog window that opens, select the analyzer file 
which holds the measurement that is to be retrieved. The 
desired record can then be selected from the list. After the 
desired file and record or records have been selected, click 
on the Download button. The measurement name is built
using the rules that are set with the Options button. One or 
more measurements can be downloaded with a single com-
mand, however, measurements from more than one file can-
not be downloaded at one time.
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Figure 3-17 Load measurement - Info page

Before the application loads a measurement, it will prompt 
the user for information about that measurement. This 
allows document information about the test, operator, instru-
ment, etc. to be entered. This information is stored with the 
measurement. It is not required to enter this information. 

In the first page of the measurement download wizard, the 
name and other identification parameters need to be set. 
These parameters are then used in the document window to 
identify the measurement. It is important to set this informa-
tion correctly so that the measurement can be identified 
during the document creating process. The application will 
always display, as default, the parameters used in the last
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download wizard execution. It is possible to change this 
information later using the document window. 

Figure 3-18 Load measurement - Option page

In the option page the user can specify the data to store from 
the analyzer measurement. The SLM store options group 
includes the selections, store the spectrum, the SLM values 
or both. The A:D (Analog to Digital) store options allow 
selection of which A:D values to store. For each A:D the 
name, measurement unit and conversion factor can be set. 
A:D values are stored in the analyzer in Volts ranging from 0 
to 5V. The conversion (scale) factor is the number used to 
convert Volts to the desired measurement unit. In the Tach 
store options the tach board values to store are selected. 

This window also sets the parameters for the passby mea-
surement.
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For the passby measurement the vehicle position needs to be 
calculated for each measured spectrum. 

There are three ways to recalculate the distance data:

• Reading the distance data directly from the analyzer. 
This is possible only if the analyzer has the passby option 
installed.

• Recalculating the distance data from the speed data.

• Recalculating the distance data from the RPM data. In 
this case the vehicle total transmission ratio must be 
entered. That information is then used to convert from 
RPM to speed and then to distance values. Click on the 
Change button to modify the transmission ratio. The total 
transmission ration dialog box will appear. (See figure 3-
19)

The last value required is the position of the first spectrum in 
the start position offset field.

Figure 3-19 Total transmission ratio dialog window
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The total transmission ratio can be entered as a user calcu-
lated value, or it can be calculated by the application from 
the vehicle type data and the transmission data.

Type data are in the same format as reported on the type 
label. Transmission data includes the axle ratio and the used 
gear ratio.

The downloaded data is immediately transferred to the open 
document in the document window. To view a measurement
that has been downloaded, activate the document window 
open the document contents window. The downloaded mea-
surement can be found there. At the end of the download 
sequence the main document window is brought to the fore-
ground.

Measurement Execution

Beyond simply downloading the instrument memory, mea-
surements can also be performed with the analyzer being 
controlled by the DNA software. To execute a measurement,
select the appropriate command in the Measurement menu. 
A Measurement Wizard will guide you through the process 
of taking a measurement. There are four modes for measure-
ment execution. The modes determine how a measurement 
is started and stopped. The following table describe each 
mode.

Manual With this mode selected, the measurement begins imme-
diately after the START button is pressed in the last page 
of the measurement wizard. The measurement will stop 
after the predefined time has elapsed.

Trigger With this mode selected, the application sets the analyzer 
in the RUN mode and then continually monitors the mea-
sured value; when the trigger conditions are met the mea-
surement begins. The measurement can be stopped after a 
predefined time or when the monitored value goes out-
side of the trigger conditions.

Timer With this mode selected, the measurement begins when a 
user timer expires, and stops after a predefined time.
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To execute these measurements you must select either a Lin-
ear repeat or Exponential averaging mode on the analyzer. 
This selection determines how the data is collected inside 
the analyzer (MT- manual trigger command). In the Linear 
repeat mode, the analyzer automatically transfers the data 
from the math unit to the output buffer, while in the Expo-
nential averaging the command must be sent by the com-
puter.

It follows that, apart from the connection speed, the preci-
sion in the time of each spectra in the exponential mode is 
worse than in the Linear repeat mode. Of course if the aver-
aging time is less than the time it takes to download a spec-
trum, the Linear repeat mode becomes imprecise. With a 
connection speed of 19200 baud, we have seen that it is pos-
sible to transfer a two channel 1/3 octave spectrum every 
125 milliseconds.

Measurement Wizard

The measurement wizard consists of a sequence of dialog 
boxes where the measurement parameters are set. To select 
the measurement wizard click on the “Measurement” menu 
and select “Execute Wizard”.

When first beginning a measurement using the measurement 
wizard, a setup for the measurement must be selected. The 
current analyzer setup (the one displayed in the Control 
Panel) can be used, or another setup can be loaded using the 
menu Setup, Open command. The measurement wizard will 

Daily With this mode selected, a sequence of measurements are 
made for each selected day. The user will set the start date 
and number of days. For each selected day the application 
can do one or two measurements, beginning at a pre-
defined time and stopping after a predefined time period.
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use the analyzer setup that is displayed in the control panel 
to perform the measurements.

Figure 3-20 Measurement wizard - Measurement description 
page

The first page of the measurement wizard is used to set the 
name and other identification parameters. These parameters 
are then used in the document window to identify the mea-
surement, so it is important to set them correctly. The appli-
cation will always display the default parameters used in the 
 3-28 DNA User Manual Data-Navigation-Analysis



last wizard execution. These values can also be changed 
later in the document window.

Figure 3-21 Measurement wizard - General setup page

The second page is used to set the general measurement con-
ditions.

The measurement start mode must be selected. See the 
modes description in the previous paragraph. Finally, a pass-
word can be set to control measurement interruption. When 
a password is set, the measurement will not be able to be 
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interrupted unless the correct password is inserted in the 
progress window.

Figure 3-22 Measurement wizard - Manual page

In the manual measurement mode, the measurement begins 
after the Start button has been pressed, and is terminated 
after a predefined time period. The only parameter that must
be set in this page is the measurement duration, in seconds. 
The application automatically calculates the required num-
ber of spectra needed to cover the selected duration. 

WARNING! If the averaging time is too short, and the computer is not 
able to keep up with the required speed, the computed num-
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ber of spectra will be collected. However, the measurement 
duration will be longer than the duration set in this window.

Figure 3-23 Measurement wizard - Trigger page

In the trigger page the trigger conditions must be inserted. 
Trigger conditions include measurement start and measure-
ment stop conditions.

Frequency/Bin Select which band, including SLM values, must be moni-
tored for trigger conditions.

Channel Select the channel of the monitored frequency/bin.
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Threshold level Insert the threshold level in dB. When the monitored sig-
nal reaches or exceeds this level, then the measurement 
begins.

Stops when a fixed time 
elapsed

Select this option if the measurement needs to terminate 
after a fixed period of time.

Stops when the level goes 
below threshold

Select this option if the measurement needs to terminate 
when the monitored signal level goes below the threshold 
value.

Number of pre-trigger 
spectra stored

The application is able to store one or more spectra (up to 
1000) preceding the trigger time. This allows storage of 
the data immediately proceeding the trigger event.

Measurement duration This parameter sets the predefined measurement duration 
in seconds for the fixed time mode.

Post under-threshold 
overtime (sec)

This is the time the application will measure after the 
trigger conditions have been released. This value corre-
sponds to the minimum distance between two consecu-
tive events. If the level exceeds the threshold before this 
time elapses, the current measurement is continued as if 
the signal had never gone below the threshold.
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Figure 3-24 Measurement wizard - Timer page

The parameters for the Timer mode are the measurement 
duration, the start date, and the start time. For the measure-
ment duration see the comments in the Manual mode section 
of this manual.
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Figure 3-25 Measurement wizard - Daily page

The daily measurement mode is used to set the start date and 
the number of days that the measurement is to be repeated. 
For each selected block of time the start time and measure-
ment duration must be set. If the second block is enabled, it 
must start at a time after the end of the first block. For the 
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measurement duration see the comments in the Manual 
mode section of this manual.

Figure 3-26 Measurement wizard - Option page

In the option page the following parameters must be set:

Store elapsed time as 
calculated by the 
computer

Clear this box to store each spectrum with the theoretical 
time given by the averaging time. Set this box to have the 
computer calculate the elapsed time of each spectrum 
based on the internal clock of the computer.
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AD options In the A:D store options, select which A:D value needs to 
be stored. For each A:D value the name, measurement 
unit and conversion factor can be defined. A:D values are 
stored in the analyzer in Volts ranging from 0 to 5V. The 
conversion factor is the number used to convert Volts to 
the desired measurement unit.

Tach/RPM Set this box to store the RPM value.

Speed Set this box to store the Speed value.

External device con-
trol

Set to high (+5V) or low depending upon the device you 
are controlling.
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If the computer has an audio board, the next wizard page is 
used to set up the audio signal recording while the measure-
ment is performed.

Figure 3-27 Measurement Wizard - Audio page

By default the audio recording is disabled. Click on the 
Enable audio recording check box to activate the other 
fields.

Select the audio input device that will be used (if there is 
more than one audio board installed). Then select the audio 
resolution. When selecting higher audio resolutions, take 
care to make sure that the disk space does not run out in a 
short time.
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Recording conditions depend on the type of measurement 
selected earlier.

If doing a triggered measurement, then the audio recording 
start will happen with the same bin, channel and threshold 
condition set for the measurement itself. The recording 
length will be the time specified in this window.

In all other cases, the recording conditions must be set in this 
window.

It is possible to record up to five seconds before the trigger 
time.

The selection of how to rearm the audio trigger must also be 
made. There are two methods to accomplish this function. 
Both of these methods can be used simultaneously. The first 
method functions so that after an audio block ends, the next 
audio block can only start after the level goes below the 
threshold level. The second defines a minimum interval time 
between two consecutive audio blocks.

The last field in the page displays approximately how much 
time can be recorded, based on the free disk space. Since the 
application uses the temporary Windows™ directory to store 
temporary files, free space must be available on the hard 
disk that contains the Windows temporary directory.
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Figure 3-28 Measurement wizard - Summary page

The last wizard page contains a summary of the measure-
ment that is to be executed. Click on the Finish button to ini-
tiate the measurement.

Before actually starting the measurement, the application 
performs a test to see if the transmission speed is enough for 
the selected averaging time.

If the time required to download a sample from the analyzer 
is longer than the averaging time, the following warning 
window is displayed.
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Figure 3-29 Speed test dialog window

This window reports the average time (based on 10 samples) 
it takes to download a sample. The first is obtained with the 
Windows message loop enabled, while the latter is obtained 
with the Windows message loop disabled.

When the message loop is disabled, the application takes 
less time to read a sample from the analyzer, but during the 
measurement it will remain locked. In this case the only way 
to interrupt a measurement is by using the Esc key.

Passby Wizard

WARNING! This feature is enabled only if you have the Passby option 
enabled on your dongle.

The Passby Wizard command under the Measurement menu 
begins a wizard designed to automate the passby measure-
ment.

Before starting the passby wizard, be sure to set the byTime 
mode and parameters on the analyzer through the control 
panel. The Trigger parameters must also be set in a way that 
is compatible with the measurement system.

The application creates a temporary file on the analyzer, 
where the measurements are stored. Its name is AUTOx 
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where x is an integer number. At the end of the wizard this 
file will be deleted from the analyzer.

In the first wizard page the Measurement Description 
parameters must be set.

Figure 3-30 Passby Wizard - Measurement Description Page

Beyond the usual fields, the user can choose to add a 
sequential number to the end of the measurement name, and 
set its initial value.
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Figure 3-31 Passby Wizard - Passby Setting

In the second page you set how the measurement is per-
formed. The required parameters are listed in the following 
table.

Gear Enter the Gear used on the vehicle during the test. This 
value is simply reported in the DNA measurement as a 
reference.

Channel 1 is side Enter which side of the vehicle is connected to channel 1.
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In the third page of the Passby Wizard, three validity tests
can be set up that will be automatically executed for each 
measurement.

Calculate speed from Select how the application measure speed. If you are 
measuring the speed with the analyzer select Analyzer, 
otherwise select RPM and set the transmission ratio.

Calculate distance from Select how the application measure the vehicle position. 
If you are measuring the position with the analyzer select 
Analyzer, otherwise select Speed.

Calculate throttle from Select how to determine when the throttle is to be consid-
ered 100% down. If you have the Passby option on the 
analyzer select Analyzer, otherwise select RPM.

In both cases you must set which is the value that corre-
sponds to Throttle 100% down.

The analyzer returns a value between 0 and 255.

Send RUN command to 
the analyzer

Set this check box to send the RUN command automati-
cally to the analyzer.

This setting depends on the trigger mode used.
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Figure 3-32 Passby Wizard - Validation Test Page

Three tests can be executed: RPM at -10m, Speed at -10m 
and vehicle throttle position when the throttle is 100% 
down.

For each test the reference value and a tolerance value must 
be set.

There are also two optional settings that can be used to store 
throttle data or acceleration data.

After the Finish button has been pressed, the application 
waits for the analyzer to complete the measurement. At the 
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end of the autostore the application downloads it automati-
cally, and performs the validation tests.

A window will then be opened that displays the measure-
ment.

Figure 3-33 Passby Wizard - Measurement display window

In this window there are two graphs. The upper graph dis-
plays the Overall (LIN) or (A) of the two channels, versus 
position, while the lower one displays RPM or Speed versus 
position.
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With the Setup button it is possible to change some of the 
graph's parameters.

Validation test result are shown Below the graphs.

Select the STORE button if the measurement is determined 
to be OK. If the measurement is determined to not be OK, 
click the REJECT button and the measurement will be dis-
carded.

In either case the Passby Wizard will restart from the begin-
ning ready for a new measurement.

2226 Multiplexer Wizard

The 2226 Multiplexer Wizard command under the Measure-
ment menu starts a wizard designed to automate the use of 
the multiplexer. At least one multiplexer must be connected 
to the analyzer.
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In the first wizard page the Measurement Description 
parameters need to be set.

Figure 3-34 Multiplexer 2226 - Measurement Description Page

Beyond the usual fields, the user can set the address at which 
the multiplexer is connected.

Two check boxes are available on the first page of the 2226 
multiplexer wizard. The first box, when checked, enables the 
application to automatically download the measurements
when they are completed. The second check box, when 
checked, allows the application to automatically delete the 
measurement file from the analyzer when the measurement 
is completed.
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The second page contains the download options. If the auto-
matic download is not enabled then this page is not dis-
played. See the description in paragraph “Measurement
download”.

There are one or more pages with the settings for each multi-
plexer. The window title will reflect the current multiplexer 
address.

Figure 3-35 Multiplexer 2226 - Input Settings Page

For each multiplexer input there is an enable check box, the 
pause time (after the input is selected) and the measurement 
duration.
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If the analyzer is in byTime or byTach mode then the mea-
surement duration is controlled by the analyzer and thus the 
fields are disabled.

In the last page there is a summary of all selected inputs with 
the current calibration value for each channel.

Figure 3-36 Multiplexer 2226 - Input summary and calibration 
page

Click on the "Calibrate selected input" button to start the cal-
ibration procedure.

A Calibration window is opened where each channel can be 
calibrated using a calibrator. The sensitivity of the trans-
ducer can also be entered manually.
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Click on the Finish button to begin the measurement proce-
dure. For each selected input the application:

• Saves the current calibration values.

• Sets the calibration values for the current input.

• Selects the input on the multiplexer.

• Executes the selected pause duration.

• Executes the measurement.

• Restores the saved calibration values on the analyzer.

At the end of the sequence the measurement will be down-
loaded automatically.
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Destination Document

Since it is possible to run more than one instance of the main 
application, there may exist more than one document that 
can receive the measurement's data.

Figure 3-37 Select Destination Document window

When the measurement is started or data is downloaded 
from memory, and more than one document is ready to 
receive the data, a dialog window with the list of documents 
is displayed. There the appropriate document can be selected
to be the destination document.
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Troubleshooting the analyzer connection 

When problems occur in the connection with the analyzer, 
the application will inform the user with a warning message. 
Given below are some of the possible messages along with 
the possible cause for the message.

WARNING! Access denied error on serial port 
COMx.

This message is received when trying to use a serial port that 
is already used by another device or application. If the port 
is used by another device (e.g. the mouse), specify another 
serial port.

If the port is used by another application, close that applica-
tion or select a different serial port.

WARNING! Cannot read from the analyzer...

The main cause for this message is that there is no physical 
connection between the computer and the analyzer.

For example: the cable may not be connected or the analyzer 
may not be turned on.

WARNING! A time-out error has occurred on serial 
port COMx.

If this message is displayed when trying to connect to the 
analyzer, the probable cause is that the baud rate inside the 
analyzer does not match what is set in the connection dialog 
box of the DNA software.

If the message is displayed after the connection has been 
established, then it may be a software error; for example 
your analyzer can have a new firmware revision not yet sup-
ported by the application.
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WARNING! An error has occurred on serial port 
COMx...

This error should not occur in normal conditions. If it does 
occur it means there is some hardware problem in the com-
munication chain.

The ErrorCode value displayed in the message represents
the error number reported by Windows.

The most common error reported by Windows is number 2 
(CE_OVERRUN). This error code indicates that the operat-
ing system was unable to read a byte from the serial port 
before the arrival of the next byte.

In case of error 2:

Step 1 Be sure that your computer has buffered serial 
ports (UART 16550).

Step 2 Next check in the communication resources for 
the serial port and enable the buffer.

Step 3 If the problem persists, try using a different baud 
rate.

Step 4 Disable the screen saver.

Step 5 If you are using a Windows 95™ on a laptop, open 
the Power management applet from the Control 
Panel. Click on the Advanced button. Then on the 
Problem solution tab. Finally disable the polling 
of the power status.

Troubleshooting the main application connection 

When problems occur in the connection between the ana-
lyzer window and the main application, a warning message 
will inform the user of the problem. Given here are the pos-
sible messages along with the probably cause that could trig-
ger the message.
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WARNING! Connection with the main application is 
not possible.

The main application is not running. Start the main applica-
tion and retry the command.

The main application is running, but is locked by a previous 
connection crash. Exit the main application, restart it and 
retry the command.

WARNING! Destination document is not yet avail-
able. Data transfer is aborted.

The destination document is not yet ready. Wait until the 
main application has created the document and retry the 
command.

WARNING! Cannot open exchange file.

WARNING! Cannot map exchange file.

The data passes from the analyzer window to the main appli-
cation window through an exchange file. This file is created 
in the Windows temporary directory.

Check that the temporary directory is set correctly.

Check the free disk space on the drive with the temporary 
directory.

If the destination document and the temporary directory are 
on the same drive, and you are performing a measurement 
that will use 100kB remember that you must have more than 
double that in available free space.

WARNING! Main application error: XXX

This message should not occur in normal conditions. It indi-
cates there is a problem in the main application.

Incompatible versions of the main application and the ana-
lyzer window EXE files are probably being used.

Try to reinstall the software.
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C H A P T E R
4 System 824 Analyzer 
Window

Introduction

The analyzer window serves as the interface between the 
document window and the analyzer. In the analyzer window 
the connection with the instrument is established, the mea-
surement setup is prepared, and the actual measurement is 
performed on-line with the instrument. Data can also be 
stored in the instrument’s memory and downloaded into the 
document.
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Figure 4-1 Analyzer Window example

To open the analyzer window click on the 824 menu item in 
the document window's menu bar. If there is more than one 
analyzer driver interface installed, (for example 2800/2900/
3200 and 824) the application will insert a menu item called 
Analyzer. The Analyzer menu item will contain a command 
for each driver interface.

Since the analyzer window is a separate executable file, it 
may be run without launching the main application. In this 
case it is not possible to perform measurements or download 
data from the instrument memory since there is no open doc-
ument ready to receive the measurement data. In any case, 
only one instance of the analyzer window can be run at one 
time. If the menu command is re-selected, the running 
instance is reactivated and displayed.

Using Setups

The Analyzer Window's Setups are handled with commands 
located in the Setup menu. Setups are loaded and saved to 
disk in the same way as other Windows applications. In the 
analyzer window, however; setups are saved and recalled 
instead of documents.

Opening a Setup To open an existing Setup, click on the Open button in the 
toolbar or use the Open command under the Setup menu.

The standard open document window enables the selection 
of a file to open. From the open window, disks and folders 
can be accessed to find the desired file.

Saving a Setup To save the current Setup, click on the Save button in the 
toolbar or use the Save command under the Setup menu. 
With this command the Setup is saved in the same file from 
which it was loaded. If the current Setup has never been 
saved then the Save As dialog box is opened. From the Save 
As dialog box a file name can be specified.

To save the current Setup in a file different from the original 
one, use the Save As command under Setup menu.
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The standard Save As dialog box is opened; there a file 
name can be specified and the disk and folder can be 
selected that will store the file.

Reading a Setup from the 
Analyzer 

Each time the connection with the analyzer is established, or 
every time the instrument type is changed, the analyzer win-
dow will read and display the complete setup from the 824 
analyzer.

The setup displayed in the analyzer window always reflects 
the setup inside the analyzer.

Writing a Setup to the Analyzer

NOTE: The setup being loaded must be 
of the same type as the instrument cur-
rently selected in the analyzer.

There is no need to manually send a setup to the analyzer. 
When you want to change a setup, simply open the desired 
setup and it will be uploaded immediately to the analyzer.

Establishing the Connection

Before establishing a connection with the analyzer, the com-
munication parameters in the computer and the instrument 
must be properly set.

Computer To set the communication parameters on the computer side, 
execute the Connect command under the Analyzer menu. In 
the dialog window the communication port, the baud rate 
and the stop bits can be selected.

Analyzer

NOTE: The communications parameters 
cannot be accessed when establishing a 
connection by selecting the connect but-
ton on the toolbar.

There is no need to set the communication parameters on the 
analyzer. The application should be able to automatically set 
the communication parameters on the analyzer.

Additional setting for Windows 
95/98

Windows™ 95/98 users must execute an additional setting 
in order to have a successful connection. The required set-
ting is to lower the transmit buffer of the communication 
port, otherwise the 824 will likely display the "Overrun 
error" message.

Step 1 Open the Control Panel
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Step 2 Double-click on the System icon

Step 3 Click on the Device Manager tab

Step 4 Select the communication port used to connect to 
the 824

Step 5 Click on the Properties button

Step 6 Click on the Port Settings tab

Step 7 Click on the Advanced button

Step 8 Set the transmit buffer to 1 (lower setting)

Step 9 Confirm the changes by clicking the OK button on 
all the opened dialog boxes.

Figure 4-2 Analyzer Connection window

The Flow control parameter is enabled only for baud rates of 
9600 or less. For higher baud rates it is preset to Hardware.

If the Create log file box is selected, then the application cre-
ates a file (named CAPTURE.TXT) where all communica-
tion data flow between the analyzer and the computer is 
recorded. This option can be useful to solve communication 
problems.

Once these operations have been performed, the connection 
can be made either with the Connect button in the Connec-
tion dialog, or with the corresponding button on the toolbar.
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When the analyzer is connected information can be obtained 
about the analyzer with the About Analyzer... command 
under the ? menu.

Figure 4-3 Analyzer information window

The other commands under the Analyzer menu can be used 
to directly control the instrument.

The Disconnect command will terminate the current ana-
lyzer session.

The Run, Stop, Reset and Store commands are direct com-
mands that have the same function as the corresponding ana-
lyzer's buttons.
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The Control Panel command will open or close a floating 
window where the analyzer’s settings can be changed on the 
fly.

The File Handler command will open a dialog box where the 
analyzer’s file system can be directly manipulated.

The Setup Handler command opens a dialog box where the 
824 instrument (or setup) type can be manipulated.

The Sync Clock command synchronizes the analyzer's clock 
with the computer time.

Connecting Through a Modem

This feature is supported only under Windows 95, Windows 
98 or Windows NT 4.0 or later.

With version 3.00, or greater, of the DNA software it is pos-
sible to establish a connection between the PC and the 824 
through a modem and a phone line.

Connecting through a modem is a sophisticated task. It is 
necessary to understand the method of communications 
between all of the devices in the chain.

Using the modem To use the modem to connect to a remote instrument the 
device chain must be composed of a PC, a modem con-
nected to the PC (local modem), a telephone line, a modem 
connected to the instrument (remote modem) and the ana-
lyzer itself.

To establish a connection three links must exist: the PC must 
be able to communicate with the local modem, the local 
modem must communicate with the remote modem and the 
remote modem must communicate with the analyzer.

Link 1 - PC to Local Modem

At least one modem must be installed in the Windows™ 
environment. The application can then use that modem in 
the same way as other windows applications. This commu-
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nication should be transparent to the user as windows should 
take care of all the details.

Link 2 - Local Modem to the Remote Modem

This connection should also be transparent.

Remote Modem to the 824 with firmware version 
pre 3.xxx

This is the connection where problems are most likely to 
occur. The problems are caused because the analyzer does 
not facilitate control of the modem.

The remote modem needs to be set up using the PC and a 
HyperTerminal connection, or some other communication 
protocol.

There are three categories of problems.

Connection cable The CBL006 that comes standard with the System 824, is 
used for direct RS-232 communication to a PC. It is not 
suitable for modem communication by itself.

The desired modem cable is CBL003 (available from 
Larson Davis), for modems with a 25 pin connector, If 
the modem being used has a 9 pin connector, then the 
standard communication cable, CBL006, can be used 
with a Null Modem adapter.

Communication speed The 824 and the modem must be arranged so that they are 
using the same baud-rate. If they are not communicating 
at the same baud rate, the analyzer will give a continuos 
stream of errors.

In general all modems have a command to select a fixed 
speed between the modem and the attached device.

In some cases it may also require setting the local and 
remote modems’ to communicate at the same speed as 
the analyzer.
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There are no definitive standards that govern modem com-
munication. Many times trial and error will be necessary to 
facilitate modem communications.

Once the remote modem is configured correctly, the config-
uration MUST be stored inside the modem itself. This will 
allow it to load automatically each time the modem is pow-
ered on. If this is not done the modem will revert back to a 
default configuration the first time the modem is turned off. 
To store the current configuration in the modem use the 
command AT&W. This command is supported by most 
modems.

WARNING! Even though the modem is configured correctly, the analyzer 
will still display errors during the connection phase. The rea-
son for this is that the modem sends a result code to the con-
nected device (RING, CONNECT..., etc.) that the analyzer is 
not able to understand. When the connection phase is over 
the modem becomes transparent and communication should 
continue without any further errors.

Remote Modem to the 824 with firmware version 
3.xxx or later

From version 3.xxx the analyzer firmware is able to control 
a modem. There should be not connection problems between 
the remote modem and the analyzer.

Normally the default initialization string inside the analyzer 
is enough to facilitate connection. Tests using two anony-
mous modems have been successful without any problems 
or additional configuration needs.

There may be some situations where the default modem ini-
tialization string must be altered inside the analyzer. This sit-
uation will occur if a cellular modem is being used. For use 
with a cellular modem, the correct PIN needs to be sent to 
the modem at power on.

Handshaking control pin It may also be necessary to setup the modem for the 
proper RS-232 handshaking control lines. For example 
some modems require the "Ignore DTR" parameter to be 
set. Others might require the "DSR always active" param-
eter to be set.
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Controlling the Analyzer

Once the connection is established, the analyzer should be 
operated only through the application window. When the 
application is connected it is still possible to operate on the 
824 keypad and change parameters. Changes made manually 
on the instrument will lead to a difference between the ana-
lyzer and the application. To re-synchronize the application 
and the analyzer, it is necessary to disconnect from the ana-
lyzer and reestablish the connection.

The analyzer control is handled through a window called 
Analyzer Control Panel

Figure 4-4 Analyzer's Control Panel

In the Control Panel there are several tabbed dialog boxes 
that contain the analyzer’s settings.

Since the setups for the different instrument types are not the 
same, the application displays a different control panel for 
each instrument type. The control panel title will include the 
instrument type.
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Four buttons are present in the Control Panel. These buttons 
can be used to send the RUN, STOP, RESET or STORE 
commands to the analyzer. Clicking on the RESET button 
will open a popup menu with the Reset options.

Display

The analyzer window can display data in real time as it is 
displayed on the analyzer screen.

The window itself can be divided into panes, each pane con-
taining a graph, in order to display different aspects of the 
analyzer's data.

Displayed graphs are of four types: spectra, SLM, time his-
tory and sonogram. Spectra and SLM graphs always display 
data from the same instantaneous spectrum. The time history 
displays the changes of a single value along the time axis.

The spectrum graph display s a series of bars that represent 
each frequency band. The SLM graph displays a series of 
bars with the values from the SLM analyzer. The System 
824 has several instrument modes, each having a different 
set of available data. The data that can be displayed in the 
live display of DNA is governed by the data that is available 
from the analyzer.

In the time history graph the abscissa (X) axis always rep-
resents time, and its amplitude is selectable by the user.

The Sonogram displays a graph with time on the X axis and 
frequency on the Y axis, with the color scale representing 
the dB level. 
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Figure 4-5 Example of graph with context menu

The setup of the graph in a pane is accomplished through a 
context menu. To access the context menu, use the right 
mouse button and click inside the desired pane. The appro-
priate command can then be selected from the context menu.

The first four commands are used to select the type of graph 
displayed. The Properties command opens a dialog window 
where the parameters for that graph can be set. The Value 
window command opens or closes a window that will dis-
play numerically the values from the selected graph. The 
Properties window can also be opened by double-clicking 
with the left mouse button inside a pane.

The properties window is structured the same for all graph 
types.

The first page, called General, enables the settings of the 
general aspects of the graph. The second page contains the 
parameters for the graph's horizontal axis. The third page 
contains the parameters for the vertical axis. The fourth page 
contains the settings that control the trace displays.
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The following figure shows an example of each page in the 
properties window. This particular display is from a spec-
trum graph, but the properties window is the same for the 
other graph types as well.

Figure 4-6 Spectrum properties - General page

In the General tab, the following parameters are set:

Click on this button to change the pen used to draw the 
graph's border.

Click on this button to set the graph's background color.

Click on this button to change the font used to draw the 
graph heading.

Border

Background

Header font
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Figure 4-7 Spectrum properties - Horizontal axis tab

The Horizontal axis tab controls the following parameters:

Click on this button to set the pen used to draw the main 
grid line.

Click on this button to set the pen used to draw the sec-
ondary grid line.

Click on this button to change the font used to draw the 
axis labels.

Main grid

Sub grid

Font
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Figure 4-8 Spectrum properties - Vertical axis tab

The Vertical axis tab controls the following parameters:

Main grid Click on this button to set the pen used to draw the main 
grid line.

Sub grid Click on this button to set the pen used to draw the sec-
ondary grid line.

Start, Stop and Step Insert values in these boxes to define the axis amplitude 
and the label steps.

Font Click on this button to change the font used to draw the 
axis labels.

The last page contains the parameters that control how the 
data is represented.
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Figure 4-9 Spectrum properties - Spectrum tab

The spectrum tab controls the following parameters:

Select how the trace is to be drawn. The choices include 
lines, bars or step.

Choose the pen used to draw lines or bar contour trace.

Changes the bar color.

In the SLM graph type each value is represented as an inde-
pendent line on the graph. The value that is to be displayed 
must be selected first, and then the settings for that value can 
be modified.

Draw as

Pen

Bar color
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Figure 4-10 SLM properties - SLM Tab

The parameters in the SLM Properties tab include:

Set the current bin bar color.

Set the trace name as it is displayed on the graph.

Add a trace to the list.

Delete the selected measurement from the graph.

Bar color

Name

Add bar

Remove bar
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Figure 4-11 Time History properties - History tab

The parameters in the history tab are:

Set the current trace's pen color.

Set the trace name as it is displayed on the graph.

Add a trace to the list.

Delete the selected trace from the graph.

Value Window

It is possible to associate a value window with each dis-
played graph that numerically displays the current value.

The font used to display the header and the data can be 
altered in each value window to improve the readability of 
the display.

To change the font, click inside the value window with the 
right mouse button. The context menu displayed contains 
two commands. The first command is used to set the value 

Pen color

Name

Add bar

Remove bar
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font, the second is used to set the font that is to be used for 
the header. 

Figure 4-12 Example of Value window connected to a SLM 
graph

The type and number of values displayed depends on the 
type of graph in the connected pane.

Measurement download

The 824 analyzer can store measured data with its internal 
memory. It has a simple file system to store several measure-
ment data sets, but only one file at a time can be loaded into 
the active memory and thus be accessible.

Every data set can hold more then one RUN/STOP. The 
application converts each RUN/STOP into a single measure-
ment.

To download measurement data, use the “Download from 
analyzer” command in the Measurement menu.

In the first wizard page select the data download mode. The 
choices include Binary transfer and ASCII transfer. It is pos-
sible to download a binary image without translating the 
data, or to translate a binary image previously downloaded. 
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The translate feature also works with files downloaded with 
the Larson Davis 824 Utility program.

Figure 4-13 Download wizard - Transfer method page

The Binary transfer is the method of choice for large data 
sets and long time histories. The ASCII transfer is faster for 
small data sets.
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Figure 4-14 Download wizard - File selection page

The second wizard page allows selection of the files that are 
to be downloaded. It also gives the option to download the 
data contained in the active memory, but has not yet been 
stored to a file.
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Figure 4-15 Download wizard - Data storage page

The third wizard page selects what data should be stored 
with the measurement.

When the wizard is finished, the application will begin to 
immediately download the data, and store it in a temporary 
file. At the end of the download, the user will be prompted 
for the measurement description for each RUN/STOP 
sequence encountered.

The downloaded data is then immediately transferred to the 
open document in the document window. To see a down-
loaded measurement, the document window must be acti-
vated. To see the data in the document, open the document 
contents window. The downloaded measurements will be 
listed there, along with any previously downloaded data. At 
the end of the download sequence the main document win-
dow is brought to the foreground.
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File Handler

Execute the File Handler command under the Analyzer 
menu to open the dialog window for handling the 824 files.

In the dialog box there is a list of files stored on the analyzer 
and the commands to manipulate them.

Figure 4-16 Analyzer’s file handler window

At the top of the list two fields report the used and free mem-
ory sizes on the analyzer.

Below is the name of the currently recalled file, if one is 
available.

The Recall button loads the selected file into the current 
active memory so it can be downloaded.

The Store button stores the data currently in active memory 
to a new file in the analyzer’s memory.

Delete removes the selected file from the analyzer’s mem-
ory.
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Analyzer's Instruments

Use the Setup handler... command under the Analyzer menu 
to open a dialog window to select a particular instrument and 
setup.

A list displays the instrument setups stored in the analyzers 
memory.

The first several instrument setups are permanent and cannot 
be changed or deleted.

Figure 4-17 Instrument setup dialog window

Below the list the currently selected ID name and number of 
allocated ID (setups) is displayed. Use the Change button to 
change the number of allocated Ids.

Recall Click on this button to recall the selected ID into the 
active instrument memory. The analyzer must be in a 
Reset-All condition to change instrument types.

Create Click on this button to create a new ID using the current 
instrument setup.
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The Read only box can be set to make the selected setup a 
read-only setup.

Measurement Execution

Beyond simply downloading the instrument memory, mea-
surements can be performed by directly controlling the 
instrument with the application.

To execute a measurement simply select the appropriate 
command in the Measurement menu. A Measurement Wiz-
ard will guide you through the process of making a measure-
ment.

There are four measurement execution modes. These modes 
determine how a measurement is started and stopped. The 
following table describes each mode.

Store Click on this button to store changes to the currently 
recalled setup replacing the old one.

Delete Click on this button to delete the currently selected ID.

Manual The measurement will begin immediately after the 
START button has been pressed in the last wizard page, 
and stop after the predefined time has elapsed.

Trigger In this mode the application will set the analyzer to the 
RUN mode and then continually monitor the measured 
value. When the trigger conditions are met the measure-
ment will begin. The measurement can be stopped after a 
predefined time or when the monitored value goes out-
side of the trigger conditions.

Timer In this mode the measurement will begin when a user 
timer expires, and stop after a predefined time.
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To execute these measurements an averaging mode of Lin-
ear repeat or Exponential must be selected. In the SLM 
mode of the analyzer, the Slow, Fast and Impulse detectors 
are, by definition, Exponential detectors. This selection 
determines how the data is collected inside the analyzer.

It follows that, apart from the connection speed, the preci-
sion in the time of each spectra in the exponential mode is 
worse than in the Linear repeat mode. Of course if the aver-
aging time is less than the time it takes to download a spec-
trum also the Linear repeat mode becomes imprecise.

At a connection speed of 57600 baud we have seen that it is 
possible to get a 1/3 octave spectrum plus some SLM values 
at least every 125 milliseconds.

Measurement Wizard

The measurement wizard consists of a sequence of dialog 
boxes where the measurement parameters can be set.

When first beginning a measurement using the measurement 
wizard, the setup the application must use for the measure-
ment must be selected. The current analyzer setup (the one 
displayed in the Control Panel) can be used, or another setup 
can be loaded using the menu Setup, Open command. The 
measurement wizard will use the analyzer’s active setup that 

Daily In this mode a sequence of measurements are made, one 
for each selected day. The user sets the desired start date 
and number of days the measurement should be made. 
For each selected day the application can do one or two 
measurements, beginning at a predefined time and stop-
ping after a predefined time period.
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is displayed in the control panel to perform the measure-
ments.

Figure 4-18 Measurement wizard - Measurement description 
page

In the first page of the measurement wizard, the measure-
ment name and other identification parameters must be set. 
These parameters are then used in the document window to 
identify the measurement. The application will always dis-
play, as the default, the parameters used in the last wizard 
execution.

This information can also be altered later in the document 
window.
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The second page of the measurement wizard allows selec-
tion of value that are to be stored in the measurement.

Figure 4-19 Measurement wizard - Storage setup page

Initially the same data being displayed is automatically 
selected. More values can be added or deleted depending on 
the desired amount of data needed in the document window.

Store spectrum Select this box to store the spectrum with the measure-
ment. The user can also select which bandwidth to store. 
(1/1 or 1/3 octave.)
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In the next page the general measurement conditions are set.

Figure 4-20 Measurement wizard - General setup page

Store elapsed time as 
calculated by the com-
puter

If this box is cleared then each spectrum will be stored 
with the theoretical time given by the averaging time. If 
this check box is set, the computer calculates the elapsed 
time of each spectrum based on the internal clock of the 
computer.

Add Select this box to add other SLM values.

Remove Select this box to remove the selected SLM value from 
the list.
 4-28 DNA User Manual Data-Navigation-Analysis



The measurement start mode is selected first. See the modes 
description in the previous paragraph.

A password can be set to control measurement interruption. 
When a password is specified, the measurement will not be 
able to be interrupted unless the correct password is inserted 
into the progress window.

Figure 4-21 Measurement wizard - Manual page

In the manual measurement mode, the measurement begins 
when the START button is pressed. The measurement will 
terminate after a predefined time period.

The only parameter that must be set in this page is the mea-
surement duration, in seconds. The application automati-
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cally calculates the required number of spectra required to 
cover the selected duration.

WARNING! If the averaging time is too short, and the computer is not 
able to keep up with the required speed, the computed num-
ber of spectra will be collected; however, the measurement 
duration will be longer than the duration set in this window.

Figure 4-22 Measurement wizard - Trigger page
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In the trigger page the trigger conditions need to be set for 
the desired measurement (measurement start). The measure-
ment stop conditions must also be defined.

This setting selects which band, including SLM values, 
must be monitored for trigger conditions.

Insert the threshold level in dB in this box. When the 
monitored signal reaches, or exceeds, this level, the mea-
surement will begin.

This option will terminate the measurement after a fixed 
period of time.

This option will terminate the measurement when the 
monitored signal level goes below the threshold value.

Select this option when only one measurement is 
required. To rearm after a triggered measurement has 
been executed, restart the measurement wizard.

This setting will cause the trigger conditions to become 
active again after the measurement has stopped. To stop 
the wizard and download the data, press the esc key.

The application is able to store one or more spectra (up to 
1000) preceding the trigger time. This allows storage of 
the data immediately proceeding the trigger event.

This setting is the predefined measurement duration in 
seconds for the fixed time mode.

With this check box set, DNA will run a speed test before 
starting the measurement to make sure that the communi-
cations speed is sufficient to transfer data. If the speed 
test is not passed, DNA will give the user the option to 
disable the Windows™ message loop to speed up com-
munications.

With this check box set, DNA will disable the Win-
dows™ message loop during the measurement. This 
means that the only way to stop the measurement once 
started, is by using the Esc. key.

Frequency/Bin

Threshold level

Stops when a fixed time 
elapsed

Stops when the level goes 
below threshold

One shot trigger

Rearm Automatically

Number of pre-trigger 
spectra stored

Measurement duration

Execute speed test 
before start

Disable Windows™ mes-
sage loop
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Figure 4-23 Measurement wizard - Timer page

The parameters for the Timer mode are the measurement 
interval, measurement duration, the start date, and the start 
time. For the measurement duration see the comments in the 
Manual mode section of this manual.
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Figure 4-24 Measurement wizard - Daily page

The daily measurement mode is used to set the start date and 
the number of days that the measurement is to be repeated. 
For each selected block of time the start time and measure-
ment duration must be set. If the second block is enabled, it 
must start at a time after the end of the first block. For the 
measurement duration see the comments in the Manual 
mode section of this manual.

If the computer has an audio board, the next wizard page is 
used to set up the audio signal recording while the measure-
ment is performed.
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Figure 4-25 Measurement Wizard - Audio page

By default the audio recording is disabled. Click on the 
Enable audio recording check box to activate the other 
fields.

Select the audio input device that will be used (if there is 
more than one audio board installed). Then select the audio 
resolution. When selecting higher audio resolutions, care 
must be taken to make sure that disk space does not run out 
in a short time.

Recording conditions depend on the type of measurement 
selected earlier.
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If doing a triggered measurement, then the audio recording 
start will happen with the same bin, channel and threshold 
condition set for the measurement itself. The recording 
length will be the time specified in this window.

In all other cases, the recording conditions must be set in this 
window.

It is possible to record up to five seconds before the trigger 
time.

The selection of how to rearm the audio trigger must also be 
made. There are two methods to accomplish this function . 
Both of these methods can be used simultaneously. The first 
method functions so that after an audio block ended, the next 
audio block can only start after the level goes below the 
threshold level. The second defines a minimum interval time 
between two consecutive audio blocks.

Look at the last field in the page. It displays approximately 
how much time can be recorded, based on the free disk 
space. Since the application uses the temporary windows 
directory to store temporary files, free space must be avail-
able on the hard disk with the Windows™ temporary direc-
tory.
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Figure 4-26 Measurement wizard - Summary page

In the last wizard page a summary of the executing measure-
ment is displayed. Click on the Finish button to initiate the 
measurement.

Before actually starting the measurement, the application 
performs a test to see if the transmission speed is fast enough 
for the selected averaging time.
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If the time required to download a sample from the analyzer 
is longer than the averaging time, the following warning 
window is displayed.

Figure 4-27 Speed test dialog window

This window reports the average time (based on 10 samples) 
it takes to download a sample. The first is obtained with the 
Windows message loop enabled, while the latter is obtained 
with the Windows message loop disabled.

When the message loop is disabled, the application takes 
less time to read a sample from the analyzer, but during the 
measurement it will remain locked. In this case the only way 
to interrupt a measurement is using the Esc key.
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Destination Document

Since it is possible to run more than one instance of the main 
application, more than one document may exist that can 
receive the measurement's data.

Figure 4-28 Select Destination Document window

When the measurement is started or data is downloaded 
from memory, and more than one document is ready to 
receive the data, a dialog window with the list of documents 
is displayed. There the appropriate document can be selected 
to be the destination document.
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Troubleshooting the analyzer connection 

When problems occur in the connection with the analyzer, 
the application will inform the user with a warning message. 
Given below are some of the possible messages along with 
the possible cause for the message.

WARNING! Access denied error on serial port 
COMx.

This message is received when trying to use a serial port that 
is already used by another device or application. If the port 
is used by another device (e.g. the mouse), specify another 
serial port.

If the port is used by another application, close that applica-
tion or select a different serial port.

WARNING! Cannot read from the analyzer...

The main cause for this message is that there is no physical 
connection between the computer and the analyzer.

For example: the cable may not be connected or the analyzer 
may not be turned on.

WARNING! A time-out error has occurred on serial 
port COMx.

If this message is displayed when trying to connect to the 
analyzer, the probable cause is that the baud rate inside the 
analyzer does not match what is set in the connection dialog 
box of the DNA software.

If the message is displayed after the connection has been 
established, then it may be a software error; for example 
your analyzer can have a new firmware revision not yet sup-
ported by the application.
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WARNING! An error has occurred on serial port 
COMx...

This error should not occur in normal conditions. If it does 
occur it means there is some hardware problem in the com-
munication chain.

The ErrorCode value displayed in the message represents 
the error number reported by Windows.

The most common error reported by Windows is number 2 
(CE_OVERRUN). This error code indicates that the operat-
ing system was unable to read a byte from the serial port 
before the arrival of the next byte.

In case of error 2:

Step 1 Be sure that your computer has buffered serial 
ports (UART 16550).

Step 2 Next check in the communication resources for 
the serial port and enable the buffer.

Step 3 If the problem persists, try using a different baud 
rate.

Step 4 Disable the screen saver.

Step 5 If you are using a Windows 95™ on a laptop, open 
the Power management applet from the Control 
Panel. Click on the Advanced button. Then on the 
Problem solution tab. Finally disable the polling 
of the power status.

Troubleshooting the main application connection 

When problems occur in the connection between the ana-
lyzer window and the main application, a warning message 
will inform the user of the problem. Given here are the pos-
sible messages along with the probably cause that could trig-
ger the message.
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WARNING! Connection with the main application is 
not possible.

The main application is not running. Start the main applica-
tion and retry the command.

The main application is running, but is locked by a previous 
connection crash. Exit the main application, restart it and 
retry the command.

WARNING! Destination document is not yet avail-
able. Data transfer is aborted.

The destination document is not yet ready. Wait until the 
main application has created the document and retry the 
command.

WARNING! Cannot open exchange file.

WARNING! Cannot map exchange file.

The data passes from the analyzer window to the main appli-
cation window through an exchange file. This file is created 
in the Windows temporary directory.

Check that the temporary directory is set correctly.

Check the free disk space on the drive with the temporary 
directory.

If the destination document and the temporary directory are 
on the same drive, and you are performing a measurement 
that will use 100kB remember that you must have more than 
double that in available free space.

WARNING! Main application error: XXX

This message should not occur in normal conditions. It indi-
cates there is a problem in the main application.

Incompatible versions of the main application and the ana-
lyzer window EXE files are probably being used.

Try to reinstall the software.
Data-Navigation-Analysis System 824 Analyzer Window  4-41



 4-42 DNA User Manual Data-Navigation-Analysis



C H A P T E R
5 HVM100 Analyzer Window

Introduction

The analyzer window serves as the interface between the 
document window and the analyzer. In the analyzer window 
the connection with the instrument is established, the mea-
surement setup is prepared, and the actual measurement is 
performed on-line with the instrument. Data can also be 
stored in the instrument’s memory and downloaded into the 
document.
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To open the analyzer window, click on the HVM100 menu 
item in the document window's menu bar. If there is more 
than one analyzer driver interface installed, (for example 
2800/2900/3200 and HVM100) the application will insert a 
menu item called Analyzer. The Analyzer menu item will 
contain a command for each driver interface.

Since the analyzer window is a separate executable file, it 
may be run without launching the main application. In this 
case it is not possible to perform measurements or download 
data from the instrument memory since there is no open doc-
ument ready to receive the measurement data. In any case, 
only one instance of the analyzer window can be run at one 
time. If the menu command is re-selected, the running 
instance is reactivated and displayed.

Using Setups

The Analyzer Window's Setups are handled with commands 
located in the Setup menu. Setups are loaded and saved to 
disk in the same way as other Windows applications. In the 
analyzer window, however; setups are being saved and 
recalled instead of documents.

Opening a Setup To open an existing Setup, click on the Open button in the 
toolbar or use the Open command under the Setup menu.

The standard Open document window enables you to select 
a setup file to open, in this case, files ending with the .hvm 
extension.

Saving a Setup To save the current instrument setup, click on the Save but-
ton on the toolbar or select the Save command under the 
Setup menu. With this command the Setup is saved in the 
same file from which it was loaded. If the current Setup has 
never been saved, then the Save As dialog box is opened. 
From the Save As dialog box a file name can be specified.

To save the current Setup in a different file, use the Save As 
command under the Setup menu. 

Reading a Setup from the 
Analyzer 

Each time the connection with the analyzer is established, or 
every time the instrument type is changed, the analyzer win-
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dow will read and display the complete instrument setup 
from the HVM100.

The setup displayed in the analyzer window always reflects 
the setup that is inside the HVM100.

Writing a Setup to the Analyzer

NOTE: The setup being loaded must be 
of the same type as the instrument cur-
rently selected in the analyzer.

There is no need to manually send a setup to the analyzer. 
When you want to change a setup, simply open the desired 
setup file and it will be uploaded immediately to the ana-
lyzer.

Establishing the Connection

Before establishing a connection with the instrument, the 
communication parameters in the computer and the instru-
ment must be properly set.

Computer To set the communication parameters on the computer side, 
execute the Connect command under the Analyzer menu. In 
the dialog window the communication port and baud rate 
can be selected. The baud rate selected needs to match the 
baud rate selected in the instrument.

Instrument The only communication parameter to be set on the instru-
ment is the baud rate. To select a baud rate, press the Tools 
button on the instrument and then use either the up or down 
arrows on the instrument keypad until the baud rate parame-
ter is displayed. Next, press the Check key on the instrument 
keypad, which will place you in the edit mode. Now, using 
the left and right keys on the instrument keypad, select the 
desired baud rate.

If the “Create log file for this session” box is checked, the 
application creates a file named CAPTURE.TXT where all 
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communication between the instrument and the computer is 
logged. This option is useful for trying to solve communica-
tion problems.

Once these operations have been performed, the connection 
can be established with either the Connect button in the dia-
log box, or by clicking on the Connect button on the toolbar.

When the connection is established, the commands under the 
Analyzer menu can be used to directly control the instru-
ment. The Disconnect command will terminate the current 
session.

The Run, Stop, Reset, and Store commands are direct com-
mands that have the same meaning as the instrument but-
tons. The Control Panel selection will toggle a floating 
window on or off wherein analyzer settings can be changed 
on the fly.

The Delete all setups and delete all files menu items will 
respectively delete all setups from the instrument and delete 
all stored data from the instrument.

The Print Report option will download and print the inter-
nally generated report from the HVM100. The report con-
tains summary information about the instrument setup and 
run/stop informations

The Sync Clock command synchronizes the instrument’s 
clock with the current computer time.

The Internal Setups menu item allows you to either store or 
recall a named setup from one of the HVM100’s internal 
setup registers.
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To store the current instrument setup in one of the setup 
locations, select the location (0-9) and give it a name. When 
you press OK, the setup will be stored in the selected loca-
tion and with the given name.

To recall an instrument setup from one of the internal setup 
locations, select the Recall option from the Internal Setup 
menu item in the Analyzer menu.

The Recall Setup dialog box will be opened, and you will be 
prompted to enter a setup number from 0-9. When you press 
OK, that setup will be recalled into the instrument and will 
become the active setup.

Controlling the Instrument

Once the connection is established, the instrument should be 
operated only through the application window. When the 
instrument is connected to the software, it is still possible to 
change parameters on the instrument. Changes made manu-
ally to the instrument will result in a difference between the 
Analyzer Window of the software and the instrument. To re-
synchronize the application and the instrument, you will 
need to disconnect from the instrument and re-establish a 
connection.

Instrument control is handled through a window called the 
Vibration Control Panel.
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In the Vibration Control Panel are several tabbed dialog 
boxes that control the different instrument settings. These 
settings are always in sync with the settings on the instru-
ment itself; every parameter that is modified in the Vibration 
Control Panel is immediately sent to the instrument.

Four buttons are present in the Vibration Control Panel that 
can be used to send the RUN, STOP, RESET and STORE 
commands to the instrument.

To configure the different operating modes of the HVM100 
(Vibration, Hand-Arm and Whole Body) select the appropri-
ate option under the Mode command in the Edit menu. You 
will need to be connected to the instrument to make these 
changes.

To change the display units and integration mode, select the 
appropriate commands under the Edit menu.

You can also change the way data is formatted on the DNA 
screen by changing the unit formatting. To access this win-
dow, select the Unit Formats command under the Edit win-
dow.
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You can select a unit, and change the way it will be dis-
played on screen.

Display The analyzer window can display data in real-time as it is 
displayed on the instrument screen.

The window itself can be divided into panes, each pane con-
taining a graph, in order to display different aspects of the 
instrument’s data. To change the number and position of the 
panes, select the Display menu item from the View menu.

There are two different types of graphs available in the ana-
lyzer window: SLM and History. The SLM graph shows 
data from the instantaneous levels from the instrument, 
while the History graph shows changes in values over time.
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The setup of the graph is accomplished through a context-
sensitive popup menu. To access this menu, right-click the 
mouse inside the desired pane, and select the desired com-
mand from the menu.

The first two commands in the popup menu are used to 
select between the two graph types. The Properties com-
mand opens a dialog box where the parameters for that 
graph can be set. The Properties window can also be opened 
by double-clicking the left mouse button in the desired pane.

The Properties window is structured the same for both graph 
types.

The first tab, called General, enables the setting of the gen-
eral aspects of the graph, including font, background color 
and border type.
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The second and third tabs contain the parameters for the 
graph’s horizontal and vertical axis, including the axis range 
and label increments.

The fourth tab contains the settings for controlling what data 
is displayed in the graph, and the color used to display that 
data.
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The Value Window command opens a window for the 
selected graph showing the actual values being graphed. 
Right-clicking the mouse in the Value window allows you to 
change the font and color of the displayed text in the win-
dow.

Measurement Download

The HVM100 can store measured data in its internal mem-
ory. It has a simple file system to store multiple measure-
ment data sets, but only one file at a time can be loaded into 
the active memory and thus be accessible.

To download measurement data, use the Download from 
Analyzer command under the Measurement menu item.

If the current data set has not yet been stored, the software 
will ask you to store the data before proceeding with a 
download.
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Here you can select which file to store the data in, or allow 
the software to find an available file.

When you are ready to begin downloading measurement 
data, you will be taken to the Download analyzer’s file dia-
log box, which allows you to select which files in the instru-
ment’s memory you wish to download.

After selecting the files, click on the Download button and 
the data will be transferred. When the data has been success-
fully transferred, you will be given the chance to add 
descriptions to each data set to help remind you about its 
contents.
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Measurement Execution Beyond simply downloading the instrument memory, mea-
surements can be performed by directly controlling the 
instrument with the application.

To execute a measurement, simply select the Execute Wiz-
ard command from the measurement menu. The measure-
ment wizard will guide you through the process of making a 
measurement.

There are four measurement execution modes which deter-
mine how a measurement is started and stopped.

• Manual - The measurement will begin immediately after 
the start button has been pressed, and stop after the pre-
defined time has elapsed.

• Trigger - In this mode the application will set the instru-
ment into run mode and continuously monitor the 
selected value. When the trigger condition is met, the 
measurement will begin. The measurement can be 
stopped after a predefined time period, or when the mon-
itored value goes out of range.

• Timer - In this mode the measurement will begin at a 
predetermined time and stop after a predefined time.
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• Daily - In this mode, a sequence of measurements are 
made for each selected day. The user sets the start day 
and the number of consecutive days the measurement 
should be made. For each selected day, the instrument 
can do either one or two measurements.

Measurement Wizard

The measurement wizard consists of a series of dialog boxes 
where measurement parameters are set.

When first beginning a measurement using the wizard, you 
must remember to first load the correct setup file into the 
analyzer for the type of measurement you are conducting.

In the first page of the measurement wizard, the measure-
ment name and other identification parameters must be set. 
These parameters are then used in the document window to 
identify the measurement. The application will always dis-
play, as a default, the last values used in the measurement 
wizard.
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This information can also be modified later in the document 
window.

The second page of the measurement window allows selec-
tion of values that are to be stored in the measurement.

The values displayed in the Store List will be recorded in the 
measurement. Use the left and right buttons on the dialog 
box to add or remove measurement values from the mea-
surement.

The next page of the wizard allows you to set the general 
parameters for the measurement, including the start mode 
and password. If a password is specified, the measurement 
cannot be interrupted unless the correct password is sup-
plied.
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If Manual measurement mode is selected, the next screen 
will allow you to specify the measurement interval and dura-
tion.
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In this measurement mode, the measurement begins after 
you have finished the wizard and press the start button.

WARNING! If the averaging time is too short, and the computer is not 
able to keep up with the required speed, the computed num-
ber of samples will be collected, however, the measurement 
duration will be longer than the duration set in this window.

If the Trigger measurement mode is selected, the conditions 
that need to be met before a measurement will begin are 
entered in this window.

• Measurement interval - Indicates how often to monitor 
the selected data sets. 

• Trigger condition - Indicates which data set will be used 
for the trigger condition.

• Threshold - Indicates the level that must be met or 
exceeded for the measurement to begin.

• Stops when a fixed time elapses - This option will termi-
nate a measurement after a fixed period of time.

• Stops when the level goes below the threshold - This 
option will terminate the measurement when the moni-
tored signal level goes below the threshold value.
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• One shot trigger - Select this option when only one mea-
surement is required. To re-arm after a triggered mea-
surement has been executed, restart the measurement 
wizard.

• Rearm Automatically - This setting will cause the trigger 
conditions to become active again after the measurement 
has stopped.

• Number of pre-trigger spectra stored - The application is 
able to store up to 1000 spectra preceding the trigger 
event.

• Measurement duration - This setting is the predefined 
measurement duration in seconds for the fixed time mea-
surement.

The parameters for a Timer Mode measurement are the mea-
surement interval, the measurement duration, and the start 
date and time.
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The daily measurement mode is used to set the start date and 
the number of days that the measurement is to be repeated. 
For each selected block of time, the start time and measure-
ment duration must be set. If the second block is enabled, it 
must start at a time after the end of the first block.
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The COM Port error handling window allows you to specify 
what effects communications errors have on your measure-
ment. Here you can instruct the software to stop the mea-
surement when an error occurs, or after a set number of 
errors has occurred, or to ignore communications errors. You 
can also specify what errors to check for, and if the software 
should save the data before ending the measurement after an 
error.

If the computer has an audio card installed, the next page of 
the measurement wizard will allow you to set up audio sig-
nal recording while the measurement is performed.

By default this option is disabled. Click on the Enable audio 
recording button to enable the other fields. 

Select the audio input device that will be used (if more than 
one audio card is installed). Then select the audio resolution. 
Audio files for higher resolution recordings are quite large, 
so it is necessary to check available disk space before 
recording a long measurement at high resolutions.

Recording conditions depend on the type of measurement 
selected earlier. If doing a triggered measurement, then the 
audio recording will start with the same conditions specified 
earlier. In all other cases, the recording conditions must be 
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set in this window. It is possible to record up to 5 seconds 
before the trigger time.

The selection of how to rearm the audio trigger must also be 
made. There are two methods to accomplish this function, 
and both can be used simultaneously. The first method func-
tions so that after the audio block ends, the next audio block 
can only start after the level goes below the threshold level. 
The second defines a minimum interval time between two 
consecutive audio blocks.

The last wizard page contains a summary of the measure-
ment parameters. Click on the Finish button to begin the 
measurement.

Destination Document Since it is possible to run more than one instance of the main 
application, more than one document may exist that can 
receive the measurement data.
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When the measurement is started, or data is downloaded 
from the instrument, and more than one document is ready 
to receive the data, a dialog box with the list of available 
documents is displayed. There the appropriate document can 
be selected as the target for the measurement data.
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C H A P T E R
6 System 814 Analyzer 
Window

Introduction

The analyzer window serves as the interface between the 
document window and the analyzer. In the analyzer window 
the connection with the instrument is established, the mea-
surement setup is prepared, and the actual measurement is 
performed on-line with the instrument. Data can also be 
stored in the instrument’s memory and downloaded into the 
document.
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Figure 6-1 Analyzer Window example

To open the analyzer window, click on the 814 menu item in 
the document window's menu bar. If there is more than one 
analyzer driver interface installed, (for example 2800/2900/
3200 and 814) the application will insert a menu item called 
Analyzer. The Analyzer menu item will contain a command 
for each driver interface.

Since the analyzer window is a separate executable file, it 
may be run without launching the main application. In this 
case it is not possible to perform measurements or download 
data from the instrument memory since there is no open doc-
ument ready to receive the measurement data. In any case, 
only one instance of the analyzer window can be run at one 
time. If the menu command is re-selected, the running 
instance is reactivated and displayed.

Using Setups

The Analyzer Window's Setups are handled with commands 
located in the Setup menu. Setups are loaded and saved to 
disk in the same way as other Windows applications. In the 
analyzer window, however; setups are being saved and 
recalled instead of documents.

Opening a Setup To open an existing Setup, click on the Open button in the 
toolbar or use the Open command under the Setup menu.

The standard open document window enables the selection 
of a file to open. From the open window, disks and folders 
can be accessed to find the desired file.

Saving a Setup To save the current Setup, click on the Save button in the 
toolbar or use the Save command under the Setup menu. 
With this command the Setup is saved in the same file from 
which it was loaded. If the current Setup has never been 
saved then the Save As dialog box is opened. From the Save 
As dialog box a file name can be specified.

To save the current Setup in a file different from the original 
one, use the Save As command under Setup menu.
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The standard Save As dialog box is opened; there a file 
name can be specified and the disk and folder can be 
selected to store the file.

Reading a Setup from the 
Analyzer 

Each time the connection with the analyzer is established, or 
every time the instrument type is changed, the analyzer win-
dow will read the complete setup from the 814 analyzer.

The setup displayed in the analyzer window always reflects 
the setup that is inside the analyzer.

Writing a Setup to the Analyzer

NOTE: The setup being loaded must be 
of the same type as the instrument cur-
rently selected in the analyzer.

There is no need to manually send a setup to the analyzer. 
When you want to change a setup, simply open the desired 
setup and it will be uploaded immediately to the analyzer.

Establishing the Connection

Before establishing a connection with the analyzer, the com-
munication parameters in the Analyzer window and on the 
instrument must be properly set.

Computer To set the communication parameters on the computer side, 
execute the Connect command under the Analyzer menu. In 
the dialog window the communication port, the baud rate 
and the stop bits can be selected.

Analyzer There is no need to set the communication parameters on the 
analyzer. The application should be able to automatically set 
the communication parameters on the analyzer.

The communications parameters cannot be accessed when 
establishing a connection by selecting the connect button on 
the toolbar.

Additional setting for Windows 
95/98™

Windows 95/98™ users must execute an additional setting 
in order to have a successful connection. The required set-
ting is to lower the transmit buffer of the communication 
port, otherwise the 814 will likely display the "Overrun 
error" message.

Step 1 Open the Control Panel
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Step 2 Double-click on the System icon

Step 3 Click on the Device Manager tab

Step 4 Select the communication port used to connect to 
the 814

Step 5 Click on the Properties button

Step 6 Click on the Port Settings tab

Step 7 Click on the Advanced button

Step 8 Set the transmit buffer to 1 (lower setting)

Step 9 Confirm the changes by clicking the OK button on 
all the opened dialog boxes.

Figure 6-2 Analyzer Connection window

The Flow control parameter is enabled only for baud rates of 
9600 or less. For higher baud rates it is preset to Hardware.

If the Create log file box is selected, then the application cre-
ates a file (named CAPTURE.TXT) where all communica-
tion data flow between the analyzer and the computer is 
recorded. This option can be useful to solve communication 
problems.

Once these operations have been performed, the connection 
can be made either with the Connect button in the Connec-
tion dialog, or with the corresponding button on the toolbar.
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When the analyzer is connected information can be obtained 
about the analyzer with the About Analyzer... command 
under the ? menu.

Figure 6-3 Analyzer information window

The other commands under the Analyzer menu can be used 
to directly control the instrument.

The Disconnect command will terminate the current ana-
lyzer session.

The Run, Stop, Reset and Store commands are direct com-
mands that have the same function as the corresponding ana-
lyzer's buttons.

The Control Panel command will open or close a floating 
window where the analyzer’s settings can be changed on the 
fly.
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The File Handler command will open a dialog box where the 
analyzer’s file system can be directly manipulated.

The Setup Handler command opens a dialog box where the 
814 instrument (or setup) type can be manipulated.

The Sync Clock command synchronizes the analyzer's clock 
with the computer time.

Connecting Through a Modem

This feature is supported only under Windows 95, Windows 
98 or Windows NT 4.0 or later.

With version 3.00, or greater, of the DNA software it is pos-
sible to establish a connection between the PC and the 814 
through a modem and a phone line.

Connecting through a modem is a sophisticated task. It is 
necessary to understand the method of communications 
between all of the devices in the chain.

Using the modem To use the modem to connect to a remote instrument the 
device chain must be composed of a PC, a modem con-
nected to the PC (local modem), a telephone line, a modem 
connected to the instrument (remote modem) and the ana-
lyzer itself.

To establish a connection three links must exist: the PC must 
be able to communicate with the local modem, the local 
modem must communicate with the remote modem and the 
remote modem must communicate with the analyzer.

Link 1 - PC to Local Modem

At least one modem must be installed in the Windows™ 
environment. The application can then use that modem in 
the same way as other windows applications. This commu-
nication should be transparent to the user as windows should 
take care of all the details.
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Link 2 - Local Modem to the Remote Modem

This connection should also be transparent as well. 

Remote Modem to 814

This is the connection where problems are most likely to 
occur. The problems are caused because the analyzer does 
not facilitate control of the modem.

The remote modem needs to be set up using the PC and a 
HyperTerminal connection, or some other communication 
protocol.

There are three categories of problems.

The CBL006 that comes standard with the System 824, is 
used for direct RS-232 communication to a PC. It is not 
suitable for modem communication by itself.

The desired modem cable is CBL003 (available from 
Larson Davis), for modems with a 25 pin connector, If 
the modem being used has a 9 pin connector, then the 
standard communication cable, CBL006, can be used 
with a Null Modem adapter.

The 824 and the modem must be arranged so that they are 
using the same baud-rate. If they are not communicating 
at the same baud rate, the analyzer will give a continuos 
stream of errors.

In general all modems have a command to select a fixed 
speed between the modem and the attached device.

In some cases it may also require setting the local and 
remote modems’ to communicate at the same speed as 
the analyzer.

It may also be necessary to setup the modem for the 
proper RS-232 handshaking control lines. For example 
some modems require the "Ignore DTR" parameter to be 
set. Others might require the "DSR always active" param-
eter to be set.

Connection cable

Communication speed

Handshaking control pin
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There are no definitive standards that govern modem com-
munication. Many times trial and error will be necessary to 
facilitate modem communications.

Once the remote modem is configured correctly, the config-
uration MUST be stored inside the modem itself. This will 
allow it to load automatically each time the modem is pow-
ered on. If this is not done the modem will revert back to a 
default configuration the first time the modem is turned off. 
To store the current configuration in the modem use the 
command AT&W. This command is supported by most 
modems.

WARNING! Even though the modem is configured correctly, the analyzer 
will still display errors during the connection phase. The rea-
son for this is that the modem sends a code result to the con-
nected device (RING, CONNECT..., etc.) that the analyzer is 
not able to understand. When the connection phase is over 
the modem becomes transparent and communication should 
continue without any further errors.
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Controlling the Analyzer

Once the connection is established, the analyzer should be 
operated only through the application window. When the 
application is connected it is still possible to operate on the 
814 keypad and change parameters. Changes made manually 
on the instrument will lead to a difference between the ana-
lyzer and the application. To re-synchronize the application 
and the analyzer, it is necessary to disconnect from the ana-
lyzer and reestablish the connection.

The analyzer control is handled through a window called 
Analyzer Control Panel.

Figure 6-4 Analyzer's Control Panel

In the Control Panel there are several tabbed dialog boxes 
that contain the analyzer’s settings.

Since the setups for the different instrument types are not the 
same, the application displays a different control panel for 
each instrument type. The control panel title will include the 
instrument type.

Four buttons are present in the Control Panel. These buttons 
can be used to send the RUN, STOP, RESET or STORE 
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commands to the analyzer. Clicking on the RESET button 
will open a popup menu with the Reset options.

Display

The analyzer window can display data in real time as it is 
displayed on the analyzer screen.

The window itself can be divided into panes, each pane con-
taining a graph, in order to display different aspects of the 
analyzer's data.

Displayed graph are of four types: spectra, SLM, time his-
tory and sonogram. Spectra and SLM graphs always display 
data from the same instantaneous spectrum. The time history 
displays the changes of a single value along the time axis.

The spectrum graph display s a series of bars that represent 
each frequency band. The SLM graph display a series of 
bars with the values from the SLM analyzer. The System 
814 has several instrument modes, each having a different 
set of available data. The data that can be displayed in the 
live display of DNA is governed by the data that is available 
from the analyzer.

In the time history graph the abscissa (X) axis always rep-
resents time, and its amplitude is selectable by the user.
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Figure 6-5 Example of graph with context menu

The setup of the graph in a pane is accomplished through a 
context menu. To access the context menu, use the right 
mouse button and click inside the desired pane. The appro-
priate command can then be selected from the context menu.

The first two commands are used to select the type of graph 
displayed. The Properties command opens a dialog window 
where the parameters for that graph can be set. The Value 
window command opens or closes a window that will dis-
play numerically the values from the selected graph. The 
Properties window can also be opened by double-clicking 
with the left mouse button inside a pane.

The properties window is structured the same for all graph 
types.

The first page, called General, enables the settings of the 
general aspects of the graph. The second page contains the 
parameters for the graph's horizontal axis. The third page 
contains the parameters for the vertical axis. The fourth page 
contains the settings that control the trace displays.
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The following figure shows an example of each page in the 
properties window. This particular display is from a spec-
trum graph, but the properties window is the same for the 
other graph types as well.

Figure 6-6 Spectrum properties - General tab

In the General tab, the following parameters are set:

Click on this button to change the pen used to draw the 
graph's border.

Click on this button to set the graph's background color.

Click on this button to change the font used to draw the 
graph heading.

Border

Background

Header font
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Figure 6-7 Spectrum properties - Horizontal axis tab

The Horizontal axis tab controls the following parameters:

Click on this button to set the pen used to draw the main 
grid line.

Click on this button to set the pen used to draw the sec-
ondary grid line.

Click on this button to change the font used to draw the 
axis labels.

Main grid

Sub grid

Font
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Figure 6-8 Spectrum properties - Vertical axis tab

The Vertical axis tab controls the following parameters:

Main grid Click on this button to set the pen used to draw the main 
grid line.

Sub grid Click on this button to set the pen used to draw the sec-
ondary grid line.

Start, Stop and Step Insert values in these boxes to define the axis amplitude 
and the label steps.

Font Click on this button to change the font used to draw the 
axis labels.

In the SLM graph type each value is represented as an inde-
pendent line on the graph. The value that is to be displayed 
must be selected first, and then the settings for that value can 
be modified.
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Figure 6-9 SLM properties - SLM tab

The parameters in the SLM Properties tab include:

Set the current bin bar color.

Set the trace name as it is displayed on the graph.

Add a trace to the list.

Delete the selected measurement from the graph.

Bar color

Name

Add bar

Remove bar
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Figure 6-10 Time History properties - History tab

The parameters in the history tab are:

Set the current trace's pen color.

Set the trace name as it is displayed on the graph.

Add a trace to the list.

Delete the selected trace from the graph.

Value Window

It is possible to associate a value window with each dis-
played graph that numerically displays the current value.

The font used to display the header and the data can be 
altered in each value window to improve the readability of 
the display.

To change the font, click inside the value window with the 
right mouse button. The context menu displayed contains 
two commands. The first command is used to set the value 

Pen color

Name

Add bar

Remove bar
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font, the second is used to set the font that is to be used for 
the header. 

Figure 6-11 Example of Value window connected to a SLM 
graph

The type and number of values displayed depends on the 
type of graph in the connected pane.

Measurement Download

The 814 analyzer can store measured data with its internal 
memory. It has a simple file system to store several measure-
ment data sets, but only one file at a time can be loaded into 
the active memory and thus be accessible.

Every data set can hold more the one RUN/STOP. The appli-
cation converts each RUN/STOP into a single measurement.

To download measurement data, use the “Download from 
analyzer” command in the Measurement menu.

In the first wizard page select the data download mode. The 
choices include Binary transfer and ASCII transfer. It is pos-
sible to download a binary image without translating the 
data, or to translate a binary image previously downloaded. 
The translate feature also works with files downloaded with 
the Larson Davis 814 Utility program.
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Figure 6-12 Download wizard - Transfer method page

The Binary transfer is the method of choice for large data 
sets and long time histories. The ASCII transfer is faster for 
small data sets.
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Figure 6-13 Download wizard - File selection page

The second wizard page allows selection of the files that are 
to be downloaded. It also gives the option to download the 
data contained in the active memory, but has not yet been 
stored to a file.
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Figure 6-14 Download wizard - Data storage page

The third wizard page selects what data should be stored 
with the measurement.

When the wizard is finished, the application will begin to 
immediately download the data, and store it in a temporary 
file. At the end of the download, the user will be prompted 
for the measurement description for each RUN/STOP 
sequence encountered.

The downloaded data is then immediately transferred to the 
open document in the document window. To see a down-
loaded measurement, the document window must be acti-
vated. To see the data in the document, open the document 
contents window. The downloaded measurements will be 
listed there, along with any previously downloaded data. At 
the end of the download sequence the main document win-
dow is brought to the foreground.
 6-20 DNA User Manual Data-Navigation-Analysis



File handler

Execute the File Handler command under the Analyzer 
menu to open the dialog window for handling the 814 files.

In the dialog box there is a list of files stored on the analyzer 
and the commands to manipulate them.

Figure 6-15 Analyzer’s file handler window

At the top of the list two fields report the used and free mem-
ory sizes on the analyzer.

Below is the name of the currently recalled file, if one is 
available.

The Recall button will load the selected file into the current 
active memory so it can be downloaded.

The Store button will store the data currently in active mem-
ory to a new file in the analyzer memory.
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Delete will delete the selected file from the analyzer mem-
ory.

Analyzer's Instruments

Use the Setup handler... command under the Analyzer menu 
to open a dialog window to select a particular instrument and 
setup.

A list displays the instrument setups stored in the analyzers 
memory.

The first 5 instrument setups are permanent and cannot be 
changed or deleted.

Figure 6-16 Instrument setup dialog window
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Below the list the currently selected ID name and number of 
allocated ID (setups) is displayed. Use the Change button to 
change the number of allocated Ids.

Click on this button to recall the selected ID into the 
active instrument memory. The analyzer must be in a 
Reset-All condition to change instrument types.

Click on this button to create a new ID using the current 
instrument setup.

Click on this button to store changes to the currently 
recalled setup replacing the old one.

Click on this button to delete the currently selected ID.

The Read only box can be set to make the selected setup a 
read-only setup.

Measurement Execution

Beyond simply downloading the instrument memory, m 
measurements can be performed by directly controlling the 
instrument with the application.

To execute a measurement simply select the appropriate 
command in the Measurement menu. A Measurement Wiz-
ard will guide you through the process of making a measure-
ment.

There are four measurement execution modes. These modes 
determine how a measurement is started and stopped. The 
following table describes each mode.

Recall

Create

Store

Delete

Manual The measurement will begin immediately after the 
START button has been pressed in the last wizard page, 
and stop after the predefined time has elapsed.
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To execute these measurements an Exponential averaging 
mode. In the SLM mode of the analyzer, the Slow, Fast and 
Impulse detectors are, by definition, Exponential detectors. 
This selection determines how the data is collected inside 
the analyzer.

Trigger In this mode the application will set the analyzer to the 
RUN mode and then continually monitor the measured 
value. When the trigger conditions are met the measure-
ment will begin. The measurement can be stopped after a 
predefined time or when the monitored value goes out-
side of the trigger conditions.

Timer In this mode the measurement will begin when a user 
timer expires, and stop after a predefined time.

Daily In this mode a sequence of measurements are made, one 
for each selected day. The user sets the desired start date 
and number of days the measurement should be made. 
For each selected day the application can do one or two 
measurements, beginning at a predefined time and stop-
ping after a predefined time period.
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Measurement Wizard

The measurement wizard consists of a sequence of dialog 
boxes where the measurement parameters can be set.

When first beginning a measurement using the measurement 
wizard, the setup the application must use for the measure-
ment must be selected. The current analyzer setup (the one 
displayed in the Control Panel) can be used, or another setup 
can be loaded using the menu Setup, Open command. The 
measurement wizard will use the analyzer’s active setup that 
is displayed in the control panel to perform the measure-
ments.

Figure 6-17 Measurement wizard - Measurement description 
page
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In the first page of the measurement wizard, the measure-
ment name and other identification parameters must be set. 
These parameters are then used in the document window to 
identify the measurement. The application will always dis-
play, as default, the parameters used in the last wizard exe-
cution.

This information can also be altered later in the document 
window.

The second page of the measurement wizard allows selec-
tion of values that are to be stored in the measurement.

Figure 6-18 Measurement wizard - Storage setup page
 6-26 DNA User Manual Data-Navigation-Analysis



Initially the same data being displayed is automatically 
selected. More values can be added or deleted depending on 
the desired amount of data needed in the document window.

Select this box to store the spectrum with the measure-
ment. The user can also select which bandwidth to store. 
(1/1 or 1/3 octave.)

If this box is cleared then each spectrum will be stored 
with the theoretical time given by the averaging time. If 
this check box is set, the computer calculates the elapsed 
time of each spectrum based on the internal clock of the 
computer.

Select this box to add other SLM values.

Select this box to remove the selected SLM value from 
the list.

In the next page the general measurement conditions are set.

Store spectrum

Store elapsed time as 
calculated by the com-
puter

Add

Remove
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Figure 6-19 Measurement wizard - General setup page

The measurement start mode is selected first. See the modes 
description in the previous paragraph.

A password can be set to control measurement interruption. 
When a password is specified, the measurement will not be 
able to be interrupted unless the correct password is inserted 
into the progress window.
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Figure 6-20 Measurement wizard - Manual page

In the manual measurement mode, the measurement begins 
when the START button is pressed. The measurement will 
terminate after a predefined time period.

The only parameter that must be set in this page is the mea-
surement duration, in seconds. The application automati-
cally calculates the required number of spectra required to 
cover the selected duration.

WARNING! If the averaging time is too short, and the computer is not 
able to keep up with the required speed, the computed num-
ber of spectra will be collected; however, the measurement 
duration will be longer than the duration set in this window.
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Figure 6-21 Measurement wizard - Trigger page

In the trigger page the trigger conditions need to be set for 
the desired measurement (measurement start). The measure-
ment stop conditions must also be defined.

Frequency/Bin This setting selects which band, including SLM values, 
must be monitored for trigger conditions.

Threshold level Insert the threshold level in dB in this box. When the 
monitored signal reaches, or exceeds, this level, the mea-
surement will begin.
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Stops when a fixed time 
elapsed

This option will terminate the measurement after a fixed 
period of time.

Stops when the level goes 
below threshold

This option will terminate the measurement when the 
monitored signal level goes below the threshold value.

One shot trigger Select this option when only one measurement is 
required. To rearm after a triggered measurement has 
been executed, restart the measurement wizard.

Rearm Automatically This setting will cause the trigger conditions to become 
active again after the measurement has stopped. To stop 
the wizard and download the data, press the esc key.

Number of pre-trigger 
spectra stored

The application is able to store one or more spectra (up to 
1000) preceding the trigger time. This allows storage of 
the data immediately proceeding the trigger event.

Measurement duration This setting is the predefined measurement duration in 
seconds for the fixed time mode.

Post under threshold 
overtime

This is the time the application will measure after the 
trigger conditions have been released. This value corre-
sponds to the minimum distance between two consecu-
tive events. In fact, if the level exceeds the threshold 
before this time elapses, the current measurement is con-
tinued as if the signal had never gone below the thresh-
old.

Execute speed test 
before start

With this check box set, DNA will run a speed test before 
starting the measurement to make sure that the communi-
cations speed is sufficient to transfer data. If the speed 
test is not passed, DNA will give the user the option to 
disable the Windows™ message loop to speed up com-
munications.

Disable Windows™ mes-
sage loop

With this check box set, DNA will disable the Win-
dows™ message loop during the measurement. This 
means that the only way to stop the measurement once 
started, is by using the Esc. key.
Data-Navigation-Analysis System 814 Analyzer Window  6-31



Figure 6-22 Measurement wizard - Timer page

The parameters for the Timer mode are the measurement 
interval, measurement duration, the start date, and the start 
time. For the measurement duration see the comments in the 
Manual mode section of this manual.
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Figure 6-23 Measurement wizard - Daily page

The daily measurement mode is used to set the start date and 
the number of days that the measurement is to be repeated. 
For each selected block of time the start time and measure-
ment duration must be set. If the second block is enabled, it 
must start at a time after the end of the first block. For the 
measurement duration see the comments in the Manual 
mode section of this manual.

If the computer has an audio board, the next wizard page is 
used to set up the audio signal recording while the measure-
ment is performed.
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Figure 6-24 Measurement Wizard - Audio page

By default the audio recording is disabled. Click on the 
Enable audio recording check box to activate the other 
fields.

Select the audio input device that will be used (if there is 
more than one audio board installed). Then select the audio 
resolution. When selecting higher audio resolutions, care 
must be taken to make sure that disk space does not run out 
in a short time.
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Recording conditions depend on the type of measurement 
selected earlier.

If doing a triggered measurement, then the audio recording 
start will happen with the same bin, channel and threshold 
condition set for the measurement itself. The recording 
length will be the time specified in this window.

In all other cases, the recording conditions must be set in this 
window.

It is possible to record up to five seconds before the trigger 
time.

The selection of how to rearm the audio trigger must also be 
made. There are two methods to accomplish this function . 
Both of these methods can be used simultaneously. The first 
method functions so that after an audio block ended, the next 
audio block can only start after the level goes below the 
threshold level. The second defines a minimum interval time 
between two consecutive audio blocks.

Look at the last field in the page. It displays approximately 
how much time can be recorded, based on the free disk 
space. Since the application uses the temporary windows 
directory to store temporary files, free space must be avail-
able on the hard disk with the Windows™ temporary direc-
tory.
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Figure 6-25 Measurement wizard - Summary page

In the last wizard page a summary of the executing measure-
ment is displayed. Click on the Finish button to initiate the 
measurement.

Before actually starting the measurement, the application 
performs a test to see if the transmission speed is fast enough 
for the selected averaging time.
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If the time required to download a sample from the analyzer 
is longer than the averaging time, the following warning 
window is displayed.

Figure 6-26 Speed test dialog window

This window reports the average time (based on 10 samples) 
it takes to download a sample. The first is obtained with the 
Windows message loop enabled, while the latter is obtained 
with the Windows message loop disabled.

When the message loop is disabled, the application takes 
less time to read a sample from the analyzer, but during the 
measurement it will remain locked. In this case the only way 
to interrupt a measurement is using the Esc key.
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Destination Document

Since it is possible to run more than one instance of the main 
application, more than one document may exist that can 
receive the measurement's data.

Figure 6-27 Select Destination Document window

When the measurement is started or data is downloaded 
from memory, and more than one document is ready to 
receive the data, a dialog window with the list of documents 
is displayed. There the appropriate document can be selected 
to be the destination document.
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Troubleshooting the analyzer connection 

When problems occur in the connection with the analyzer, 
the application will inform the user with a warning message. 
Given below are some of the possible messages along with 
the possible cause for the message.

WARNING! Access denied error on serial port 
COMx.

This message is received when trying to use a serial port that 
is already used by another device or application. If the port 
is used by another device (e.g. the mouse), specify another 
serial port.

If the port is used by another application, close that applica-
tion or select a different serial port.

WARNING! Cannot read from the analyzer...

The main cause for this message is that there is no physical 
connection between the computer and the analyzer.

For example: the cable may not be connected or the analyzer 
may not be turned on.

WARNING! A time-out error has occurred on serial 
port COMx.

If this message is displayed when trying to connect to the 
analyzer, the probable cause is that the baud rate inside the 
analyzer does not match what is set in the connection dialog 
box of the DNA software.

If the message is displayed after the connection has been 
established, then it may be a software error; for example 
your analyzer can have a new firmware revision not yet sup-
ported by the application.
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WARNING! An error has occurred on serial port 
COMx...

This error should not occur in normal conditions. If it does 
occur it means there is some hardware problem in the com-
munication chain.

The ErrorCode value displayed in the message represents 
the error number reported by Windows.

The most common error reported by Windows is number 2 
(CE_OVERRUN). This error code indicates that the operat-
ing system was unable to read a byte from the serial port 
before the arrival of the next byte.

In case of error 2:

Step 1 Be sure that your computer has buffered serial 
ports (UART 16550).

Step 2 Next check in the communication resources for 
the serial port and enable the buffer.

Step 3 If the problem persists, try using a different baud 
rate.

Step 4 Disable the screen saver.

Step 5 If you are using a Windows 95™ on a laptop, open 
the Power management applet from the Control 
Panel. Click on the Advanced button. Then on the 
Problem solution tab. Finally disable the polling 
of the power status.

Troubleshooting the main application connection 

When problems occur in the connection between the ana-
lyzer window and the main application, a warning message 
will inform the user of the problem. Given here are the pos-
sible messages along with the probably cause that could trig-
ger the message.
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WARNING! Connection with the main application is 
not possible.

The main application is not running. Start the main applica-
tion and retry the command.

The main application is running, but is locked by a previous 
connection crash. Exit the main application, restart it and 
retry the command.

WARNING! Destination document is not yet avail-
able. Data transfer is aborted.

The destination document is not yet ready. Wait until the 
main application has created the document and retry the 
command.

WARNING! Cannot open exchange file.

WARNING! Cannot map exchange file.

The data passes from the analyzer window to the main appli-
cation window through an exchange file. This file is created 
in the Windows temporary directory.

Check that the temporary directory is set correctly.

Check the free disk space on the drive with the temporary 
directory.

If the destination document and the temporary directory are 
on the same drive, and you are performing a measurement 
that will use 100kB remember that you must have more than 
double that in available free space.

WARNING! Main application error: XXX

This message should not occur in normal conditions. It indi-
cates there is a problem in the main application.

Incompatible versions of the main application and the ana-
lyzer window EXE files are probably being used.

Try to reinstall the software.
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C H A P T E R
7 712-720-812-820-870 
Analyzer Window

Introduction

The analyzer window serves as the interface between the 
document window and the analyzer. In the analyzer window 
the connection with the instrument is established, the mea-
surement setup is prepared, and the actual measurement is 
performed on-line with the instrument. Data can also be 
stored in the instrument’s memory and downloaded into the 
document.
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Figure 7-1 Analyzer Window example

To open the analyzer window click on the 712/720/812/820/
870 menu item in the document window's menu bar. If there 
is more than one analyzer driver interface installed, (for 
example 712/720/812/820/870 and 824) the application will 
insert a menu item called Analyzer. The Analyzer menu item 
will contain a command for each driver interface.

Since the analyzer window is a separate executable file, it 
may be run without launching the main application. In this 
case it is not possible to perform measurements or download 
data from the instrument memory since there is no open doc-
ument ready to receive the measurement data. In any case, 
only one instance of the analyzer window can be run at one 
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time. If the menu command is re-selected, the running 
instance is reactivated and displayed.

Using Setups

The Analyzer Window's Setups are handled with commands 
located in the Setup menu. Setups are loaded and saved to 
disk in the same way as other Windows applications. In the 
analyzer window, however; setups are saved and recalled 
instead of documents.

Opening a Setup To open an existing Setup, click on the Open button in the 
toolbar or use the Open command under the Setup menu.

The standard open document window enables the selection 
of a file to open. From the open window, disks and folders 
can be accessed to find the desired file.

Saving a Setup To save the current Setup, click on the Save button in the 
toolbar or use the Save command under the Setup menu. 
With this command the Setup is saved in the same file from 
which it was loaded. If the current Setup has never been 
saved then the Save As dialog box is opened. From the Save 
As dialog box a file name can be specified.

To save the current Setup in a file different from the original 
one, use the Save As command under Setup menu.

The standard Save As dialog box is opened; there a file 
name can be specified and the disk and folder can be 
selected to store the file.

Reading a Setup from the 
Analyzer 

Each time the connection with the analyzer is established, or 
every time the instrument type is changed, the analyzer win-
dow will display the complete setup from the 712/720/812/
820/870 analyzer.

The setup displayed in the analyzer window always reflects 
the setup that is inside the analyzer.
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Writing a Setup to the Analyzer

NOTE: The setup being loaded must be 
of the same type as the instrument cur-
rently selected in the analyzer.

There is no need to manually send a setup to the analyzer. 
When you want to change a setup, simply open the desired 
setup and it will be uploaded immediately to the analyzer.

Establishing the Connection

Before establishing a connection with the analyzer, the com-
munication parameters in the Analyzer window and on the 
instrument must be properly set.

Computer To set the communication parameters on the computer side, 
execute the Connect command under Analyzer menu. In the 
dialog window the communication port, the baud-rate and 
the Stop bits can be selected.

Analyzer To set the communications parameters on the instrument, 
press the Setup key, then scroll down and find the COM port 
baud rate and handshaking settings. These settings should 
match the setting in the DNA software. To change these set-
ting, press the ‘modify’ key on the instrument until the 
proper selection appears on the screen. After the desired 
selection is displayed, press the ‘enter’ key. The RS-232 
address must be set to 0.

WARNING! If a model 712, 720, 812 or 820 is being used, be sure to set 
the Output 1 Logic (2nd setting after the COM handshaking 
setting) to off, otherwise there will be no communication at 
all.
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Figure 7-2 Analyzer Connection window

If the Create log file box is selected, then the application cre-
ates a file (named CAPTURE.TXT) where all communica-
tion data flow between the analyzer and the computer is 
recorded. This option can be useful to solve communication 
problems.

Once these operations have been performed, the connection 
can be made either with the Connect button in the Connec-
tion dialog, or with the corresponding button on the toolbar.

When the analyzer is connected information can be obtained 
about the analyzer with the About Analyzer... command 
under the ? menu.
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Figure 7-3 Analyzer information window

The other commands under the Analyzer menu can be used 
to directly control the instrument.

The Disconnect command will terminate the current ana-
lyzer session.

The Run, Stop, Reset and Store commands are direct com-
mands that have the same function as the corresponding ana-
lyzer's buttons.

The Control Panel command will open or close a floating 
window where the analyzer’s settings can be changed on the 
fly.

The last command, Sync Clock, synchronize the analyzer's 
clock with the computer time.
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Connecting through a modem

This feature is supported only under Windows 95, Windows 
98 or Windows NT 4.0 or later.

With version 3.00 of the DNA software it is possible to 
establish a connection between the PC and the 824 through a 
modem and a phone line.

Connecting through a modem is a sophisticated task. It is 
necessary to understand the method of communications 
between all of the devices in the chain.

Using the modem To use the modem to connect to a remote instrument the 
device chain must be composed of a PC, a modem con-
nected to the PC (local modem), a telephone line, a modem 
connected to the instrument (remote modem) and the ana-
lyzer itself.

To establish a connection three links must exist: the PC must 
be able to communicate with the local modem, the local 
modem must communicate with the remote modem and the 
remote modem must communicate with the analyzer.

Link 1 - PC to Local Modem

At least one modem must be installed in the Windows™ 
environment. The application can then use that modem in 
the same way as other windows applications. This commu-
nication should be transparent to the user as windows should 
take care of all the details.

Link 2 - Local Modem to the Remote Modem

This connection should be transparent as well. 
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Remote Modem to the model 820 or 870

NOTE: The proper cable must be used 
for modem communication to be success-
ful. The recommended cable for use with 
the 820 connection to a modem is the 
CBL039. The recommended cable for use 
with the 870 connection to a modem is 
the CBL050.

The 820 and 870 are able to control a modem. All connec-
tion problems between the remote modem and the analyzer 
should disappear.

Normally the default initialization string inside the analyzer 
is enough to facilitate connection. Tests using two anony-
mous modems proved successful without any problems or 
additional configuration needs.

There may be some situations where the default modem ini-
tialization string must be altered inside the analyzer. This sit-
uation will come up if a cellular modem is being used. For 
use with a cellular modem, the correct PIN needs to be sent 
to the modem at power on.

Remote Modem to modem 812

This is the connection where problems are most likely to 
occur. The problems are caused because the analyzer does 
not facilitate control of the modem.

The remote modem needs to be setup using the PC and a 
HyperTerminal connection, or some other communication 
protocol.

There are three categories of problems.

Connection cable The standard communication cable (INT002) for the 712, 
720, and 812 is used for direct RS-232 communication to 
a PC. It is not suitable for modem communication by 
itself.

The desired modem cable, for modems with a 9 pin con-
nector, is CBL039. (Available from Larson Davis.) If the 
modem that is being used has a 25 pin connector, then a 9 
pin to 25 pin adapter can be used with the CBL039.
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There are no definitive standards that govern modem com-
munication. Many times trial and error will be necessary to 
facilitate modem communications.

Once the remote modem is configured correctly, the config-
uration MUST be stored inside the modem itself. This will 
allow it to load automatically each time the modem is pow-
ered on. If this is not done the modem will revert back to a 
default configuration the first time the modem is turned off. 
To store the current configuration in the modem use the 
command AT&W. This command is supported by most 
modems.

Even though the modem is configured correctly, the analyzer 
will still display errors during the connection phase. The rea-
son for this is that the modem sends a code result to the con-
nected device (RING, CONNECT..., etc.) that the analyzer is 
not able to understand. When the connection phase is over 
the modem becomes transparent and communication should 
continue without any further errors.

Communication speed The analyzer and the modem must be arranged so that 
they are using the same baud-rate. If they are not commu-
nicating at the same baud rate, the analyzer will give a 
continuos stream of errors.

In general all modems have a command to select a fixed 
speed between the modem and the attached device.

In some cases it may also require setting the local and 
remote modems’ to communicate at the same speed as 
the analyzer.

Handshaking control pin It may also be necessary to setup the modem for the 
proper RS-232 handshaking control lines. For example 
some modems require the "Ignore DTR" parameter to be 
set. Others might require the "DSR always active" param-
eter to be set.
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Controlling the Analyzer

Once the connection is established, the analyzer should be 
operated only through the application window. When the 
application is connected it is still possible to operate on the 
analyzers keypad, and change parameters. Changes made 
manually on the instrument will lead to a difference between 
the analyzer and the application. To re-synchronize the 
application and the analyzer, it is necessary to disconnect 
from the analyzer and reestablish the connection.

The analyzer control is handled through a window called 
Analyzer Control Panel.

Figure 7-4 Analyzer's Control Panel

In the Control Panel there are several tabbed dialog boxes 
that contain the analyzer’s settings.

Since the setups for the different instrument types are not the 
same, the application displays a different control panel for 
each instrument type. The control panel title will include the 
instrument type.
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Four buttons are present in the Control Panel. These buttons 
can be used to send the RUN, STOP, RESET or STORE 
commands to the analyzer. Clicking on the RESET button 
will open a popup menu with the Reset options.

Display

The analyzer window can display data in real time as they 
are displayed on the analyzer screen.

The window itself can be divided in panes, each pane con-
taining a graph, in order to display different aspects of the 
analyzer's data.

Displayed graph are of two types: SLM and time history. 
SLM graphs always display data from the same instanta-
neous spectrum. The time history displays the changes of a 
single value along the time axis.

The SLM graph displays a series of bars with the values 
from the SLM. 

In the time history graph the abscissa (X) axis always repre-
sent time, and its amplitude must be selected by the user. 
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Figure 7-5 Example of graph with context menu

A context menu is used to set the parameters for each graph. 
Click inside the desired pane with the right mouse button to 
open the context menu. Select the appropriate command 
from the context menu.

The first two commands are used to select the type of graph 
that is displayed. The Properties command will open a dia-
log window where the parameters for that graph can be set. 
The Value window command opens or closes a window that 
numerically displays the values from the selected graph. The 
Properties window can also be opened by double-clicking 
with the left mouse button inside a pane.

The properties window is structured in the same way for all 
graph types.

The first page, called General, enables the settings of the 
general aspects of the graph. The second page holds the 
parameters for the graph's horizontal axis. The third page 
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holds the parameters for the vertical axis. The fourth page 
holds the settings that control the trace displays.

The following figure shows an example of each page in the 
properties window. This particular display is from a spec-
trum graph, but the properties window is the same for the 
other graph types as well.

Figure 7-6 Spectrum properties - General tab

In the General tab, the following parameters are set:

Click on this button to change the pen used to draw the 
graph's border.

Click on this button to set the graph's background color.

Click on this button to change the font used to draw the 
graph heading.

Border

Background

Header font
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Figure 7-7 Spectrum properties - Horizontal axis page

The Horizontal axis page controls the following parameters:

Click on this button to set the pen used to draw the main 
grid line.

Click on this button to set the pen used to draw the sec-
ondary grid line.

Click on this button to change the font used to draw the 
axis labels.

Main grid

Sub grid

Font
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Figure 7-8 Spectrum properties - Vertical axis tab

The Vertical axis page controls the following parameters:

Main grid Click on this button to set the pen used to draw the main 
grid line.

Sub grid Click on this button to set the pen used to draw the sec-
ondary grid line.

Start, Stop and Step Insert values in these boxes to define the axis amplitude 
and the label steps.

Font Click on this button to change the font used to draw the 
axis labels.

In the SLM graph type each value is represented as an inde-
pendent line on the graph. The value that is to be displayed 
must be selected first, and then the settings for that value can 
be modified.
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Figure 7-9 SLM properties - Trace page

The parameters in the SLM Properties page include:

Set the current bin bar color.

Set the trace name as it is displayed on the graph.

Add a trace to the list.

Delete the selected measurement from the graph.

Bar color

Name

Add bar

Remove bar
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Figure 7-10 Time History properties - Trace page

The parameters in the history page are:

Set the current trace's pen color.

Set the trace name as it is displayed on the graph.

Add a trace to the list.

Delete the selected trace from the graph.

Value Window

It is possible to associate a value window with each dis-
played graph that numerically displays the current value.

The font used to display the header and the data can be 
altered in each value window to improve the readability of 
the display.

To change the font, click inside the value window with the 
right mouse button. The context menu displayed contains 

Pen color

Name

Add bar

Remove bar
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two commands. The first command is used to set the value 
font, the second is used to set the font that is to be used for 
the header.

Figure 7-11 Example of Value window connected to a SLM 
graph

The type and number of values displayed depends on the 
type of graph in the connected pane.

Measurement Download

The 712, 720, 812, 820 and 870 analyzers can store mea-
sured data inside their memory.

Every data set can hold more the one RUN/STOP. The appli-
cation will convert each RUN/STOP into a single measure-
ment.

To download measurements, use the Download from ana-
lyzer command from the Measurement menu.

The first wizard page allows selection of the data download 
method. The selection include Binary transfer or ASCII 
transfer. It is possible to download a binary image without 
translating the data, or to translate a binary image previously 
downloaded.
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Figure 7-12 Download wizard - transfer method selection

Binary transfer is the method of choice for large data sets 
and long time histories. The ASCII transfer is faster for 
small data sets.
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Figure 7-13 Download wizard - Data storage page

In the second wizard page selection of which data should be 
stored with the measurement must be made.

As the wizard is finished the application will begin to imme-
diately download the data and store it in a temporary file. At 
the end, the usual measurement description for each RUN/
STOP couple encountered will be requested.

The downloaded data is immediately transferred to the open 
document. To see a downloaded measurement, activate the 
document window, and open the document contents win-
dow. The downloaded measurement can be viewed in this 
window. At the end of the download sequence the main doc-
ument window is brought to the foreground.
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Measurement Execution

Beyond simply downloading the instrument memory, mea-
surements can be performed by directly controlling the 
instrument with the application.

To execute a measurement simply select the appropriate 
command in the Measurement menu. A Measurement Wiz-
ard will guide you through the process of making a measure-
ment.

There are four measurement execution modes. These modes 
determine how a measurement is started and stopped. The 
following table describes each mode.

The measurement will begin immediately after the 
START button has been pressed in the last wizard page, 
and stop after the predefined time has elapsed.

In this mode the application will set the analyzer to the 
RUN mode and then continually monitor the measured 
value. When the trigger conditions are met the measure-
ment will begin. The measurement can be stopped after a 
predefined time or when the monitored value goes out-
side of the trigger conditions.

In this mode the measurement will begin when a user 
timer expires, and stop after a predefined time.

In this mode a sequence of measurements are made, one 
for each selected day. The user sets the desired start date 
and number of days the measurement should be made. 
For each selected day the application can do one or two 
measurements, beginning at a predefined time and stop-
ping after a predefined time period.

To execute these measurements an exponential averaging 
mode must be selected. The Slow, Fast and Impulse detec-
tors are, by definition, Exponential detectors. This selection 
determines how the data is collected inside the analyzer

Manual

Trigger

Timer

Daily
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Measurement Wizard

The measurement wizard consists of a sequence of dialog 
boxes where the measurement parameters can be set.

When first beginning a measurement using the measurement 
wizard, the setup the application must use for the measure-
ment must be selected. The current analyzer setup (the one 
displayed in the Control Panel) can be used, or another setup 
can be loaded using the menu Setup, Open command. The 
measurement wizard will use the analyzer’s active setup that 
is displayed in the control panel to perform the measure-
ments.

Figure 7-14 Measurement wizard - Measurement description 
page
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In the first page of the measurement wizard, the measure-
ment name and other identification parameters must be set. 
These parameters are then used in the document window to 
identify the measurement. The application will always dis-
play, as default, the parameters used in the last wizard exe-
cution.

This information can also be altered later in the document 
window.

The second page of the measurement wizard allows selec-
tion of value that are to be stored in the measurement.

Figure 7-15 Measurement wizard - Storage setup page
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Initially the same data being displayed is automatically 
selected. More values can be added or deleted depending on 
the desired amount of data needed in the document window.

Select this box to store the spectrum with the measure-
ment. The user can also select which bandwidth to store. 
(1/1 or 1/3 octave.)

If this box is cleared then each spectrum will be stored 
with the theoretical time given by the averaging time. If 
this check box is set, the computer calculates the elapsed 
time of each spectrum based on the internal clock of the 
computer.

Select this box to add other SLM values.

Select this box to remove the selected SLM value from 
the list.

In the next page the general measurement conditions are set.

Store spectrum

Store elapsed time as 
calculated by the com-
puter

Add

Remove
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Figure 7-16 Measurement wizard - General setup page

The measurement start mode is selected first. See the modes 
description in the previous paragraph.

A password can be set to control measurement interruption. 
When a password is specified, the measurement will not be 
able to be interrupted unless the correct password is inserted 
into the progress window.
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Figure 7-17 Measurement wizard - Manual page

In the manual measurement mode, the measurement begins 
when the START button is pressed. The measurement will 
terminate after a predefined time period.

The only parameter that must be set in this page is the mea-
surement duration, in seconds. The application automati-
cally calculates the required number of spectra required to 
cover the selected duration.

WARNING! If the averaging time is too short, and the computer is not 
able to keep up with the required speed, the computed num-
ber of spectra will be collected; however, the measurement 
duration will be longer than the duration set in this window.
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Figure 7-18 Measurement wizard - Trigger page

In the trigger page the trigger conditions need to be set for 
the desired measurement (measurement start). The measure-
ment stop conditions must also be defined.

Frequency/Bin This setting selects which band, including SLM values, 
must be monitored for trigger conditions.

Threshold level Insert the threshold level in dB in this box. When the 
monitored signal reaches, or exceeds, this level, the mea-
surement will begin.
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Stops when a fixed time 
elapsed

This option will terminate the measurement after a fixed 
period of time.

Stops when the level goes 
below threshold

This option will terminate the measurement when the 
monitored signal level goes below the threshold value.

One shot trigger Select this option when only one measurement is 
required. To rearm after a triggered measurement has 
been executed, restart the measurement wizard.

Rearm Automatically This setting will cause the trigger conditions to become 
active again after the measurement has stopped. To stop 
the wizard and download the data, press the esc key.

Number of pre-trigger 
spectra stored

The application is able to store one or more spectra (up to 
1000) preceding the trigger time. This allows storage of 
the data immediately proceeding the trigger event.

Measurement duration This setting is the predefined measurement duration in 
seconds for the fixed time mode.

Post under threshold 
overtime

This is the time the application will measure after the 
trigger conditions have been released. This value corre-
sponds to the minimum distance between two consecu-
tive events. In fact, if the level exceeds the threshold 
before this time elapses, the current measurement is con-
tinued as if the signal had never gone below the thresh-
old.

Execute speed test 
before start

With this check box set, DNA will run a speed test before 
starting the measurement to make sure that the communi-
cations speed is sufficient to transfer data. If the speed 
test is not passed, DNA will give the user the option to 
disable the Windows™ message loop to speed up com-
munications.

Disable Windows™ mes-
sage loop

With this check box set, DNA will disable the Win-
dows™ message loop during the measurement. This 
means that the only way to stop the measurement once 
started, is by using the Esc. key.
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Figure 7-19 Measurement wizard - Timer page

The parameters for the Timer mode are the measurement 
interval, measurement duration, the start date, and the start 
time. For the measurement duration see the comments in the 
Manual mode section of this manual.
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Figure 7-20 Measurement wizard - Daily page

The daily measurement mode is used to set the start date and 
the number of days that the measurement is to be repeated. 
For each selected block of time the start time and measure-
ment duration must be set. If the second block is enabled, it 
must start at a time after the end of the first block. For the 
measurement duration see the comments in the Manual 
mode section of this manual.

If the computer has an audio board, the next wizard page is 
used to setup the audio signal recording while the measure-
ment is performed
 7-30 DNA User Manual Data-Navigation-Analysis



Figure 7-21 Measurement Wizard - Audio page

By default the audio recording is disabled. Click on the 
Enable audio recording check box to activate the other 
fields.

Select the audio input device that will be used (if there is 
more than one audio board installed). Then select the audio 
resolution. When selecting higher audio resolutions, care 
must be taken to make sure that disk space does not run out 
in a short time.
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Recording conditions depend on the type of measurement 
selected earlier.

If doing a triggered measurement, then the audio recording 
start will happen with the same bin, channel and threshold 
condition set for the measurement itself. The recording 
length will be the time specified in this window.

In all other cases, the recording conditions must be set in this 
window.

It is possible to record up to five seconds before the trigger 
time.

The selection of how to rearm the audio trigger must also be 
made. There are two methods to accomplish this function . 
Both of these methods can be used simultaneously. The first 
method functions so that after an audio block ended, the next 
audio block can only start after the level goes below the 
threshold level. The second defines a minimum interval time 
between two consecutive audio blocks.

Look at the last field in the page. It displays approximately 
how much time can be recorded, based on the free disk 
space. Since the application uses the temporary windows 
directory to store temporary files, free space must be avail-
able on the hard disk with the Windows™ temporary direc-
tory.
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Figure 7-22 Measurement wizard - Summary page

In the last wizard page a summary of the executing measure-
ment is displayed. Click on the Finish button to initiate the 
measurement.

Before actually starting the measurement, the application 
performs a test to see if the transmission speed is fast enough 
for the selected averaging time.
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If the time required to download a sample from the analyzer 
is longer than the averaging time, the following warning 
window is displayed.

Figure 7-23 Speed test dialog window

This window reports the average time (based on 10 samples) 
it takes to download a sample. The first is obtained with the 
Windows message loop enabled, while the latter is obtained 
with the Windows message loop disabled.

When the message loop is disabled, the application takes 
less time to read a sample from the analyzer, but during the 
measurement it will remain locked. In this case the only way 
to interrupt a measurement is using the Esc key.

Destination Document

Since it is possible to run more than one instance of the main 
application, more than one document may exist that can 
receive the measurement's data.
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Figure 7-24 Select Destination Document window

When the measurement is started or data is downloaded 
from memory, and more than one document is ready to 
receive the data, a dialog window with the list of documents 
is displayed. There the appropriate document can be selected 
to be the destination document.
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Troubleshooting the analyzer connection 

When problems occur in the connection with the analyzer, 
the application will inform the user with a warning message. 
Given below are some of the possible messages along with 
the possible cause for the message.

WARNING! Access denied error on serial port 
COMx.

This message is received when trying to use a serial port that 
is already used by another device or application. If the port 
is used by another device (e.g. the mouse), specify another 
serial port.

If the port is used by another application, close that applica-
tion or select a different serial port.

WARNING! Cannot read from the analyzer...

The main cause for this message is that there is no physical 
connection between the computer and the analyzer.

For example: the cable may not be connected or the analyzer 
may not be turned on.

WARNING! A time-out error has occurred on serial 
port COMx.

If this message is displayed when trying to connect to the 
analyzer, the probable cause is that the baud rate inside the 
analyzer does not match what is set in the connection dialog 
box of the DNA software.

If the message is displayed after the connection has been 
established, then it may be a software error; for example 
your analyzer can have a new firmware revision not yet sup-
ported by the application.
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WARNING! An error has occurred on serial port 
COMx...

This error should not occur in normal conditions. If it does 
occur it means there is some hardware problem in the com-
munication chain.

The ErrorCode value displayed in the message represents 
the error number reported by Windows.

The most common error reported by Windows is number 2 
(CE_OVERRUN). This error code indicates that the operat-
ing system was unable to read a byte from the serial port 
before the arrival of the next byte.

In case of error 2:

Step 1 Be sure that your computer has buffered serial 
ports (UART 16550).

Step 2 Next check in the communication resources for 
the serial port and enable the buffer.

Step 3 If the problem persists, try using a different baud 
rate.

Step 4 Disable the screen saver.

Step 5 If you are using a Windows 95™ on a laptop, open 
the Power management applet from the Control 
Panel. Click on the Advanced button. Then on the 
Problem solution tab. Finally disable the polling 
of the power status.

Troubleshooting the main application connection 

When problems occur in the connection between the ana-
lyzer window and the main application, a warning message 
will inform the user of the problem. Given here are the pos-
sible messages along with the probably cause that could trig-
ger the message.
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WARNING! Connection with the main application is 
not possible.

The main application is not running. Start the main applica-
tion and retry the command.

The main application is running, but is locked by a previous 
connection crash. Exit the main application, restart it and 
retry the command.

WARNING! Destination document is not yet avail-
able. Data transfer is aborted.

The destination document is not yet ready. Wait until the 
main application has created the document and retry the 
command.

WARNING! Cannot open exchange file.

WARNING! Cannot map exchange file.

The data passes from the analyzer window to the main appli-
cation window through an exchange file. This file is created 
in the Windows temporary directory.

Check that the temporary directory is set correctly.

Check the free disk space on the drive with the temporary 
directory.

If the destination document and the temporary directory are 
on the same drive, and you are performing a measurement 
that will use 100kB remember that you must have more than 
double that in available free space.

WARNING! Main application error: XXX

This message should not occur in normal conditions. It indi-
cates there is a problem in the main application.

Incompatible versions of the main application and the ana-
lyzer window EXE files are probably being used.

Try to reinstall the software.
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C H A P T E R
8 General Description

Introduction

DNA is a “single document” application. In one instance of 
DNA only one document can be opened. However, more 
then one instance of the application may be started at one 
time and thus have more than one document opened simulta-
neously. This behavior follows the Microsoft guidelines 
toward a document-centric application.

Windows layout

When the DNA application starts, a window is opened dis-
playing an empty page. This is the Document Window 
where all of the work will be done, except for operations 
involving the analyzer. All the operations involving the ana-
lyzer occur in a separate window, called the Analyzer Win-
dow. There are four selections for the Analyzer Window. 
The first is the interface to the real-time analyzers 2800, 
2900 and 3200; the second is the interface to the 824 ana-
lyzer the third is the one for the 814 and the fourth is the 
interface to the statistic analyzers 712, 720, 812, 820 and 
870. Select the appropriate LarsonDavis product from the 
analyzer menu item and the Analyzer Window will be 
opened for that instrument. All operations with the analyzer 
are performed in the analyzer window. When measurement 
data is downloaded from the analyzer, it is routed by the 
Analyzer Window to the Document Window.

Since the Analyzer Window is a separate executable file, it 
may run as a stand alone application. In this case, connection 
to the analyzer and performing setup operations may be 
done, but data cannot be downloaded from the analyzer. 
Analyzer window operations are covered in the instrument 
manual, located in chapters 3 through 6 of this manual.
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The Document

When the DNA application is run for the first time, an empty 
document with one page is created. The DNA document can 
have up to 65535 pages. (Depending on your computers 
memory.)

In the Document Window only one page can be displayed at 
a time. A page is composed of two layers: Global Layer and 
Page Layer. The global layer is standard for all pages, and is 
repeated over each document page. Use the global layer to 
draw document headers, the company logo or whatever is 
required on every page. Graphs cannot be placed on the 
global layer.

The Page Layer is where graphs, tables, reports, graphics, or 
saved files are placed.

Inside each layer, all objects are drawn sequentially. The 
order in which objects are drawn on the page can be 
changed. This allows objects to be drawn behind other 
objects such as would be used for overlays. 

Templates

The DNA application supports a template concept. Tem-
plates are a simple way to reuse your work. DNA supports 
Document Templates and Graph Templates.

Imagine the Document Template as a normal document 
without any measurement data. Whenever a new document 
is created DNA will display the list of document templates 
where the one that best suits your needs can be chosen. The 
template is then loaded inside the newly created document. 
Of course, empty documents can always be created. 

Graph templates store predefined models of graphs. Tem-
plates can be created from any existing document or from 
any existing graph inside a document.
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On-line Help

DNA has extensive on-line Help. This Help facility can be 
used at anytime during a session, to get help about com-
mands, dialog box or other objects or context matters.

Help Contents The dialog box with the Help Contents can be displayed by 
using the Help Topics command under the help menu. From 
this window, information can be located. In this dialog box 
the Index tab and the free text search tab can be accessed.

Context sensitive help Information can be obtained about, or relative to, the context 
where working. To get information quickly about a com-
mand, window or object, activate the object and press F1. 
For example get help about a menu command, select that 
command and, before releasing the morse button, press F1 
or click on the palette tool and before releasing the mouse 
button, press F1.

Another method is to press the key combination Shift-F1. 
The application then enters a special help mode, the pointer 
changes to an arrow with a question mark, and by clicking 
on a command, window or object, the correct information is 
displayed in the Help window.

Help dialog box Inside every dialog box there is usually a Help button that 
displays the help topic for that dialog box.

Context sensitive help is available in dialog boxes as well. 
To get information about a field or a control, move the 
mouse pointer over the field or control and press F1.

In Windows 95 and NT, the help button will also provide 
this type of Help. Select the help button in the toolbar. The 
mouse pointer will now change to the pointer and Question 
mark symbol. The Help can then be accessed by right click-
ing on the desired field or control.
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C H A P T E R
9 The Document Window

Introduction

The Document Window is used to create and modify a docu-
ment. There are three options for viewing a document.

• Output Page View: The document is represented in a 
WYSIWYG (What you see is what you get) format. The 
document is displayed as it will be seen on the printed 
page.

• Graph View: The selected graphs are displayed in the full 
window.

• Measurement Data View: The raw data is displayed on 
the screen in a spread sheet format.

As support to the Document Window operations, there are 
three floating windows.

• Document Contents window: displays the document con-
tents as measurements, weight curves and reference 
curves.

• Disk Browser: displays the contents of your disk drive, 
along with the stored documents.

• Measurement Board: displays a list of the measurements 
that are currently displayed in the document; for every 
measurement found, the number of graph references and 
value references are reported.

These floating windows can be opened and closed at will 
with a button located on the tool bar.
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View as Output Page

The output page view displays the document in a WYSY-
WYG (What you see is what you get) mode. Only one page 
can be displayed at a time.

Objects that can be represented on a document’s page fall 
into several categories: draw objects, text objects, graph 
objects, bitmap objects and metafile objects. 

Draw Objects Draw objects are created using the tools in the Tool’s palette. 
Currently the program supports lines, rectangles, rounded 
rectangles, polygon’s and ellipses. To make an object with 
the same vertical and horizontal size, hold down the Shift 
key while drawing the object. For example to draw circles 
select the ellipse tool and draw while holding down the Shift 
key.

Text Objects To enter a block of text select the Text tool and click where it 
is to be placed. A dialog window then opens where the text 
can be inserted. Text objects cannot be resized like draw 
objects. 

Graph Objects To create a graph object select the Graph tool from the 
Graph palette, or select the command "Graph New" from the 
insert menu. To create a graph using a predefined template, 
select the command “Graph Load” from the Insert menu and 
select a template.

Importing Bitmaps and Meta Files Bitmaps and metafiles can be imported with their respective 
commands under the Insert menu, or can be inserted through 
the clipboard with the Cut, Copy and Paste mechanism.

Changing Object Properties To change the properties of an object, select it and press 
Alt+Enter, double click on it with the left mouse button, or 
right click on it, and select properties from the menu. Multi-
ple objects can be selected by holding down the Shift key 
while selecting each object with the Select tool. Selections 
can be moved by using the click and drag feature.
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Graph View

The graph view displays only the graphs. One or more 
graphs can be displayed simultaneously. The window can be 
divided into panes using the two split tools in the Tool Box. 
One tool is used to split a pane horizontally and the other 
vertically. Each pane can be divided either vertically or hori-
zontally until all graphs are displayed. When all graphs are 
displayed, the split tools are disabled.

Measurement Data View

The measurement data view will display measurements in a 
spreadsheet like window.

Measurement data view has its own property page dialog 
window, which is used to determine which measurement is 
displayed and how to display it. To change the data view 
properties, execute the Properties command in the Edit menu 
or double-click inside the sheet.

Data can be scrolled using the scroll bar or the cursor keys. 
While in the measurement data view, the Copy command is 
enabled. 

Exporting Data to a Spreadsheet Application

The Copy command allows the measurement data, which is 
in text and spread sheet format, to be pasted into a word pro-
cessor or spread sheet program.

Along with the Copy command, the other two commands 
can be used to export the displayed data in text format 
(ASCII) or in DIF format (Data Interchange Format). A con-
text menu is also available. Right click inside the window to 
display the context menu. This contains the most common 
commands in numeric data view.
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Direct Edit

This mode allows direct editing of the measurement data 
while in the Measurement View mode. It is accomplished 
one value at a time, or an entire group of values can be mod-
ified.

WARNING! In the direct edit mode, values typed directly or generated by 
the user are written directly to the measurement and replace 
the original values. It is up to the user to enter the correct 
data while in the Direct Edit mode.

It is recommended that the measurement be duplicated 
before changing the data with the Direct Edit mode. 
With this precaution, there will always be a copy of the 
original measurement that can be reloaded.

The Direct Edit mode can be entered by double clicking on a 
cell, or by executing one of the commands from the Edit 
menu. 

Not all cells can be edited (e.g. Time data). If the cell selec-
tion  holds a cell that cannot be edited, then all Direct Edit 
operations are disabled. 

The operations currently supported are listed in the follow-
ing table:

Operation Description

Edit values cell by 
cell

This operation is started by double clicking 
on a cell. The editing is done in place with 
an overlapped edit control. 
Press the Esc key to exit from the Direct 
Edit mode.

Insert Data Column This function allows data from other 
devices or sources to be added.

Import Selection or 
Paste into Selection

This operation allows the user to import 
data into the selection from a test file or 
from another application (e.g. Excel).
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Edit values cell by cell This operation is started by double clicking on the cell which 
needs to be modified. The editing is done in place with an 
overlapped edit control.

Edited data is confirmed with the Enter key, while the Esc 
key will discard the edited data and exits the Direct Edit 
mode.

Once a value has been confirmed with the Enter key, the 
application begins the editing of the next cell. The next cell 
will either be to the right or below the current cell, depend-
ing on the progress direction. The progress direction is con-
trolled with the two buttons on the top left corner of the 
window. Selecting the progress mode and the first cell, it is 
possible to insert an ordered sequence of numbers without 
exiting the Direct Edit mode.

The current cell can also be moved to an adjacent cell with-
out interrupting the Direct Edit mode. This is accomplished 
by use of the arrow keys while holding down the control key. 
The Esc key will always exit the Direct Edit mode.

Inserting Data Columns This command is used to add a data column to the measure-
ment. The new column is always added to the leading values 
of the current data section. It is not possible to insert a data 
column inside a data channel or inside a spectrum. Use this 
feature to insert data measured with another instrument or 
coming from other devices (e.g. speed, temperature, etc.).

Fill Selection This operation fills the selected cells in the 
four directions or with a linear series.

Operation Description
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Figure 9-1 Insert data column window

In this dialog window the parameters used to identify a data 
column need to be set. The window includes the name, the 
measurement unit, numeric data type, and the default value 
that is to be assigned to the new cells.

The measurement units currently supported are: dB, RPM, 
km/h, m, C, F, K, and V e EU. The numeric data types cur-
rently supported are: Integer, DWORD (unsigned integer), 
real (floating point), complex magnitude/phase and complex 
real/Imaginary.

Import Selection or Paste in 
Selection

If the data to be inserted into the measurement is in a text file 
or in another application’s document (e.g. Excel), it is possi-
ble to import directly into the current selection.

The text file structure is very simple. Numbers must be orga-
nized in the same way as the cell selection, with each row 
separated by a cr (carriage return) and lf (line feed). Num-
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bers need to be on the same row separated by either 
comma’s or by a tab. 

The number of values in each row and the number of rows 
must be enough to fill the selection completely. If more 
numbers are given in a row, or more rows are given, then the 
application will import only the values needed to fill the 
selection. Missing values inside a row are not allowed.

To copy data from Excel:

• In Excel select the data and execute the copy command.

• In DNA, select a row/cell matrix compatible with the 
selection from Excel. Execute the import command to 
place the data into the measurement.

Fill Selection The fill command is similar to the fill command in Excel.

Fill Mode Operation

For every column, the value in the top cell is 
copied to the cells below

For every column, the value in the left most 
cell is copied to the cells to the right.

For every column, the value in the bottom 
cell is copied into the cells above.

This command will generate a linear series 
of numbers. The series can be created in 
rows or in columns. The user must specify 
the increment value.

Document Contents window

The application displays, in the Contents window, a file tree 
representing your document’s contents. To expand or col-
lapse a tree node click on the node, or double-click over an 
icon or element name. A node square that does not contain 
the +/- sign cannot be expanded. The document contents is 

Down

Right

Up

Series
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logically grouped in folders, one for each measurement type, 
plus one for Weight curves and one for Reference curves.

Figure 9-2 The document Contents window

NOTE: When dragging an item, the 
mouse pointer changes shape as the 
position changes; when it becomes a 
Stop sign it means that the object cannot 
be dropped; when it becomes an arrow 
with the object icon, it means that drop-
ping is allowed.

Measurements can be expanded into channels and values 
contained within those channels. The Drag and Drop feature 
can be used to move elements from this window into the 
document page. 

From the Document Contents window, measurements can be 
dropped over the legend in a graph, replacing the old refer-
ence with the dragged one; or it can be dropped over a 
derived axis to create a new data source, with a new curve. A 
record value can be dropped in an empty page position, thus 
creating a new Calculated Value object. Moreover, the Drag 
and Drop feature is enabled between this window and the 
Measurement Board window. Dragging a measurement from 
here and dropping over a name in the Measurement Board, 
will replace every reference of the old measurement with the 
new.

The Disk Browser Window

The Disk browser window contains a tree structure that dis-
plays the disk drives available on your computer. Navigation 
of your disk structure is similar to the Windows 95 
Explorer window. The difference is, that here, only folders 
and DNA documents are displayed.
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NOTE: This Disk browser window is 
structured as  a File tree. To expand or 
collapse a tree node, click on the + or - 
sign, or double click over an icon or ele-
ment name. A node without a + or - sign 
cannot be expanded.

Figure 9-3 File Window

NOTE: The File browser window cannot 
be a target for a Drag and Drop opera-
tion.

The Disk browser window is also a source for the Drag and 
Drop feature. Taking a measurement from a document in this 
window and dragging it over one of the other windows is 
equivalent to importing that measurement with the Import 
command in the File menu. 

The Measurement Board window

The Measurement Board window contains the list of mea-
surements currently displayed in the document. Along with 
the name, there are two numbers: the first is the number of 
references to the measurement inside graph objects, the sec-
ond is the number of references to the measurement inside 
value objects. Only direct references are counted. If a Value 
is bounded to a measurement through a data source it is not 
counted. The data source itself already accounts for that ref-
erence.

Figure 9-4 Measurement Board Window
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NOTE: The Measurement Board win-
dow cannot be used as a Drag and Drop 
source.

beyond giving a general overview of the document, espe-
cially for multiple page documents, the Measurement Board 
acts as a target for the Drag and Drop feature. Measurements 
can be taken from the Document Contents window, dragged 
over a compatible name in the Measurement Board, and 
when dropped, all references to the old measurement will 
change to the dropped one.

The Graph Control window

The Graph Control window can be used to set some of the 
graph parameters without opening the graph property page. 
This window is opened or closed automatically as a graph is 
selected or unselected. The user can enable or disable this 
window with the appropriate button in the toolbar or with 
the command “Show / Graph Control” in the View menu.

Figure 9-5 The Graph Control window

This window has two groups of controls. The upper group 
contains axis controls; the lower contains curve or data 
source controls. The three buttons in the axis group can be 
used to move up or down the axis range, or perform an axis 
autorange. Note that every axis in a graph has its own page. 

The curve group is composed by a variable number of pages, 
one for each defined curve in the graph. To enable a curve 
page, click on the corresponding number.
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The Cursor Control window

The Cursor Control window contains a row of buttons simi-
lar to the buttons of a video cassette recorder. Clicking on 
one of these buttons will move the cursor. The Max and Min 
buttons will move the cursor to the maximum or minimum 
curve value. 

Figure 9-6 Cursor Control window

The cursor may also be set with the mouse by clicking 
directly inside a graph. The use of the Ctrl key may be 
required for this operation depending on the Selection Mode 
parameter setting in the Preferences window. A range of 
curve values may also be selected by clicking and holding 
the mouse button while moving over the desired range.

The Cursor Value window

In the Cursor Value window the application displays the cur-
rent graph cursor values. These are the same values dis-
played in the cursor value window inside the graph. 

Figure 9-7 Cursor Value window

The contents of this window is dependant on the type of 
graph selected. The font type and size of this window can be 
changed by clicking inside the window with the right mouse 
button and selecting "Font" from the context menu.
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Drag and Drop

In many Windows-based applications, items can be selected 
with a mouse, dragged to another location on the screen, and 
"dropped" at that location. The window where the item was 
selected is the source, the place where the item is dropped is 
the target.

The application assists in finding a target by changing the 
cursor as it moves. If the position under the mouse pointer is 
a valid target, then the arrow with the dragged icon is 
selected, otherwise the cursor changes to the Stop sign. The 
DNA application has two Drag and Drop sources (the Docu-
ment Contents window and the Disk Browser window). Tar-
gets can be the document page, a graph on the page, the 
Document Contents window or the Measurement Board. 
The following table lists the various combinations of items, 
sources, and targets enabled for Drag and Drop operations.

Item Source Target Effect

Measurement Document 
Contents win-
dow 

Graph/ compatible 
Data Source

The dropped measurement will replace the 
existing measurement in the same Data 
Source. It is equivalent to opening the Data 
Source properties window and manually 
changing a measurement. 

Measurement Document 
Contents win-
dow 

Graph / Derived axis A new Data Source is created for the target 
axis. It is equivalent to opening the graph 
property window, and adding a Data Source. 

Measurement Document 
Contents win-
dow 

Measurement Board All references to the target measurement are 
changed to the dropped measurement. 

A Channel Value Document 
Contents win-
dow 

A page position with 
no objects 

A calculated Value object displaying the 
first sample is created and placed at the drop  
position. 

Measurement Disk Browser Graph / compatible 
Data Source

The measurement is imported from the 
source document, to the current document. 
It is then treated as if the drag source was 
the Document Contents window. 
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Measurement Disk Browser Graph / Derived axis The measurement is first imported from the 
source document, to the current document. 
It is then treated as if the drag source was 
the Contents window.

Measurement Disk Browser Measurement Board The measurement is first imported from the 
source document, to the current document. 
It is then treated as if the drag source was 
the Contents window.

Measurement Disk Browser Document Contents 
window

The measurement is imported from the 
source document, to the current document. 

Weight curve Disk Browser Document Contents 
window

The weight curve is imported from the 
source document to the current document.

Reference Curve Disk Browser Document Contents 
window

The reference curve is imported from the 
source document to the current document. 

Item Source Target Effect
Data-Navigation-Analysis The Document Window  9-13



Setting Application Preferences

There are several parameters that control the application 
behavior. These parameters are set using the “Preferences” 
command under the Edit menu.

General Page This command opens a property sheet composed of several 
pages.

Figure 9-8 Preferences Window - General page

The General page defines how the mouse is used to move 
objects or move the cursor. Since the mouse can be used to 
both move and to resize an object and also to move the cur-
sor inside a graph object, the application distinguishes the 
two operations by monitoring the state of the Ctrl key. The 
application can be set to move objects when Ctrl is released 
and move cursors with the Ctrl key pressed, or vice versa.

CTRL+mouse click to set 
Graph cursor (default 
mode)

If this option is selected, the mouse is used to move or resize 
objects. The CTRL key must be held down to move the cursor 
inside a graph. 

CTRL+mouse click to 
move or resize objects 

If this option is selected then the CTRL key must be held to 
move or resize an object with the mouse, and the cursor can be 
set by clicking inside a graph without the need to press a key.
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This parameter can also be quickly changed using two but-
tons on the tool bar. Changing this parameter in the toll bar 
will not save the change. the setting will revert back when 
DNA is restarted. To change the parameter default setting, 
change the setting the Main Applications Options page.

Start Up Page

Figure 9-9 Preferences Window - Start Up page

The Start Up page controls the application start up mode. 
The application can be started in four different modes:

Move selection with CTRL 
+ arrow by 10mm

This setting will set the distance the graph will move with the 
control key + the desired arrow key combination. Enter a value 
between 1 mm and 10 mm.

Selection Handle Size This setting will set the size of the square handles that surround 
a selected object. Enter a value from 2 to 10 pixels.

Automatically display the 
Evaluate selection window

This setting will allow the user to set whether or not to automat-
ically display the evaluation screen after a range of data is 
selected. This screen is available in the context window by 
clicking with the right mouse button as well. It is used to evalu-
ate a portion of a measurement and compare that portion to the 
measurement as a whole. The portion of the measurement that 
needs to be evaluated is selected by dragging the cursor through 
a graph with the left mouse button depressed.

Last used document This selection will cause DNA to open automatically that last 
document that was used on start up.
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Units Page

Figure 9-10 Preferences Window - Units page

The Units page controls the measurement unit used in the 
Output Page View. The measurement unit choices are Milli-
meters, Centimeters, Inches and User units.

When User Units are selected, the unit’s name, abbreviation 
and scale factor must be set.

The Open document 
dialog box

This selection will cause DNA to open the Open File dialog box 
on startup.

An Empty Docu-
ment

This selection will cause DNA to open an empty document 
when the application is started.

Create a new docu-
ment from a Tem-
plate

This selection will allow the user to select a document template 
from the template selection window when DNA is started.

Open automatically 
the analyzer win-
dow

This selection will prompt DNA to open the analyzer window 
automatically when the application is started. If there is more 
than one analyzer window available (e.g. 824 and 814), then this 
setting is not valid and will be ignored by DNA.
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Grid Page

Figure 9-11 Preferences Window - Grid page

NOTE: The grid is only visible when in 
the zoomed mode in the View As Output 
Page selection.

The Grid page has the parameters to control the grid. Grid 
parameters may be selected from the following: display grid, 
magnetic (snap to) grid, grid spacing, and grid color.

Monitor Page

Figure 9-12 Preferences Window - Monitor page

The monitor page is used to calibrate the screen dimensions. 
Windows does not have any knowledge about the size of 
your monitor, so it is not possible to display the page or the 
objects in their real size. By default, Windows uses a log-
ical resolution based on the resolution selected for the video 
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board. This logical size makes things a little bigger, to com-
pensate for the monitor distance and resolution against that 
of the printed page. 

DNA can display objects on the monitor at their real size. 
This is done by measuring the length of the two black bars 
and setting the values in the Monitor page. This operation is 
optional and does not have any effect on what will be printed 
on the document’s pages.

Save Page The Save page is used to set the preferences regarding how 
documents are saved. The first check box enables the appli-
cation to keep the last copy of each document, saving it with 
the same document’s name but with the BAK extension.

Figure 9-13 Preferences Window - Save page

The second check box is used to enable or disable the auto-
matic save feature, along with the save interval in minutes 
feature. It is strongly recommended that this option be 
enabled. This feature, joined with the automatic temporary 
file recovery, protects you and your work from any crash of 
the application, operating system, or computer.
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Drag n’ Drop Page The “Drag’ n’ Drop” page sets the options for the Drag and 
Drop behavior when a measurement is dragged over the 
Measurement Board.

Figure 9-14 Preferences Window - Drag n’ Drop page

When a measurement is dragged over one of the elements in 
the Measurement Board, the actual replacement can be done 
in two ways. First the drop operation can be enabled only 
when the replaced measurement is exactly the same type as 
the dragged measurement, or it can be enabled if the two 
measurements are not equal but are compatible.

Once the drop operation is enabled, it is possible to let the 
replacement operation occur on the whole document, or only 
on the current page. 
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Order Tracking Page The Order Tracking page includes the parameters used in 
order calculations. This page is displayed only if your pack-
age includes the Order Tracking option.

Figure 9-15 Preferences window - Order page

Order calculation is performed with the following algorithm: 
starting from the RPM value of a spectrum, DNA computes 
the frequency of the selected order and selects the band with 
that frequency. The level of the selected band will be the 
order level. The first group of parameters indicates which 
bands, before and after the order band, are summed to obtain 
the order level. This summation is used to compensate for 
possible phase displacement between the RPM value and the 
spectrum, and to compensate for the fact that the order fre-
quency does not fall exactly in the middle of the measured 
band.

The smoothing function can be used to smooth the calcu-
lated order curve over the RPM or time direction. When 
enabled, the order level for a given spectrum is calculated as 
two times the order of the spectrum plus the order of the pre-
ceding and following spectrum, and then divided by 4.
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Managing documents

DNA document management is done with commands found 
in the File menu.

Creating a new document

To create a new document, press the New button in the tool-
bar or select the New command in the File menu.

Figure 9-16 Create New Document window

In the Create New Document window, there is the list of 
available document templates. Select a template and see the 
preview of it’s first page by selecting the preview check box. 
Then press OK to load the selected template as the new doc-
ument base, or select Empty document to have an empty 
document. The newly created document will be named Unti-
tled.
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Open document

To open an existing document, press the Open button on the 
toolbar or select the Open command in the File menu.

Figure 9-17 Standard Open Document window 
(Windows 95 style)

The standard Open file window is opened where the file 
name of your document can be chosen. From the standard 
open window, your computer’s disks or any connected net-
work disk can be selected and searched for the required file.

Saving a document

To save the current document, press the Save button on the 
toolbar or select the Save command in the File menu. The 
document will be saved in the same file from where it was 
opened. If the document is a newly created document then 
the Save As window will open where the document’s file 
name can be specified. To save the current document in a file 
different from the original, select the Save As command 
from the File menu. The standard Save As dialog box is dis-
played. In this window, a file name can be entered, and the 
location where the file is to be stored can be selected.
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Automatic recovery feature

When DNA opens a document, it creates a temporary copy 
in the Windows temporary directory, and performs all 
subsequent operations on that copy. When the normal appli-
cation behavior is interrupted in an abnormal way (i.e. by an 
application crash, or operating system crash) the temporary 
file is not deleted from the disk.

At the next application run, DNA will find the temporary 
file and recover it automatically. In this case, the application 
window title will show a name in the form “~$xxxxxx 
(Recovered)” where xxxxxx indicates a random number. 
This feature, along with the automatic save feature (see Set-
ting Application Preferences) should protect your work even 
when the computer is reset or turned off unexpectedly. Of 
course, the application is able to recover only the informa-
tion from the last automatic save.

It is strongly recommend that the automatic save feature be 
enabled frequently (even as often as every 2-3 minutes). The 
time lost on the automatic save will be rewarded at the first 
accident.

Summary information

The DNA document is able to store summary information 
about the document itself. This information is stored in a 
Microsoft standard format and can be inspected by utili-
ties programs that have the ability to read this information.

To update the summary information for the current docu-
ment, select the Summary Information command under the 
File menu. 
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Figure 9-18 Summary information window

The Summary property sheet that is displayed has two 
pages. The first page contains information fields that the 
user must fill in.

Figure 9-19 Document statistics information window

The second page displays the document statistics.
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Managing templates

The DNA application handles two types of templates: docu-
ment templates and graph templates.

All templates, in order to be recognized by the application, 
must reside in the Template directory or in one of its subdi-
rectories. Only the first level of a subdirectory is scanned 
while searching for templates.

Templates found in the Template directory will be assigned 
to the General folder; the others will be assigned to folders 
with the same name as the disk subdirectory.

Loading Document templates

A document template is loaded by selecting it when a new 
document is created. (See the creating a new document sec-
tion in this manual.)

A template can also be loaded into an existing document. 
This is done by selecting the Import Document Template 
under the File menu. This command will allow you select a 
document template and then load it into the current docu-
ment. DNA then substitutes the contents of the current docu-
ment excluding the measurement data.

Saving Document templates

A document template can be saved with the “Template/Save 
Document Template” command under the File menu.

In this dialog window, the template name, a description of 
the template and to which folder it is to be saved must be 
specified. The template name does not correspond to the file 
name. The file name is selected opportunely by the applica-
tion.
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Figure 9-20 Save template dialog window

NOTE: In order to save a document tem-
plate you must first save the document 
itself. If the current document has been 
modified and not yet saved, then the 
menu command is disabled.

The content of the first document page is saved with the 
template and used as the template preview during the load 
operation. The priority value is used in the template selec-
tion in the Insert Graph Template wizard. Selected templates 
are always sorted first by the priority value.

Loading Graph templates

A graph template is loaded by selecting the command 
“Graph Template” Under the Insert menu.

The graph template wizard will guide you through selecting 
the right template for a given measurement and in position-
ing the template itself inside the document.
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Figure 9-21 Insert Template Wizard - Selection page

The first page of the wizard contains a list of measurements. 
These can be selected from the new measurements, the 
unused ones, or all of the document’s measurements.The 
new, unused, and all selections available at the top of this 
first page only affect the list of measurements. They do not 
necessarily reflect the full content of the document.

When a measurement is selected, the application searches 
among the existing templates to find which template best fits 
the selected measurement. The templates will be displayed 
in the Template list in order of priority and fitness.

By setting the Template Preview check box, a Template pre-
view window can be opened. This displays what the tem-
plate looks like.

Template Search Criteria Templates are organized in folders. By clicking on the Tem-
plate Search Criteria button on the Select Graph Template 
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page, a customized search sequence of the available tem-
plates can be set.

Figure 9-22 Template Search Criteria Dialog box

In the template search criteria dialog box up to three differ-
ent folders can be selected, defining the search sequence. It 
is always possible to search in all folders by setting the First 
Search In category to All folders. 

The search sequence is stored by measurement type. Each 
different type of measurement will have its own search 
sequence.

The Template search criteria dialog box also allows you to 
set the maximum number of displayed templates. Enter ’0’ 
to display all valid templates.
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Template Drawing Position

Figure 9-23 Insert Template Wizard - Position page

The second page of the wizard is used to define the place-
ment of a template inside the document. The following 
parameters are available: Which document’s page to insert 
the template into, which position on the page, whether or not 
to execute an automatic viewing zoom and whether or not to 
execute an automatic axis autoscale of the graphs included 
in the template.

Saving Graph templates

To save a Graph Template use the command “Template/Save 
Graph Template” under the File menu. This command is 
enabled when one or more graphs are selected. Selected 
marks or markers connected to selected graphs will not be 
included in the graph template. The dialog window is used 
to specify the template name, a description of the template 
and to which folder it should be saved.

The template name does not correspond to the file name. 
The file name is selected opportunely by the application.
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Along with object’s data, the application saves in the tem-
plate information about the current measurement referenced 
in the template itself. This type of information will be used 
in the load template wizard to calculate the fitness of a tem-
plate for a given measurement. It is very important that the 
measurement displayed when the template is saved, is repre-
sentative of the purpose of the template. Attention must also 
be focused on the selected Value objects. It is best to avoid 
Value objects which reference a measurement directly, or 
which reference indirectly a graph not included in the tem-
plate.

A preview of the graph is saved with the template and used 
as a template preview during the load operation.
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Printing documents

DNA is able to print on any Windows print device. Of 
course a printer must be installed in order to print a docu-
ment. See the operating system instructions on how to install 
a printer.

There are three commands that deal with print operations. 
They are located under the File menu.

Figure 9-24 Print Setup dialog box (Windows 95 style)

Print Setup is used to select the printer and all of its parame-
ters. The Print Setup dialog box used by DNA is the stan-
dard windows print setup dialog box. Print Setup is also 
used to select paper size and orientation. DNA uses the cur-
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rently selected paper and printer information to calculate the 
page size.

Figure 9-25 Print preview

The Print Preview command displays your pages exactly as 
they will be printed. One or two pages can be seen at a time. 
The top row buttons allow access to Print directly from the 
preview, display the next page, display the previous page, 
change the preview from one page to two page mode and 
vice versa, and to zoom in and out.
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C H A P T E R
10 Objects

Introduction

In this chapter we give a description of the objects available 
in the Document Window. Object tools are used to place 
drawing or value objects into a document. Drawing tools 
insert symbols, boxes, Lines, Circles, etc. Value objects are 
used to reference values contained in the measurement data 
such as overall values from SLM measurements, or date and 
time stamps. Value objects can also be used for document 
information such as page numbers or document author.

An object can be created using a menu command or by using 
a drawing tool. Drawing tools are grouped in palettes. Since 
tool palettes can be closed by the user, each tool command is 
usually available through the main menu. Tool Palettes are 
hidden or displayed by the application depending on the 
active program context. The tool palette can also be dis-
played along the left side of the document window. The fol-
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lowing figures show the two tool palettes used in DNA, and 
the name of each tool.

Figure 10-1 The Drawing Tool's Palette

Figure 10-2 The Graph Tool's Palette (in Graph View)

Selecting Objects

To perform any operation on an object, first select that 
object. To select an object, use the Selection tool (repre-
sented by the arrow cursor). The Selection tool is the default 
tool. It is selected automatically after using one of the other 
tools.

The Selection tool has two different action modes. The first 
mode selects or modifies the objects; the second executes 
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actions inside complex objects. For example; it sets the 
graph cursor, or selects the current curve in a graph’s legend. 
The selection mode is specified with the Ctrl key. The appli-
cation supports both combinations (Ctrl pressed to move - 
Ctrl released to set cursors, or Ctrl released to move - Ctrl 
pressed to set cursors). The selection of which combination 
to use is made in the Preferences window.

There are several procedures that can be used to select 
objects in the Document Window. All of the listed proce-
dures assume that the Selection tool is already the active 
tool.

• To select a single object, move the pointer over the 
object and press the left mouse button. Any objects that 
were previously selected become unselected.

• To select two or more objects, hold down the SHIFT key 
while making your selection. This retains previously 
selected objects and includes the newly selected object in 
the selection list. If you click on a previously selected 
object it will be removed from the selection list.

• To select all the objects that intersect a given rectangle, 
click outside any object and drag the mouse pointer to 
form the required rectangle, then release the mouse but-
ton.

• To select all the objects in the active layer of the current 
page use the command Select All from the Edit menu or 
press CTRL-A.

• To resize an object, first select the object. A variable 
number of small square handles will surround the 
selected object. Move the pointer over a handle until the 
cursor changes shape. Press the left mouse button and 
drag the handle. The size of the handles can be adjusted 
in the preferences window.

• If the cursor does not change shape when moved over a 
handle, then the object cannot be resized, the handle is 
not a valid resize handle, or the object can be resized but 
it is in the locked state. Resize is disabled when there are 
multiple selections.

The selection tool has two operation modes; one to select, 
move and resize objects; the other to select parts of a com-
posite object (graph) and to set the cursor position.
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The first operation mode is indicated by the standard arrow 
mouse pointer; the second one by an arrow with a vertical 
line on the right side.

The selection mode normally activated can be selected in the 
Preferences window. To activate the other mode you must 
hold down the Ctrl key while acting with the mouse.

The following table gives the possible combinations for the 
selection tool.

Ctrl key released Ctrl key pressed

Set graph cursor or select compo-
nents of composite objects.

Move or resize objects on the 
page. 

Move or resize objects on the page Set graph cursor or select compo-
nents of composite objects 

Moving Objects

Objects can be moved with the mouse, or positioned with 
the keyboard through each object’s properties window. The 
mouse can move multiple objects. This operation cannot be 
done with the keyboard.

To move an object

Step 1 Select the object to move (multiple objects can be 
selected)

Step 2 Move the pointer over the selected object(s)

Step 3 Click with the left mouse button

Step 4 With the button still pressed, move the pointer to 
the new location.

Step 5 Release the mouse button.

In Preferences is activated 
“CTRL+mouse click to set 
graph/cursor” 

If Preferences is acti-
vated“CTRL+mouse click to 
move or resize objects” 
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The other way to move objects is with the command “Offset 
Objects” under the Layout menu.

Figure 10-3 Offset dialog window

The Offset Objects command enables application of a hori-
zontal and vertical offset to a selection. This can also dupli-
cate the objects while offsetting them. This option is useful 
to layout a series of objects all at the same distance from 
each other.

Grouping Objects

Two or more objects can be joined to form a single entity 
that behaves like a single object.

To group a set of objects:

Step 1 Select two or more objects

NOTE: Properties for the single objects 
in a group cannot be set individually. To 
change the properties of a grouped 
object you must first ungroup it.

Step 2 Select the “Group” command from the Layout 
menu. 

To ungroup a group object:

Step 1 Select the grouped object.

NOTE: The Ungroup command is 
enabled only when a group object is 
selected.

Step 2 Select the “Ungroup” command from the Layout 
menu. 

It is possible however, to change the properties that are com-
mon to more than one object. To do this:

Step 1 Move the mouse pointer over one of the selected 
objects.

Step 2 Click with the right mouse button.
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Step 3 Select the desired command from the context 
menu. 

The parameters that can be modified in this way are: font, 
pen style, fill style and references for a calculated value 
object.

This rule can be applied also to grouped objects. To change 
the other properties you must ungroup and then change the 
properties object by object.

Resizing Objects

An object can be resized with the mouse or you can set the 
object size with the keyboard through each object proper-
ties’ window.

Not all objects support resizing. For example Text object 
size is calculated by the application, and the text object, can-
not be resized.

To determine if an object can be resized, select it and move 
the mouse pointer over one of the displayed handles; if the 
pointer changes from the standard arrow to another shape 
then the object is resizeable. Normally, all displayed handles 
can be used to resize the object; for some special objects 
(e.g. markers) not all handles can be used for resizing.

Resize can only occur when an object is selected on its own. 
On a multiple selection, resize is always disabled.

To resize an object

Step 1 Select the object to resize.

Step 2 Move the pointer over one of the displayed han-
dles until the cursor changes shape.

Step 3 Click with the left mouse button.

Step 4 With the button still pressed, move the handle to 
the new location.

Step 5 Release the mouse button.
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Another way to resize objects is through the Resize Objects 
command in the Layout menu. This command enables you 
to resize one or more objects with a numeric size or by copy-
ing from the size of one of the selected objects.

Figure 10-4 Resize Objects window

The Resize Objects window displays the following fields:

In this combo box choose among: User Size, Size of the first 
selected object or size of the last selected object. 

Allows selection of Width and Height of selected objects. 
Enabled only for Resize with User Size. 

Check this field to disable the resize in the horizontal direction.

Check this field to disable the resize on the vertical direction.

Since the mouse can be used to move (and resize) an object 
and to move the cursor inside a graph object, the application 
distinguishes the two operations by the status of the Ctrl key 
whilst operating the mouse. The application can be set to 
move objects when Ctrl is released and move cursors with 
the Ctrl key pressed, or vice versa. See Setting Application 
Preferences in chapter 4.

Spacing Objects

Two or more selected objects can be evenly spaced. To 
evenly space a selection, perform the following operations:

Resize with size of

User Size

Disable Horizontal Resize

Disable Vertical Resize
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Step 1 Select a group of objects.

Step 2 Open the layout menu.

Step 3 Select the command “Distribute Objects/Horizon-
tally” to space the objects horizontally.

Step 4 Select the command “Distribute Objects/Verti-
cally” to space the objects vertically.

Step 5 Select the command “Distribute Objects/Diago-
nally” to space the objects diagonally.

Locking/Unlocking Objects

Every object on the page can be locked. Locked objects can-
not be moved or resized, however; locked objects can still be 
selected and thus used as a reference for other operations.

To lock objects:

Step 1 Select the object(s) to be locked.

Step 2 Select the Lock command in the Layout menu, or 
type Ctrl-L (press Control and L keys simultane-
ously).

To unlock objects:

Step 1 Select the object(s) to be unlocked.

Step 2 Select the Unlock command in the Layout menu, 
or type CtrlU (press Control and U keys simulta-
neously).

Aligning Objects

Objects can be aligned either to a page coordinate or to other 
objects. To align objects:

Step 1 Select the object(s) to align.
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Step 2 Select the “Align Objects command” in the Lay-
out menu.

Step 3 Change the alignment parameter as desired.

Step 4 Press the OK button.

The Align Objects window has two parameter groups. One 
is for horizontal alignment and the other for vertical align-
ment. Alignment can be done independently on the horizon-
tal axis or the vertical axis, or can be done simultaneously 
for both axes.

Figure 10-5  - Align Objects window

For Horizontal alignment set:

This combo-box enables selection of the following alignment 
modes. 
No alignment 
User coordinates, to align to an arbitrary page coordinate. 
First selected object, to align to the first selected object in the 
selection list. 
Last selected object, to align to the last object. 

The radio button group allows a choice between Left, Center and 
Right alignment. 

The page coordinate to align to, enabled only when the align 
mode is User Coordinate. 

Align to

Radio button

User alignment 
coordinate
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For the Vertical alignment set:

This combo-box enables selection of the following alignment 
modes. 
No alignment 
User coordinates, to align to an arbitrary page coordinate. 
First selected object, to align to the first selected object in the 
selection list. 
Last selected object, to align to the last object.

The radio button group allows a choice between Top, Center and 
Bottom alignment. 

The page coordinate to align to, enabled only when the align 
mode is User Coordinate. 

If one or more objects in your selection list are locked, then 
they will not be moved even if they are included in the align 
object’s list.

Objects order

Objects are drawn on the page following a precise order.

First, objects on the Global layer are drawn, then objects on 
the Page layer for the current page are drawn, excluding 
Marker objects that are drawn after all other objects. Mark-
ers are on a hidden layer that is drawn after the page layer.

Inside every layer, objects are drawn in the order they were 
added to that layer, so the last object added will always be 
drawn over other objects. Moreover, if you have two over-
lapping objects the selection tool will always select the 
object on the top.

Of course, there may be a time where the object drawing 
order will not fit your needs. In that case the object order can 
be changed. Only the order inside a single layer can be 
changed.

To change object drawing order:

Align to

Radio Button

User alignment coor-
dinate:
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Step 1 Select the object in the Z order to be moved. (The 
order of a multiple selection cannot be changed.)

Step 2 Go to the Layout menu and open the Move Object 
submenu.

Step 3 Select one of the commands in the Move Object 
submenu:

Select “To Front” to bring the selected object in 
front of all other objects.

Select “To Back” to move the object below of all 
other objects.

Select “Forward” to move the object one place 
forward, that is over the nearest object in the Z 
order.

Select “Back” to move the object one place back-
ward, that is below the nearest object in the Z 
order.

Text Object

With the Text object, a small text block can be placed on the 
page. A block of text in a text object is considered as a 
whole and its attributes are applied to the whole text. If text 
is to be inserted with different formatting options, they must 
be incorporate as an OLE object from another application 
(e.g. Microsoft™ WinWord™). While a text object can be 
rotated, an OLE object cannot. Use the Text tool to place the 
text block on the document’s page.

To insert a block of text:

Step 1 Select the Text tool.

Step 2 Click with the left mouse button where the text is 
to be placed.

Step 3 The text dialog window is opened and text may be 
added.
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Step 4 Open the Font dialog box by pressing the Font 
button and selecting the desired font.

Step 5 Set alignment and rotation.

Step 6 Press the OK button.

Figure 10-6 Text Properties window

The rotation value must be specified in degrees; the direc-
tion is counterclockwise. To modify an existing text object, 
use the Select Tool and double-click on the text with the left 
mouse button, or select it and press Alt+Enter, or use the 
“Properties” command in the Edit menu.

The size of a text object is calculated by the application, and 
cannot be resized.

How to insert subscript and superscript character

In the text strings used for the text object, the calculated 
value object and the graph’s axis title, you can insert format-
ting characters to instruct the application to draw subscript 
and superscript characters.

The escape sequence is composed by two characters \ (back-
slash) and a single digit number. At the start of the text, nor-
mal height text is selected. Each subscript or superscript 
sequence should be ended by a normal escape sequence.

Escape sequence  Effect
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For example the text L\2eq\0 will be drawn as Leq.

Line Object

Use the Line tool to insert Line objects in the current layer.

To draw a line:

Step 1 Select the Line tool.

Step 2 Click with the left mouse button at the starting 
position.

Step 3 While holding down the button, drag the mouse 
until the pointer reaches the ending line position.

Step 4 Release the mouse button.

To change the size of an existing line object:

Step 1 Select the line object with the Selection tool.

Step 2 Move the pointer over one of the highlighted han-
dles.

Step 3 Click with the left mouse button.

Step 4 Drag the handle to the new position.

Step 5 Release the mouse button.

\0 Plain text

\1 Superscript text

\2 Subscript text
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Figure 10-7 The Line Properties window

To change the line’s attributes use the Select Tool and dou-
ble-click on the line with the left mouse button, or select it 
and press Alt+Enter, or use the “Properties” command in the 
Edit menu.

Pressing the Line Attribute button will open the Line Attri-
butes window where the line attributes can be set.

Figure 10-8 The Line Attribute window

In the Style list-box, select the line style. To change the 
color, press the Change Color button. The last parameter is 
the line thickness.
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To add or modify line styles press the Edit button at the right 
of the style list-box. The Edit Line Style window will be 
opened.

Figure 10-9 The Edit Line Style window

Along with the name, the length of each piece of line or 
space must be defined. Up to five lines and spaces can be 
defined.

Upon obtaining the desired style, use Append to add the cur-
rent style at the end of the list, or insert, to insert before the 
style being edited, or Replace, to replace the current style.

Line styles are automatically saved in the application INI 
file.

Polygon Object

The Polygon tool is used to insert a Polygon object in the 
current layer.

To insert a polygon:

Step 1 Select the Polygon tool.

Step 2 Click with the left mouse button on the first point 
and release the button.

Step 3 Move the pointer to the second point and click one 
more time to release.
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Step 4 Repeat step 2 for all of the other polygon points.

Step 5 When the last point has been placed, double-click 
with the left mouse button. This will terminate the 
polygon.

Polygons are automatically closed by the program.

To change the shape of an existing polygon object:

Step 1 Select the polygon object with the Selection tool.

Step 2 Move the pointer over one of the highlighted han-
dles.

Step 3 Click the left mouse button and drag the polygon 
point to the new position.

Step 4 Release the button.

To change polygon properties, you use the “Select Tool” and 
double-click on the polygon with the left mouse button, or 
select it and press Alt+Enter, or use the Properties command 
in the Edit menu.

Figure 10-10 The Polygon Properties window

Available properties for a polygon are the border line attri-
butes and the filling style. Line attributes can be changed as 
in the Line Properties window. Fill attributes can be changed 
by pressing the Fill button.
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The Fill Attribute window is displayed, and the desired fill-
ing pattern can be selected.

Figure 10-11 The Fill Attribute window

The background color, foreground color, or the Background 
Mode can then be changed. The last parameter is valid only 
for the predefined Windows hatch patterns.

To add or modify a pattern style, select it and press the Edit 
button on the right of the list. The Edit Fill window is dis-
played.

Figure 10-12 The Edit Fill window
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Along with the name, the pattern itself must be defined. 
Click on the pattern checkerboard to add or remove pixels 
and look at the change in the Sample area. Once the desired 
style is obtained, use Append to add the current style at the 
end of the list, insert, to insert before the style you are edit-
ing, or Replace, to replace the current style.

Fill styles are automatically saved in the application INI file.

Rectangle Object

The Rectangle tool is used to insert rectangle objects in the 
current layer.

To insert a rectangle

Step 1 Select the Rectangle tool.

Step 2 Click with the left mouse button on the first rect-
angle corner.

Step 3 Drag the mouse and move the pointer to the oppo-
site rectangle corner.

Step 4 Release the mouse button.

If the Shift key is kept down while dragging, the rectangle is 
automatically changed to a square.

To change the rectangle size:

Step 1 Select the rectangle object with the Selection Tool.

Step 2 Move the pointer over one of the highlighted han-
dles.

Step 3 Click with the left mouse button and draw the han-
dle to the new position.

Step 4 Release the button.

To change rectangle properties, use the Select Tool and dou-
ble-click on the rectangle with the left mouse button, or 
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select it and press Alt+Enter, or use the Properties command 
in the Edit menu.

Figure 10-13 The Rectangle Properties window

Along with the rectangle coordinates the fill attributes and 
the border line attributes may be changed.

Rounded Rectangle Object

This object has the same user interface as the rectangle. The 
only difference is a resize handle that appears inside one of 
the rectangle corners. This handle is used to change the 
roundness of the corners.

Ellipse Object

Use the Ellipse tool to insert ellipse and circle objects in the 
current layer.

To insert an ellipse:

Step 1 Select the Ellipse tool.

Step 2 Click with the left mouse button on the first cor-
ner.

Step 3 Drag the mouse to the opposite corner.

Step 4 Release the mouse button
Data-Navigation-Analysis Objects  10-19



If the Shift key is kept down while dragging, the 
ellipse is automatically changed to a circle.

To change the shape of an ellipse object:

Step 1 Select the ellipse object with the Selection Tool.

Step 2 Move the pointer over one of the highlighted han-
dles.

Step 3 Click with the left mouse button and draw the han-
dle to the new position.

Step 4 Release the button.

To change ellipse properties use the Select Tool and double-
click on the ellipse with the left mouse button, or select it 
and press Alt+Enter, or use the Properties command in the 
Edit menu.

Along with the bounding rectangle coordinates, the fill attri-
bute and the border line attribute may be changed.

Calculated Value Object

Use the Calculated Value tool to insert value objects in the 
current layer. Value objects are special types of text objects, 
because they behave like text objects, but the text is calcu-
lated by the application.

To insert a value object:

Step 1 Select the Value Tool.

Step 2 Click with the left mouse button where the text is 
to be placed.

Step 3 The Value Properties window is opened and the 
parameters for how the value is to be calculated 
are set.
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Step 4 Press the OK button

Figure 10-14 The Value Properties window - General page

To set up a value first select from the group list-box, then 
select an appropriate value from the value list-box. The Ref-
erence parameter is enabled only for the Measurement, 
Channel and Graph groups.

The General group includes the following values:

• User Information entered at time of setup or in the User 
Information page.

• Number of the page.

• Printing date time.

The Document group includes the document file names and 
the fields from the document’s summary information.

The Measurement group includes the following values:

• Measurement Name, Date, Time, Site, Operator, Instru-
ment, Calibration and Annotation. These fields are the 
same fields the user must enter when a new measurement 
is started.

• Other measurement values are the number of spectra (or 
temporal items), the number of channels, the total mea-
surement RunTime and the Delta time.
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The reference source used to calculate these values can be 
selected directly from the Measurement combo-box. To use 
a measurement as a reference source, click on the measure-
ment radio button and select the desired measurement from 
the list. A data source from a graph may also be used as a 
reference source. To use a Graph data source, click on the 
Through a Graph radio button and then select the data source 
from the list.

The Channel/Category group includes:

• Channel name.

• Filter type (for spectral channels).

• Band type (for spectral channels) e.g.: 1/1 octave, 1/3 
octave and so on.

• First and Last defined band and number of bands (for 
spectral channels).

• Measurement condition as Detector, Average, Weight, 
High and Low pass filters.

• Calibration Offset eventually introduced by the user 
inside the application.

• FFT window type.

The measurement used to calculate these values can be 
selected directly, or can be referenced through the Data 
Source of a graph.

The Graph group includes:

• The position and value of the main cursor.

• The Minimum Value/Maximum Value.

• The total Leq or SEL value, at the end of the measure-
ment, regardless of which part of the signal is displayed.

• The partial Leq or SEL value, the Leq or SEL of the sig-
nal displayed in the graph.

The Measured Values group includes:

• One of the measured values.

• The minimum value.

• The maximum value.
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• The mean value.

• The standard deviation value.

• An LN value if the selected Data supports the cumulative 
calculation.

The Calculated Value object is very flexible and it is likely 
that other groups or values will be added to it in the future.

Figure 10-15 The Value Properties window - Layout page

The value properties related to the text displayed can be set 
in the Layout page.

Position Enter the calculated value reference point position in page coor-
dinates. 

Prefix text Enter a text that precedes the value string. 

Postfix text Enter a text that follows the value string. 

Font Click this button to change the font type. 

Numeric 
format

Set the numeric format used to convert numbers to strings. Some 
representable values are not numbers and they ignore this set-
ting. 

Layout - Unfor-
matted text

Select this option to combine the prefix, value string and postfix 
in a single string. The text alignment and rotation are also 
selected.
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How to insert subscript and superscript characters

In the text strings used for the text object, the calculated 
value objects and the graph’s axis title, formatting characters 
can be inserted to instruct the application to draw subscript 
and superscript characters.

The escape sequence is composed by two characters \ (back-
slash) and a single digit number. At the start of the text, nor-
mal height is selected. Each subscript or superscript 
sequence should be ended by a normal escape sequence

Escape Sequence Effect

Plain text

Superscript text

Subscript text

Layout - Use Tab-
ulator

Select this option to leave the prefix, value string and postfix 
drawn independently. For each item the offset position must then 
be set (from the object reference point). Each section accepts an 
alignment setting that shoud be useful to line up multiple value 
objects.

\0

\1

\2
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For example the text L\2eq\0 will be drawn as Leq.

Figure 10-16 The Value Properties window - User Info page

In the User Information page every user can define the con-
tents of the user information fields.

Marker Object

Use the Marker Tool to insert marker objects in the current 
layer. Marker objects are a special kind of object used to 
indicate something on the document page. There are two 
kinds of marker depending on the type of connection: Graph 
Marker and Free Marker.

The first type, the Graph Marker, is connected to a data point 
displayed in a graph; this marker will follow the connected 
graph when it is moved or when it is copied to the clipboard. 
Graph markers are deleted when the connected graph is 
deleted.

The second, Free Marker, is not connected to other objects, 
but is connected to a page coordinate.

To insert a marker

Step 1 Select the Marker Tool.
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Step 2 Click with the left mouse button on the desired 
location of the marker. By clicking on a graph, a 
Graph Marker is created and connected to the 
main cursor position of the current graph’ s data 
source. By clicking any place outside a graph, a 
Free Marker is created and connected to the indi-
cated coordinate point. 

Step 3 The Marker Properties window is opened. Set the 
parameter for the new marker.

Step 4 Press the OK button

The Marker Properties window is divided into four pages.

On the first page the reference position for Unconnected 
Markers is set. For Graph Markers, the reference parameters 
are displayed but cannot be changed. 

Figure 10-17 The Marker Properties - General page

Marker types are selected among three choices

Text Marker Display in the marker window an arbitrary user text block

Picture Marker Display in the marker window an image (either bitmap or meta-
file) 
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At the bottom of the window, the marker window’s offset 
can be specified. This is the distance of the window from the 
connection point.

Figure 10-18 The Marker Properties window - Layout page

On the Layout page, the parameters that control the Marker 
appearance are selected.

For the connection the choices are:

No connection line is drawn.

A line will connect the marker window to the connection point.

A line with a terminating arrow will connect the marker window 
to the connection point. 

When the connection style box is chosen, the line attributes 
and arrow size can be set. For the marker window, the border 
line attributes, fill attributes and the Frame Oversize can be 
set.

Value Marker Display the value of the connected point. This type is disabled 
for Free Markers since there is no value to be displayed. 

None

Line 

Arrow+Line
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The connection line is linked automatically to the marker 
window. The program chooses as a link point, the nearest 
handle on the marker window.

The Picture page controls the parameters of a Picture Marker 
type. If the marker type is not a picture, then this page is dis-
abled.

Figure 10-19 The Marker Properties window - Picture page

Images used in Picture Markers are stored in the document 
and displayed in the Select Picture list-box. To add images to 
this list, use the Import Picture button. Images can be 
imported in two formats: Windows Metafile (*.wmf or 
*.emf) or Windows Bitmap (*.dib or *.bmp).

The selected image can be deleted from the list with the 
Delete Picture button. Remember, however, that the list is 
shared with all markers in a document, and the picture used 
by another marker could be deleted.

Once the picture is selected, its size can be changed by spec-
ifying the Width and Height. Clicking on the Keep original 
aspect ratio will change the picture height in order to match 
the original proportion.
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On the Text page, the parameters that control the text and 
value marker types can be set.

Figure 10-20 The Marker Properties window - Text page

The Marker Text edit control will be enabled only for Text 
Markers. The Font used to draw the text and the alignment 
can be selected.

Resizing or moving a marker directly is done with the 
mouse:

Step 1 Select a marker.

Step 2 Click inside the marker window and drag the 
pointer to move the marker window. The connec-
tion point will not be moved; only the window off-
set will change.

Step 3 Click on the connection point handle and drag the 
pointer to move the connection point. For Free 
Markers the handle can be moved anywhere on the 
page. For Graph Markers, the point can be moved 
only along the connected data source curve.
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Figure 10-21 Picture Marker example

To resize the marker window, click on one of the active 
marker window handles. Handle activation is shown by the 
change in cursor shape when the cursor is moved over the 
handle. As is shown in Figure 9-21, the active handles are 
those at the opposite side of the connection line. Window 
size can be changed only for Picture Type markers.

XY Graph Object

XY Graph objects are used to display measurement data.

To insert an XY Graph:

Step 1 Load a measurement from the analyzer, or import 
from another document. If no measurement data 
exists, an empty XY Graph is drawn.

Step 2 Select a command from the XY Graph submenu in 
the Insert menu. Use New to create a completely 
new graph, or use Load... to load a predefined 
graph template.

Step 3 If New is chosen, the XY Graph properties win-
dow is displayed immediately and the graph’s 
parameters can be set. When finished, press the 
OK button.

Step 4 If Load is chosen, the loaded graph object is 
placed on the page and displayed.
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Figure 10-22 XY Graph example

An XY Graph object can be divided into several compo-
nents: the graph area, main axis, derived axes, legend, data 
cursors, data cursor window, and overall bars. When a graph 
is selected, in addition to the usual resize handles, one or 
more hollow handles are displayed to indicate which compo-
nent is selected. For example, if the selection tool is placed 
over the main axis, then the graph is normally selected and 
the main axis component is selected. This will enable all the 
commands that require a selected graph, but also the com-
mands that require a selected axis (e.g. Axis Autorange tool 
in the Graph Tool’ s palette).

The graph area is the rectangle where the data curve is 
drawn. Curve traces are always clipped at the graph area 
boundaries.

A graph has an axis in the horizontal and vertical direction. 
An axis is identified by its Measurement Unit. Derived axes 
must always have a Measurement Unit compatible with the 
main axis unit.

A graph has only one main axis, but it can have up to 10 
derived axes. Each pair of main/derived axes defines which 
data source can be graphed.

A data source defines from which measurement data is taken 
and how it must be displayed. A data source is linked to a 
main/derived axes pair. Each data source has two data cur-
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sors; each data cursor holds a single data point, and can dis-
play it’s value in the data cursor window.

The data cursor window displays data cursor values. Only 
the data cursor of the current data source can display it’s 
data. However, along with its data it can also display data 
from other compatible data sources in the graph. Moreover, 
a graph can have other components like a legend that dis-
plays a caption for each data source in the graph, or the over-
all bars (only if the main axis units are Hz).

Since the mouse can be used to move (and resize) an object 
and to move the cursor inside a graph object, the application 
distinguishes the two operations with the use of the Ctrl key 
while doing the mouse operation. The application knows 
whether or not to move objects when Ctrl is released and 
move cursors with the Ctrl key pressed, or vice versa, by the 
setup Application Preferences in chapter 4. 

An XY Graph object is setup through a set of connected dia-
log boxes. The main XY Graph properties window has sev-
eral subcomponent dialogs. Some of these dialogs can be 
reached directly with a single mouse action. For example, 
double-clicking on an axis will open the properties window 
for that axis.

XY Graph Main Properties

The XY Graph Properties window can be opened in several 
ways:

Step 1 Double-Click on the graph area.

Step 2 Select the graph and press the Edit Graph button in 
the Graph Tool’ s palette.
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The XY Graph properties window is made up of five pages.

Figure 10-23 The Graph Properties window - General page

On the General page, the following parameters can be 
entered:

Identify one graph from another. It is very important to give a 
different name to each graph since the name will be used in the 
combo-box and the list-box to select parameters that reference a 
graph. 

The position of the lower left corner of the graph area on the 
document page. 

The size of the graph area. 

Press the Border button to set line attributes for the graph area 
border. 

Press the Background Fill button to set fill attributes for the 
graph area background. 

Graph Name

Origin Position

Size 

Line Style

Fill Style 
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Figure 10-24 The Graph Properties window - Axis-Data page

On the Axis-Data page, three groups of controls are dis-
played:

Select the main axis position between Horizontal and Vertical, 
and open the main axis properties window clicking on the Edit 
Button. 

The list-box displays the list of derived axes. Press the Edit But-
ton to open the properties window for the selected derived axis. 
Press New... To add a new derived axis (Max. 10 axes). Press 
Delete to delete the currently selected axis. Deleting a derived 
axis will delete all the data sources bound to that axis. The last 
remaining axis cannot be deleted.

The list-box displays a list of the data sources bound to the 
derived axis selected. Press Edit... To open the properties win-
dow for the selected data source. Press New... To add another 
data source. Press Delete to delete the current data source. 

Main Axis 

Derived Axes

Displayed Data
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Figure 10-25 The Graph Properties window - legend page

On the legend page, the parameters for displaying the graph’ 
s legend are established. The graph’ s legend will hold a cap-
tion for each of the data sources in the graph.

Display mode The Display mode field allows selection of when and how to dis-
play the legend. The legend can be docked to one of the graph 
sides or can be freely positioned. In the latter case, captions can 
be laid out horizontally or vertically. 

Options This group of check boxes allows selection of which compo-
nents of the legend string must be displayed. The measurement 
name is always displayed. 

Offset Is the offset from the graph origin of a free type legend.

Size Is the size of the legend rectangle. For a docked legend only one 
side is selectable. Captions are not clipped at the legend rectan-
gle boundary.

Border The Border button is used to set border line attributes.

Fill Use the Fill button to set legend fill attributes.
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Figure 10-26 The Graph Properties window - Cursor page

On the Cursor page, parameters for the Data Cursor window 
are set.

Font Use the Font button to select the font used with the legend. All 
captions are drawn with the same font but using the color of the 
respective data source curve. 

Display Cursor 
Window

Select from this combo-box the position of the data cursor win-
dow. It can be docked at one of the four corners of the graph area 
or it can be freely positioned. However, when the window is free, 
it cannot be positioned outside the graph area.

Offset Is the offset from the graph origin when the window display 
mode is free. 

Display data 
from unselected 
curves

The “Display data from unselected curve” function will include 
values at the same cursor position collected from the other curves 
in the graph.

Interpolate data 
from unselected 
curves 

This check box is enabled only if the previous one is checked. If 
this field is checked, data from other data sources are interpo-
lated. Otherwise, the value nearest to the cursor position is dis-
played.
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Figure 10-27 The Graph Properties window - Reference curves 
page

The Reference Curves page show parameters for displaying 
a set of reference curves.

Reference curves are a set of curves that can be plotted on a 
graph with main axis in Hz (vs Freq graphs), and can be 
compared to the plotted spectrum. These parameters are 
enabled only for vs Frequency graphs.

Line Style Click here to set the data cursor window border attributes.

Fill Style Click here to set the data cursor window fill attributes.

Font To set the data cursor window font.
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Included reference curves are the ISONR, LFNR, Loudness 
curves and ISO-LXY.

Use this combo box to select the active reference curve. This box 
displays only the curves already loaded in the document. By 
default, no reference curves are loaded in the document. Use the 
Load Curves... Button to load a curve inside the current docu-
ment.

Used to set when the curves are drawn, before or after the data 
curves.

This group of fields controls the appearance of labels beside each 
curve. Labels may be drawn at the default position, the left, the 
right, or not drawn at all. The Font button enables setting of the 
font for curve labels, while the offsets can be used to adjust the 
label position.

Click here to set the pen color and style to be used to draw the 
reference curves.

Set this check box to see the result value for each displayed spec-
trum in the cursor window. 

Set this check box to draw the reference curve corresponding to 
the result value. The accessory pen in the data source is used to 
draw the resultant curve. 

Axis Properties

The Axis Properties window can be opened in several ways:

Step 1 Double-Click on the axis.

Step 2 Select the axis and press the Edit Axis button in 
the Graph Tool’ s palette.

Step 3 From the Axis-Data page described above.

Step 4 Click with the right mouse button on the axis and 
select Properties in the context menu.

Reference Curve

Curve drawing 
order

Curve labels

Pen attributes 

Display results 
along with cursor 
values

Draw resulting 
curve 
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The Axis properties window is made up of five pages.

Figure 10-28 The Axis Properties window - General page

On the general page, the following parameters are estab-
lished:

Measurement 
Unit

This is the identification parameter of the axis. The list of 
choices presented in this combo-box are different from the main 
axis and derived axes. For a derived axis the list is a function of 
the main axis unit.

User Unit The default setting establishes for the axis, the same name as the 
Measurement Unit. This field can be changed to display the 
same unit with another name. Used in conjunction with the User 
Conversion Factors, this enables scaling of the axis unit. For 
example, if sec were selected as the axis unit, but the desired 
scaling was in minutes, change the User Units to m (or some 
other selection). When the field is changed then the User Con-
version Factors will be enabled. Set the divider to 60 and the 
axis will be displaying minutes instead of seconds.

Axis Type This radio button group allows selection of linear scaling or log-
arithmic scaling for the axis. Log Special is a special logarithmic 
axis and is enabled only for Hz axis.

Overall Values Opens the overall bars setup window. This button is enabled 
only for main axis with Hz units. 
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Figure 10-29 The Axis Properties window - Scaling page

The Scaling page allows setting of the scaling parameters.

User Conver-
sion Factors

Use these parameters to scale the axis to a unit different from the 
selected default. This field is enabled only when the User Unit 
name is changed. See User Unit for an example.

Offset The Offset from graph origin enables the axis to be moved away 
from its default position. 

Line Style Use this button to change the Axis line attributes.

Start This field defines the beginning of the axis. For Log axis it must 
be greater than 0.

Stop This field defines the axis end. It must be greater then Start.

Major Division 
Interval

The interval at which major divisions are laid down. Major divi-
sions have ticks and labels and must be greater then 0. A Log 
axis represents the division interval as an exponent of 10. If it is 
set to 2, then the division will occur every 102 or 100 units.

Major Division 
First Value

The first value displayed. It must be greater than, or equal to 
Start, and less than Stop. 
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When the Log special axis type is selected in the General 
page, the scaling page will not display the Minor division 
interval.

Figure 10-30 The Axis Properties window - Scaling page (Log 
Special axis)

Instead, a radio button group is displayed which enables 
selection from three different axis divisions:

Normal Divides the axis as it is divided in the standard recording paper, 
used in old style instruments. 

Every 1/3 Divides the axis every 1/3 octave.

Every 1/1 Divides the axis every 1/1 octave.

Major Division 
Last Value

The last value displayed. It must be greater than the First value 
and less than, or equal to Stop. 

Minor Division 
Ticks

Minor divisions only display tick marks. Sets how many minor 
divisions for each major division.
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Figure 10-31 The Axis Properties window - Ticks page

On the Ticks page, the tick mark appearance is set.

There are two identical groups of control, one for the Major 
ticks and the other for the Minor ticks.

Ticks This combo-box has the following items: No, to hide ticks, 
Before, to draw ticks before the axis line, After, to draw after the 
axis line and Across to draw across the axis line.

Length This field defines the tick length.

Show grid Lines Check this to show the grid line for this tick.

Grid Line Style Click this field to change the tick line attributes.
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Figure 10-32 The Axis Properties window - Labels page

The Labels page shows the parameters which control the 
label attributes.

Labels This combo-box has the following items: No, to hide labels, 
Before, to draw labels before the axis line, After, to draw after 
the axis line and Across, to draw across the axis line.

Offset This field defines an offset value to move the label.

Label format The Label format group controls how the numbers are converted 
to text. Prefix and Postfix labels are user defined text strings. 

Font Click this button to change the font used to draw labels. 

Label Color Click this button to change the color used for labels. 

Display as Date 
and Time

This field is enabled only for axes displaying time, and to enable 
the display of time as absolute values (date and time or calendar 
values). If this field is checked, the page changes as in the fol-
lowing figure.
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Figure 10-33 The Axis Properties window - Labels page 
(Absolute time)

Additional fields are:

Time first Specifies whether to display the time before the date; by default 
it is unchecked and date precedes time. 

Date group A group of check boxes that control the date display; check 
which date element is to be displayed. 

Time group A group of check boxes that control the time display; check 
which time element is to be displayed.

Example A read only field that displays how the date and time will be dis-
played in the graph.
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Figure 10-34 The Axis Properties window - Title page

The Title page sets the parameters for the axis title

Title  The title string.

Title Position This combo-box has the following items: No to hide title, 
Before to draw title before the axis line and After to draw after 
the axis line. 

Title Offset Moves the title away from its default position. 

Font Changes the font used to draw the axis title. 

Title Color Changes the color used for the axis title.

Data Source Properties

The Data Source Properties window can be opened in sev-
eral ways.

Step 1 Double-Click on the data source caption

Step 2 From the Axis-Data page described above
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The Data Source properties window is made up of six pages.

Figure 10-35 The Data Source Properties window - Data Source 
page

The Data Source page shows which data will be drawn.

Measurement This combo-box holds the list of measurement’s that have data 
compatible with the main/derived axis pair. If a measurement 
has no compatible data then it is not included in this list.

Channel/Category This combo-box holds the list of channels or categories of the 
selected measurement that have data compatible with the main/
derived axis pair.

Value This combo-box holds the list of values that can be displayed 
from the Measurement-Channel selection above. 

Spectrum/Frequency This group of controls enables selection of which spectrum will 
be displayed (on vsFreq graph) or which frequency will be dis-
played (on vsTime graph) when the selected value is a spectrum 
value.

Display as This field is enabled only for octave spectrum measurement with 
bandwidth finer then 1/1 octave. It enables display of an octave 
spectrum in a band bigger than the original; for example a 1/3 
octave spectrum could be plotted in 1/1 octave with automatic 
value conversion. 
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Figure 10-36 The Data Source Properties window - Curve page

The Curve page sets the curve appearance with the follow-
ing options:

Curve mode Defines the type of curve used to draw the data choices: lines, 
bars, and bar contour.

Line Style This button changes the line attributes.

Bar fill Style This button changes the bar fill attributes.

Line Style This button changes the line attributes of the accessory curve. It 
is used to draw the resultant curve when the reference curve is 
selected in a graph, and to draw the resultant curve of the acous-
tic insulation measurement.

 Link to cursor Press this button to define a linkage between the spectrum/fre-
quency and a cursor on another graph. Linking a value to a cur-
sor allows a vsFreq graph to display the spectrum corresponding 
to the cursor position of another graph. Changing that cursor will 
automatically change the data in the Data Source.
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Figure 10-37 The Data Source Properties window - Weight page

The Weight page sets the weighting parameters for the data 
source. Controls in this page are enabled only if the selected 
data source supports weighting.

Weight Curve From this combo box, select the weight curve desired. Weight 
curves are stored inside the document. A weight curve is always 
present in a document, However, other curves can be loaded 
with the Load Curve button.

Add/Subtract This radio button selects if the application must add or subtract 
weight. The default action is to Add weight. 

Load Curve Press this button to load a new weight curve.

Integration/Derivation Use this field to perform frequency integration or derivation.

Reference Value Insert the reference value used to pass between dB and linear 
values. This field is enabled only when the data must be con-
verted to be displayed on the current derived axis.
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Figure 10-38 The Data Source Properties window - Options 
page

The Options page sets some of the option parameters. There 
are two groups of fields: the former is for displaying vs Time 
signals; the latter is for measurements with complex data 
types.

None-Display original values No vs Time option. Original measured signals are displayed.

Display running Leq Instead of the original signal, the “Running” Leq is displayed. 
At each time sample, the Leq calculated to that time is dis-
played. The last displayed value will be the total Leq.

Display running SEL Instead of the original signal, the “running” SEL is displayed. At 
each time sample, the SEL calculated to that time is displayed. 
The last displayed value will be the total SEL.

Display sliding Leq Instead of the original signal, the “Sliding” Leq is displayed. At 
each time sample, the Leq calculated on a portion of the signal is 
displayed. The user defines the size of the window and the posi-
tion with respect to the current sample.

Display Sliding LN Instead of the original signal, the “Sliding” LN is displayed. At 
each time sample, the LN calculated on a portion of the signal is 
displayed. The user defines which LN, the size of the window 
and the position with respect to the current sample.
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Example of Sliding calculation

Suppose we have a vs Time signal with 100 samples. Sup-
pose also that the sliding window size is set to 11 samples. 
The following table contains samples that will be used to 
calculate the sliding value for different sliding window posi-
tions.

Sliding window After current Across current Before current

position sample sample sample

Use samples from Use samples from Use samples from

20 20 to 30 15 to 25 10 to 20

21 from 21 to 31 from 16 to 26 from 11 to 21

22 from 22 to 32 from 17 to 27 from 12 to 22

The following graphs show an example of a Sliding LN cal-
culation used to remove undesired events from a time signal.

Sliding window size This value represents the number of samples over which, the 
Sliding Leq or LN is calculated.
For time samples near the beginning or the end of the signal, the 
effective number of samples used can be less than the number 
set here.

Sliding window position This field indicates the window position with respect to the cal-
culating sample. The window can be set before, after, or across 
the calculated sample.

Calculated LN This represents the LN calculated in the Sliding LN.
 10-50 DNA User Manual Data-Navigation-Analysis



The measurements used, are taken from an airport noise sur-
vey, where the flight events are masked by the barking of a 
dog close to the microphone position.

Figure 10-39 Flight events overlapped by dog barking.

Using a Sliding LN55 with a window size of 25 samples, 
removes the dog barking completely, leaving the flight 
events cleaned.

Figure 10-40 The previous signal “cleaned” with a Sliding 
LN55 and 25 samples window size.
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Figure 10-41 The Data Source Properties window - Cursor page

The Cursor page allows the setting of parameters for the cur-
sors in the data source. Each data source has two cursors. 
The main cursor is always enabled, while the secondary is 
disabled. The cursor can be positioned either with a left 
mouse button click inside the graph area or moved with the 
cursor keys. In either case, the Shift key acts a switch 
between main and secondary cursor: when the Shift key is 
pressed, the secondary cursor is positioned or moved. When 
it is released, the main cursor is positioned or moved.

Allow Interpolation between mea-
surement’s data

If not checked, when the cursor is positioned with the mouse, 
the application moves the cursor to the nearest valid value. If 
checked, the application calculates the real value by interpolat-
ing between the two nearest valid values. If the cursor is moved 
with the keyboard, valid values are always selected.

Adjust Axis if cursor is moved out-
side limits 

Currently unimplemented.

Line Style Click this button to change the main cursor line attributes.

Link Main cursor to... Click this button to link the cursor to the cursor in another 
graph. Moving the cursor in the linked graph will move this cur-
sor. 
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Figure 10-42 The Data Source Properties window - Format page

The Format page allows setting of how the numeric values 
are converted to text before being displayed in the data cur-
sor window.

When creating a new data source, the format for derived axis 
labels are copied in the data source.

Overall Bar Properties

The Overall Bar Properties window can be opened from the 
Main Axis Properties window, General page. Overall bars 
are available only for graphs having main axes in Hz and 
only one derived axis.
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Figure 10-43 The Overall Bar Properties window

The Overall Bar Properties window allows setting of the 
parameters to display overall bars in a vs Freq graph. These 
are the parameters and their meaning:

Display Defines the overall bar display mode. Choices are: No, do not 
display overall, Overall Linear displays overall linear bar, Over-
all Weighted displays overall weighted bars, Linear+Weighted 
displays both the linear and weighted bars. In the latter case, the 
weighted value depends on the weight applied to the data 
source. If the data source is linear, then linear and A weight is 
displayed. If the data source is weighted, then linear and 
selected overall weight is displayed.

Position Defines the overall bar position. Since overall bars are linked to 
the main axis, their position depends on the main axis position. 
Choices are Top or Right and Left or Bottom.

Offset The offset value allows fine tuning of the overall bar position. 

Bar Width This field defines the width of each bar.

Multiple Bars Selects whether multiple bars should be drawn laid out, Side by 
Side, or Overlapped.
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Link Properties

There are two kinds of link that can be established between 
graphs.

In the first, the cursor in one graph can be linked with the 
cursor in another graph. (i.e. when the cursor in the second 
graph is moved, the cursor in the first graph will also move 
to the same position.) Of course, the main axis of the two 
graphs must be compatible.

In the second, a data source in one graph can be linked to the 
cursor in the other graph, so that when the cursor in the sec-
ond graph changes position it will update the first graph to 
display data for that cursor position.

For example, a graph with the main axis in Hz (vsFreq) and 
another graph with its main axis in Sec (vsTime) both dis-
playing data from the same multispectrum measurement, the 
data source in the vs Freq graph (which displays a spectrum) 
can be linked with the cursor of the other graph. When the 
cursor is moved in the vsTime graph (i.e. click on the 2 sec. 
Position) then the vsFreq graph will automatically display 
the 2 sec spectrum of the same measurement. Even in this 
case, the axis of the two graphs must be compatible.

To open the Link Properties window, click on the Link to 
Cursor… button in the Data Source Properties page (Data 
Source page), or on the Link to Main Cursor… in the Data 
Source Properties page (Cursor page).

Figure 10-44 The Link Properties window
Data-Navigation-Analysis Objects  10-55



Three fields are in that window

Graph List of compatible graph.

Axis List of compatible derived axis.

Cursor List of compatible data source cursor.

Numeric Table Object

The Numeric Table object is used to display in a table, the 
data displayed in a graph as a graphical curve.

To create a Numeric Table object

Step 1 Select a graph which displays a valid data source 
curve.

Step 2 Select the “Numeric Table” command from the 
Insert menu If the menu item is disabled, it means 
that no graphs are selected or the selected graph 
does not contain a valid data source.

A numeric table can display all the data in the data source or 
can filter the data. The data filter can filter Max and Min 
peaks and Max and Min values. Each cell in a numeric table 
will display both the X and Y value of a data point.

Figure 10-45 Numeric Table example

To change the Numeric Table parameters, use the Select 
Tool and double-click on the table with the left mouse but-
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ton, or select it and press Alt+Enter, or use the Properties 
command in the Edit menu.

The Numeric Table Properties window is composed of four 
pages.

Figure 10-46 The Numeric Table Properties window - General 
page

The General page sets parameters for the reference, position 
and data filter of the table.

Figure 10-47 The Numeric Table Properties window - Layout 
page
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Graph  Select the graph from this combo-box.

Data Source Select the data source to connect to.

Position Is the position of the top left corner of the table. The table can be 
moved with the mouse.

Data Filter Mode This parameter enables or disables the filter mode. The choices 
are: None, data filter disabled, Max Peaks, displays N maximum 
peaks, Min Peaks, displays N minimum peaks, Max Values, dis-
plays N maximum values, and Min Values, displays N minimum 
values.

Max Number of Filtered 
Values

Specify how many values must be filtered (max. 200).

Sort Filtered Values by This field selects the sort order of filtered data. The choices are: 
None, data remain unsorted, Ascending X, Descending X, 
Ascending Y and Descending Y. 

The Layout page sets the following parameters

Table Size Specify how many rows and columns the table will have.

Column Size Specify the width of the X and Y values.

Fill Order The table can be laid down firstly by filling the rows and then 
the columns, or first the columns and then the rows.

Border Line Click this button to set the border line attribute.

Grid Line Click this button to set the internal separator line attributes 
between rows and columns.

Fill Style To change the background fill attributes.
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Figure 10-48 The Numeric Table Properties window - Format 
page

On the format page there are two groups of control one for 
the X values and the other for the Y values. Each group 
defines how numbers are converted to text, and has a font 
button.

Figure 10-49 The Numeric Table Properties window - Title page
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The Title page sets the following parameters:

Title Mode This parameter enables or disables the table title. The choices 
are: None, do not draw the title; Data Source Description, dis-
play the data source description as table title; User Title, dis-
plays a user text as title.

User Title This field has the text for the User Title mode.

Title Font… Click this button to select the title font.

Title Height Use this field to set the height of the title rectangle.

Align Use this field to set title text alignment.

Display Header Label Use this check box to enable or disable value headers, and 

Header Font Header Font… to select the header font.

Picture Object

With DNA it is possible to insert a picture onto the docu-
ment page. Picture objects can be resized in the same man-
ner as the other objects.

DNA will recognize four different picture formats. Windows 
Metafile, Windows Bitmap, TIF, and JPEG.

To insert a picture object, follow the following steps:

Step 1 Select Picture from the insert menu.

Step 2 Select the file type that needs to be imported.

Step 3 Select the file to be imported.

Picture objects can be resized in the same manner as rectan-
gle objects. To change the picture object parameters, use the 
Select Tool and double click on the picture with the left 
mouse button, or select the picture and press Alt-Enter, or 
use the Properties command in the Edit menu.
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Figure 10-50 The Image Properties window

The Image properties window has the following parameters

Position Is the position on the page of the lower left corner of the 
image.

Size Is the actual image size.

Keep original aspect ratio Selecting this check box will change the size of the image 
to match the original aspect ratio. 
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C H A P T E R
11 Measurement Processing

Introduction

In this chapter we describe the various modes available for 
processing or changing a measurement.

There are various functions that can be performed on mea-
surements. These include splitting or joining channels, 
extracting a measurement part or linking two or more mea-
surements into a single one, and duplicating or recalibrating 
measurements. But the most important processing functions 
are masking, performing a search, and calculating the rever-
beration time.

Measurement editing is performed with what we call a 
Mask. A Mask is a definition of a data range, extending both 
in the time direction and in the frequency direction. It 
defines a portion of your measurement that is to be modi-
fied. Up to now masks can completely hide the defined data 
or apply an offset to that data. A measurement can have an 
unlimited number of masks.

Masks cannot span the Channel/Category boundary. To 
mask data in the Main category and in the Sub category of a 
dual mode measurement, two separate masks must be cre-
ated. When a mask is set for a measurement, then the statisti-
cal data and overall data (for real-time spectrum 
measurement) are recalculated, to account for the change 
introduced by the mask. Besides statistical data and overall 
values, masks will change the running Leq calculation.
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Three search functions are implemented. 

• Search for pure tones inside a spectrum (or multispec-
trum measurement). 

• Search for impulses in a time signal.

• Search events in a time signal.

Measurement Information

The following measurement information can be changed. 
The name, and the other identification strings.

To open the Measurement Information properties window:

Step 1 Select a graph.

Step 2 Select the measurement data source in the graph 
that is to display information.

Step 3 Select the “Information” command from the Mea-
surement field in the Process menu.
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This window has three or more pages. Only the first page is 
used to change data in the measurement. The other pages 
will only display the measurement parameters.

Figure 11-1 Measurement Properties window - User 
Information page

On the first page, the User Information parameters are set. 
These parameters are the measurement’s name, place, ana-
lyzer name, calibration, operator and notes.

Figure 11-2 Measurement Properties window - Global page
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The Global page displays the measurement parameters. 
These include: internal measurement ID, date and time, 
number of channels, number of spectra, delta time, Run 
Time, and the number of bytes used by the measurement.

Figure 11-3 Measurement Properties window - Channel page

Each of the other pages display the channel parameters, one 
page per channel.

Duplicate measurement

To duplicate a measurement inside a document, use the 
“Measurement / Duplicate” command under the Process 
menu.

In the window displaying the existing measurement, select 
which measurement is to be duplicated, then press OK. 
Immediately after the operation, the Measurement Informa-
tion window is opened for the new measurement. The name 
or other parameters can then be changed.
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Recalibration

Figure 11-4 - Calibrate Measurement window

To recalibrate a measurement do the following:

Step 1 Select the “Calibration” command from the Mea-
surement field in the process menu.

Step 2 Select the measurement to calibrate from the list.

Step 3 In the Calibrate Measurement window, insert the 
offset value of each measurement channel.

Step 4 Select OK.

Step 5 To remove the calibration, reopen the same win-
dow and set the Calibration Offset to 0.

Creating a Mask

To create a mask first, select an appropriate graph. Only vs 
Frequency or vs Time graphs can be used to create masks. 
For example, if a Cumulative graph is selected (LN) then the 
mask command will remain disabled. Of course the graph 
must be showing the measurement data source that needs to 
be edited.

The application will use the cursor position to initialize the 
newly created mask. If both the main and secondary cursors 
are enabled, their position is used as the range boundary 
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depending on the graph type selected. To demonstrate the 
Create Mask procedure we will use the DEMO.NWW demo 
document included with the application. Start by loading the 
Piano document and go to the second page.

Step 1 Select the graph on the second document page.

Step 2 Move the cursor to indicate a time range around an 
arbitrary signal portion. Use both the main and 
secondary cursor.

Step 3 Select “Create Mask” from the Mask field, in the 
process menu. Or right click on the graph to bring 
up the menu and select “Create Mask”.

Step 4 Set the parameter of the mask in the properties 
window. Note that the Start spectrum and Stop 
spectrum are already set at the graph’ s cursor 
position.

Figure 11-5 Mask Properties window - General page

The General page you sets the following:

Mask Name This name is used to identify the mask. Since more then one 
mask can be assigned per measurement channel it is always a 
good idea to set the name to a meaningful text. The default name 
for a created mask is New Mask 1, 2, 3 etc.
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Figure 11-6 Mask Properties window - Masked Values page

The Masked Values page sets which value can be masked. A 
list box displays all the data that can be masked; each value 
has a check box that can be used to set or remove a value 
from the mask.

On the right of the screen a set of buttons enables setting or 
removing a group of items from the mask. A mask can be 

Disable Mask Checking this box disables a mask without deleting from the 
measurement. When this field is checked then the mask has no 
effect on the measurement data.

Mask Mode These radio boxes set the behavior of the mask over masked 
data. By choosing Mask, masked data will be completely hid-
den. When Offset is chosen, an offset is applied to the masked 
data.

Offset Value Is the offset used in the Offset mask mode. The offset is always 
added to the data, to subtract/lower values insert a negative 
value.

Start & Stop Spectrum These two fields define the mask extension in the time direction.
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displayed on the graph as a rectangle that delimits the mask 
size.

Figure 11-7 Mask Properties window - Display page

The Display page allows specification of how the mask is 
displayed on the graph:

Display Mask Use this check box to display or hide the mask. Hiding the dis-
play of a mask only has a visual effect. To remove the mask 
effects from the data, use the Disable Mask command on the 
General page.

Display Mode The mask rectangle can be drawn under, or below the related 
curve.

Fill Click this button to change the mask rectangle fill attributes.

Border line Click this button to change the mask rectangle border attributes.

Once all the parameters are set, press the OK button.

As soon as a mask is added or changed, the application will 
start recalculating, in the background, the statistic and over-
all data affected by the mask. The only sign of the recalcula-
tion process is a progress bar displayed in the status bar at 
the bottom of the window.
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Modifying and Deleting Masks

To modify a mask:

• Or select the “Edit Mask” command under the Mask sub-
menu in the Set menu. Choose a mask to modify from 
the list. 

To delete a mask

• Select the “Delete Mask” command under the Mask sub-
menu in the Set menu. Choose a mask to delete from the 
list.

To have these menu commands enabled, a graph with a data 
source that has at least one mask must be selected.

Split channels

The “Measurement / Split Channels” command under the 
Process menu can be used to divide the channels of a mea-
surement into two single channel measurements.

The original measurement remains unchanged.

Join channels

The “Measurement / Join Channels” command under the 
Process menu can be used to join two or more single channel 
measurements into a single multichannel measurement. The 
selected measurement must have the same sample interval 
time.

The original measurements remain unchanged.
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Link measurements

The “Measurement / Link” command can be used to link a 
sequence of measurements into a single measurement.

The selected measurement must have the same data structure 
and the same sample interval time.

Extract measurements

The “Measurement / Extract” command can be used to 
extract a portion of a measurement into a separate measure-
ment, or to split a long measurement into several pieces of 
the same length.

This can be used to isolate part of a measurement in order to 
get statistics calculation on that part only.

Figure 11-8 Extract measurement dialog window

In the first mode, called Cursor selection, the measurement 
part identified by the cursor selection is extracted. The 
Begin at and Stop at fields set the first and last sample to 
extract. The Discard selection check box, reverses the selec-
tion mode extracting the part of the measurement that is not 
selected.

In the second mode, called Even Time Interval, the interval 
time is set in seconds for each extracted piece and the syn-
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chronization mode. Note that the original measurement 
remains unchanged.

Delete Measurement

To delete a measurement from a document, use the “Delete” 
command in the submenu Measurement of the menu Pro-
cess.

Figure 11-9 Delete Measurement window

A window will display the list of measurements currently in 
the open document. Select the measurement to delete. Only 
one measurement can be selected at a time. Before DNA 
carries out this operation, it will offer to confirm or cancel 
the delete process.
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Arithmetic Operations 

The Arithmetic Operations in the Process/Operations menu 
can be used to execute various arithmetic operations 
between two measurements of the same type.

Figure 11-10 Arithmetic Operations dialog window

The Arithmetic Operations dialog window displays all set-
tings required to perform an operation.

In DNA an arithmetic operation will always happen between 
two operands.

Components of the arithmetic operation include the first 
operand (A), the operation type and the second operand (B). 
The second operand can be a constant value instead of a 
measurement.

In the operand (A) list the application displays all the mea-
surements enabled for arithmetic operations. In the operand 
B list the DNA displays only those measurements compati-
ble with the one selected as operand A. Every time the oper-
and A measurement is changed, the operand B list will 
change accordingly.

While operand A can be a multispectrum measurement, 
operand B must be a single spectrum measurements. In 
cases when the operand A is multispectrum then the opera-
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tion will be executed by using each spectrum from operand 
A and the single spectrum in operand B.

If operand A is a multichannel measurement, DNA will 
select as possible operand (B) measurements with a single 
channel, but that are compatible with the channels in oper-
and A. If this is the case then the operation will be executed 
on all channels of operand A always using the single channel 
in operand (B).

With measurements that can be weighted, operand (A) can 
be weighted before performing the operation.

Normally the four basic operations are available: sum, sub-
traction, multiplication and division. If operand (A) is a 
measurement holding dB values, then the operations with 
antilogarithm will be enabled as well. The latter are listed 
here.

10 10
A 10

10
B 10

+ log

10 10
A 10

10
B 10

– log

10 10
A 10

10
B 10 log

10 10
A 10

10
B 10 log

10 10
A 10

B+ log

10 10
A 10

B– log

10 10
A 10

B log

10 10
A 10

B log

If operand B is chosen as the constant value, then this value 
must not be 0 for division operations.

The Execute operation on Overall (LIN) and (A) values 
command enables the user to define how the operation is 
performed for those values. If this box is checked, then the 
application will execute the operation on overalls and will 
not recalculate the overall after the operation is complete. If 
unchecked then DNA recalculates the overall of each resul-
tant spectrum.
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The other optional parameter controls the behavior of the 
subtraction operation. There are situations, if the operands 
are too similar (e.g. while subtracting SPL values), where 
the subtraction operation is not logical. In these cases the 
user can control the result of the operation and prevent it 
from falling below a threshold value, and eventually replac-
ing it with a default value. At the end of a subtraction a 
warning message is displayed if that situation occurred 
during the operation.

Operations - Statistics 

The Operations / Statistics command under the Process 
menu can be used to perform standard statistical calculations 
on a set of measurements of the same type.
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Figure 90 - Statistics dialog window

Step 1 In the dialog window select the values  that must 
be calculated. The selections include Mean, Maxi-
mum, Minimum, Standard Deviation and Power 
Average. At least one of these values must be 
selected to enable the calculation. For each 
selected value a measurement will be created.
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Step 2 Select the main measurement, that is used to build 
the list of compatible measurements under it.

If the main measurement is a multispectrum measurement 
then the following parameters are enabled.

Is the unit used to calculate the position of each spectrum. Usu-
ally the time is used, but RPM, speed or position may also be 
used, provided that these values are in the selected measure-
ments.

Is the position of the first calculated spectrum in the scan unit.

Is the position of the last calculated spectrum in the scan unit.

Is the distance between one spectrum and another in the scan 
unit.

Enable this check-box to synchronize the selected measure-
ments. The value used can be selected from among the values in 
the source measurement.
Specify the level and slope used to synchronize the measure-
ments.

This is the slope the signal must have at the synchronization 
point.

Spectra in the resulting measurements will be placed 
between Start and Stop and with an increment equal to 
Delta.

For each of the selected measurements, the application cal-
culates an interpolated spectrum at the result spectrum posi-
tion, using linear interpolation. The interpolated spectra are 
then used to perform the statistics and calculate the result 
spectra.

Synchronization enables the user to align a particular event 
in the selected measurements. For example it is possible to 
execute the mean of the level decay used to calculate rever-
beration time before calculating the RT60 itself.

Multispectrum scan unit

Start

Stop

Delta

Synchronize measure-
ments

Slope
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Operations - Vector sum 

The Operations - Vector sum under the Process menu, can be 
used to calculate the acceleration vector sum over the three 
axes.

The formula used is:

 

VS Fx aw x 2 Fy aw y 2 Fz aw z 2+ + =

where:

VS is the vector sum

Fx is the factor for the x axis measurement

aw,x is the weighted acceleration in m/s² for the x axis

Fy is the factor for the y axis measurement

aw,y is the weighted acceleration in m/s² for the y axis

Fz is the factor for the z axis measurement

aw,z is the weighted acceleration in m/s² for the z axis
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Figure 91 - Acceleration Vector Sum

In the dialog box the measurement, channel, weighting 
curve and factor for each axis must be set. The data for each 
axis can be from different measurements but they must have 
the same format. The measurement for the x axis will set the 
format required for the other axes.
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Search Pure Tones

The “Search / Pure Tones” command under the Process 
menu can be used to find tones in a real-time octave mea-
surement. The selected pure tones are indicated with a 
marker connected to the frequency band of the pure tone.

NOTE: This method does not meet any 
industry standard. It is given only to give 
an idea of where the pure tone is. 

This command is enabled only when a vsFrequency graph is 
selected and a spectrum is displayed.

Figure 11-11 Search Pure Tones dialog window

In the dialog window, the parameters for the search opera-
tion must be set. The default values are the ones commonly 
used to recognize pure tones.

Difference with previ-
ous band 

The difference between the current search bands level and the 
previous bands level must be present before the pure tone is rec-
ognized. Both conditions (previous and next) must be true to 
recognize a pure tone.

Difference with next 
band 

The difference between the current search bands level and the 
next bands level must be present before the pure tone is recog-
nized. Both conditions (previous and next) must be true to rec-
ognize a pure tone.

Includes first and last 
band 

This check box determines if the first and last bands are to be 
included in the search process. Usually this is not done because 
the first and last band have only one adjacent band.
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When all parameters are set, click OK.

Markers used to indicate pure tones behave like other mark-
ers and can be modified or moved. Their existence is con-
trolled by the application; and if the search command is 
repeated, or the displayed measurement changed, they will 
be removed automatically.

Search Impulse

The “Search / Impulse” command under the Process menu, 
can be used to find impulsive components in a time signal. 
The selected impulses are indicated with a marker placed at 
the impulse position.

This command is enabled only when a vsTime graph is 
selected and a measurement is displayed in that graph. 
Moreover, that measurement must include both the SLOW 
and IMPULSE signals required to perform the operation.

Verify against equal 
loudness level 
contours

Set this check box to perform a verification on the tones found, 
against the loudness level contour. A pure tone is then recog-
nized only if no other band in the spectrum has a phon value 
greater than the pure tone.

Interpolate to find a 
tone near the cross 
band

Set this check box to instruct the application to try and find the 
tone frequency when the tone falls near the cross band fre-
quency. In this case, the highest of the two surrounding bands is 
marked as a pure tone band, and in the calculated values the 
interpolated frequency is stored. 

Use band by band 
minimum spectrum

If this option is selected, then the tone search is done on the 
band by band minimum spectrum of a multispectrum measure-
ment.

Minimum tone dura-
tion (sec) 

Select this option to search for the tone based on the minimum 
tone duration. Available only on multispectrum measurements.

Setup Tone Marker Click on this button to setup the marker used to identify pure 
tones on the graph. 
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Figure 11-12 Search Impulse dialog window

The Impulse dialog window sets the required parameters.

Indicates the IMPULSE signal to be used. This should be set 
automatically by the application. 

Indicates the SLOW signal to be used. This should be set auto-
matically by the application. 

Indicates the FAST signal to be used. This should be set auto-
matically by the application. 

Insert the difference in dB between the two signals that trigger 
the impulse recognition. The default value is 5 dB.

When the level goes below this threshold, the search operation is 
not performed. This is useful to avoid impulse recognition when 
the signal is too low.

Select the maximum impulse duration measured at 10dB below 
the FAST max value. 

Click on this button to setup the marker used to identify 
impulses on the graph.

When all parameters are set, click OK.

Markers used to indicate impulses, behave like other mark-
ers and can be modified or moved individually. Their exis-
tence is controlled by the application; and if the search 

IMPULSE signal

SLOW signal

FAST Signal

Required delta (IMPULSE-
SLOW)

IMPULSE signal threshold

Maximum duration at -10 dB 
FAST (sec)

Setup Impulse Marker 
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command is repeated, or the displayed measurement 
changed, they will be removed automatically.

Search Events

The “Search / Events” command under the Process menu 
can be used to identify sound events in a time signal. The 
recognized events are indicated with a marker at the maxi-
mum event level.

This command is enabled only when a vsTime graph is 
selected and a measurement is displayed in that graph.

Figure 11-13 Search Events - General Page

In the displayed dialog window, the required parameters for 
the Event search are set.

Threshold level Indicates the signal level that triggers the event recognition. 

Minimum event duration Insert the minimum event duration in seconds. If, after an event 
has been triggered, the signal goes below the threshold before 
the minimum time has elapsed, then the event is canceled. In the 
case where the signal goes above the threshold before the mini-
mum separation time elapses, then the event is reenabled and 
calculated from the first threshold trigger.

Minimum event 
separation 

Insert the minimum event separation in seconds, so that two con-
secutive events are indicated separately.
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Figure 11-14 Search Events-Extraction page

The extraction page contains the parameters to control the 
event extraction in separate measurements.

Set this check box to automatically extract an event from the 
source measurement to a new measurement.

Enter the name of the extracted measurements. The name is 
always suffixed with the progressive event counter value. 

Enter the number of pre trigger spectra to be stored, along with 
the event spectra. 

Enter the number of post trigger spectra to be stored, along with 
the event spectra. 

Setup Event marker Click on this button to setup the marker, used to identify 
impulses on the graph.

Extract events to new 
measurements

Extract name

Pre trigger samples to store

Post event samples to store 
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Figure 11-15 Search Events-Measurement page

While searching an event, DNA is able to generate a new 
measurement, holding values calculated on every event.

Evaluate events in a separate 
measurement

Set this box to generate a new measurement with values calcu-
lated on every event.

Event time is Defines how to calculate the time of each event. Select between 
the initial event time and the maximum time.

Each event parameters Select which parameters must be calculated for each event. 
Some values are predefined and can be enabled or disabled, 
while other statistic parameters can be defined by the user. The 
predefined values are: the event time, duration, duration at 10 
dB, Leq, Leq at -10 dB, SEL, SEL at -10 dB, Lmax, Symmetry, 
EPNL, EPNL with tone correction. The EPNL values are pres-
ent only with the Airport option.

Global parameters Select which global values must be calculated. Predefined val-
ues are: Lva, Lva day, Lva night, (Only with Airport option), 
total number of events, number of day and night events, total 
measurement Leq, Leq events only (-10 dB), Leq events 
excluded, total measurement SEL, SEL events only (-10 dB), 
SEL events excluded, Ldn.

Add statistic value Click this button to add a new user defined statistic value, calcu-
lated for each event.
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Figure 11-16  Search Events - Day/Night options

The Day/Night options window is used to set the hour when 
day and night begins. The Time options can be used when 
the time of the source measurement is given in GMT 
(Greenwich mean time), (generally used by the control sys-
tem in the airports). Setting this box, and defining the differ-
ence between local time and the GMT time, allows the 
application to correctly position the events in the local day/
night time.

Figure 11-17 Search Events - Add statistic value window

When all parameters are set, click OK.

Markers used to indicate events behave like other markers 
and can be modified or moved individually. Their existence 
is controlled by the application; and if the search command 
is repeated, or the displayed measurement changed, they will 
be removed automatically.

Delete statistic value To delete the currently selected statistic value.

Day/Night options Opens the window where the start time for the Day and Night 
period can be set.
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Frequency domain resampling

The “Frequency domain resampling” command under the 
Process menu can be used to change the frequency resolu-
tion of a spectral measurement. This command is available 
for octave band measurements and for FFT measurements. 
Moreover, an FFT measurement can be resampled in the 
corresponding octave band measurement.

Figure 11-18 Frequency domain resampling dialog window

Select the measurement that needs to be resampled from the 
list, and setup the resampling parameters.

Select this option to resample octave band measurements. The 
list will show only octave band measurements.

Select this option to resample FFT measurements. The list will 
show only FFT measurements. 

Select the frequency band you wish to convert to.

Select the number of FFT lines you wish to convert to.

Enter the minimum number of FFT lines that must be included 
in the first octave bin. Enabled only when converting from an 
FFT measurement to an octave band measurement.

Set this check box to duplicate the audio recordings (if present) 
from the source measurement to the resampled measurement.

Octave filter

FFT filter

Convert to 

FFT lines

Minimum number of 
FFT lines in the first bin

Duplicate audio 
recordings
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The resampling operation can be done only from a higher 
resolution to a lower resolution, so measurements in 1/1 
octave cannot be resampled.

Time domain resampling

The Time domain resampling command under the Process 
menu can be used to change the time resolution of a mea-
surement.

Figure 11-19 Time domain resampling dialog window

Select the measurement that need to be resampled from the 
list and setup the resampling parameters.

Time based resample Resampling will occur on the base time; i.e. if a new sample 
time of 1 hour is set, the application will sum all of the values for 
each hour.

Count based resample Each group of samples, as set in the Resampling factor field, will 
be summed into a single sample.

New sampling time (sec) Select the new sampling time.

Auto Sync time Set this option to synchronize the sample time start, in Time 
based resample mode. This feature is not implemented in the 
current version. 
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Reverberation time

The reverberation time, often referred as RT60, is the time it 
takes for a signal to decay by 60 dB. DNA can calculate the 
RT60 by using a multispectrum measurement where the 
decay has been recorded. The time calculated for each band 
is stored as an RT60 measurement.

The RT60 measurement can accumulate more than one shot, 
by taking the average of the time calculated in each spec-
trum band. The data stored for each band is the average time 
and the number of averages used to generate that value.

To perform reverberation time calculations, go to the 
“Reverberation” time command in the Architectural Acous-
tics section, of the Process menu. The behavior of that com-
mand depends on which measurement is selected in the list 
box. If an RT60 measurement is selected, then the data from 
that measurement is loaded and the calculation results will 
be added to that measurement; in this case the create wizard 
phase is skipped and the RT60 property sheet is displayed 
immediately.

Resampling factor (>1) Select the number of samples from the source measurement that 
will be summed into a single spectrum in the destination mea-
surement. 

Duplicate audio 
recordings

Set this check box to duplicate the audio recordings (if present) 
from the source measurement to the resampled measurement.
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If no RT60 measurement is selected, the application assumes 
that a new measurement is to be created and starts the wiz-
ard.

Figure 11-20 Create RT60 wizard - Description page

In the first wizard page, the usual measurement reference 
data is set.

Figure 11-21 Create RT60 wizard - Setup page
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In the second wizard page, select which octave band the 
measurement is restricted to (1/1 octave or 1/3 octave), and 
the first and last defined frequency. These values are initial-
ized to the last values used, unless the selected measure-
ment, when the command was issued, is a multispectrum 
measurement compatible with RT60 calculation; in that 
case, the default values are copied from that measurement.

At the end of the creation process, the new shot dialog win-
dow is displayed.

Figure 11-22  RT60 - New shot

The fields displayed in this page are:

Measurement This is the multispectrum measurement used to calculate the 
current shot. The combo box displays only those measurements 
that are compatible with the selected reverberation time mea-
surement.

Dynamic In this field, the dynamic amplitude used for the calculation is 
set. The reverberation time is defined for a decay of 60 dB, but it 
is nearly impossible to achieve that dynamic in the field, so cal-
culation is done on a lower dynamic, and extrapolated to the 
requested 60 dB. This value should be proportioned to your 
measurement dynamic.
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After the OK the application starts the calculation of the 
RT60 for the new shot and displays the RT60 main dialog 
window, where the database status and current shot results 
are displayed.

Figure 11-23 RT60 - Main dialog window

The fields displayed in this page are:

Start offset This value is an offset from the highest integrated value to the 
starting point. It must be used to jump over to where the decay 
slope is linear. Again this must be proportioned to your measure-
ment condition.

Backward
integration 

In this field the backward integration mode is selected. Back-
ward integration is a method to overcome the problem of signal 
fluctuation. The source signal is integrated from the end toward 
the start and the integrated signal is used for the calculation. The 
first method listed is called Standard Schroeder, this implements 
the classic Schroeder method described in “New method of 
measuring reverberation time” (1965) J. Acoustic. Soc. Am. 37, 
p.409-412. The second method is called Squared Schroeder. 
This is a variation on the Standard Schroeder that we designed 
in order to lose less dynamic. The third method called Drop 
Down, is the simpler method but should be useful with very low 
dynamic signal conditions. 

Database status This list box displays for each element, the frequency, the aver-
aged RT60 and the number of averages that contributed to the 
RT60 time.
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Figure 11-24 RT60 - Single frequency preview

The preview window displays a graphical representation of 
the RT60 calculation for each bin. Here the calculation 
results can be checked band by band. Moreover, the 
Dynamic and Start offset for each band can be changed inde-
pendently. The graph displays how the calculation was done.

Current shot This list box displays for each element, the frequency, the cur-
rent RT60 and the calculation method used. A row of asterisk 
indicates that the application was not able to calculate the RT60 
time.

New shot Click on this button to restart a new calculation.

Print Click on this button to print a test page with all of the band sig-
nals along with the slope and calculated values. This is only a 
draft print, just to give an idea of how the calculation went.

Store This button is used when the shot satisfies the calculated values 
and is able to be added to the current reverberation measure-
ment. When the store is done, the Status page is automatically 
displayed and the measurement status may be checked.

Current shot 
preview

Click on this button to display a window to inspect how the cur-
rent shot calculation has been performed, and change parameters 
band by band.
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The blue curve is the original signal; the red curve is the 
backward integrated signal; the filled vertical cursor is the 
start point and the dotted cursor is the stop point. The rever-
beration time is calculated between these two points. If the 
Dynamic or the Start offset is changed, the current band is 
recalculated immediately.

Selecting the All frequency check box will display all the 
frequencies. To change the displayed frequency, double click 
on the desired graph.

Figure 11-25 RT60 - All frequency preview

If the calculation was not done properly, the Manual check 
box can be selected to position the two cursors by yourself. 
The application then recalculates the RT60 by interpolating 
between the two cursors with the least square method.
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Sound insulation

Sound insulation has been divided in three sections. Each 
section has its own command in the Architectural Acoustics 
submenu under the Process menu. Use the first section to 
calculate the sound insulation between rooms, the second to 
calculate the sound insulation between facades and facade 
elements, and use the last for the impact sound insulation.

After the execution of the required command, a sound insu-
lation wizard will ask for all the data required to perform the 
calculation. The result of each calculation will be stored in a 
new sound insulation measurement. The contents of the new 
measurement depends on the selected section and the 
selected standard. The sound insulation wizard is similar for 
all three calculation procedures. Here we give a detailed 
description of one.

The first wizard page asks for the name and other descriptive 
parameters for the new measurement. The following page 
must be used to define how the calculation is performed.

Figure 11-26 Sound insulation - Select standard page
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Select among three options:

Which standard must be followed during the calculation. The 
choice is always between the North American standard and the 
European standard.

Select among the standard range and the wide range. Even on 
the wide range calculation, the ISO index and adaptation terms 
are always calculated on the standard range.

Select the desired octave band.

While doing the impact sound insulation calculation a sup-
plemental field can be used to enable the Impact sound 
attenuation between the bare floor and the surfaced floor.

The third page asks for the transmitting room measurements 
(for rooms), facade measurements (for facades) and bare 
floor (for impact attenuation).

Figure 11-27 Sound insulation - Transmitting room page

Fields in this page are:

Standard Select 

Calculation range

Octave band 

Measurement from 
transmitting room

Insert the list of measurements executed in the transmitting 
room. Specify one or more measurements. In the latter case, the 
mean measurement is used. If the selected measurements are 
multispectrum measurements then the Leq spectrum is used.
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Figure 11-28 Sound insulation -Receiving room page

The fourth page asks for the receiving room measurement. 

Fields in this page are:

Insert the list of measurements executed in the receiving room. 
Specify one or more measurements. In the latter case, the mean 
measurement is used. If the selected measurements are multi-
spectrum measurements then the Leq spectrum is used.

Insert the receiving room volume.

Use this button to add measurements to the list.

Use this button to remove the selected measurements from the 
list.

Room volume Insert the transmitting room volume.

Add measurement Use this button to add measurements to the list. 

Remove measurement Use this button to remove the selected measurements from the 
list.

Measurement from 
receiving room

Room volume

Add measurement 

Remove measurement 
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Figure 11-29 Sound insulation - Other parameters page

The last page asks for the remaining parameters required to 
complete the calculation.

Fields in this page are:

Select the reverberation time measurement from the receiving 
room. If no measurement is selected, or the selected one does not 
cover the required calculation range, then the default value is 
used.

Enables the background noise calculation and selects the mea-
surement with the background noise spectrum. If the difference 
between the signal level and the background noise level in a fre-
quency band is less than the requested minimum, then the calcu-
lated value for that band will be followed by an asterisk.

Enter the dividing element surface area in square meters.

The following list shows, which data are stored in the sound 
insulation measurement for each calculation.

Reverberation time

Background noise

Element surface area
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Sound insulation between rooms Stored channels are:

• Spectrum from the transmitting room.

• Spectrum from the receiving room.

• Reverberation time spectrum.

• Sound insulation D

• Normalized sound insulation Dn

• Normalized sound insulation DnT

• Transmission loss R

Stored calculated values are:

• Transmitting room volume

• Receiving room volume

• Element surface area

• ISO evaluation index

• ISO adaptation terms

Sound insulation between facades Stored channels are:

• Spectrum from the facade

• Spectrum from the receiving room

• Reverberation time spectrum

• Sound insulation D

• Normalized sound insulation Dn

• Normalized sound insulation DnT

• Transmission loss R

Stored calculated values are:

• Receiving room volume

• Element surface area

• ISO evaluation index

• ISO adaptation terms
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Impact sound insulation Stored channels are:

• Naked floor spectrum

• Spectrum from the receiving room

• Reverberation time spectrum

• Normalized insulation L’ n

• Normalized insulation L’ nT

• Impact sound attenuation delta L

Stored calculated values are:

• Receiving room volume

• Element surface area

• ISO evaluation index

• ISO adaptation terms
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Sound Power

The Sound Power command calculates the sound power 
level of noise sources using sound pressure as described in 
ISO 3744.

Figure 11-30 Sound Power - page 1
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A wizard with three pages will collect all the required 
parameters for the sound power calculation.

In the first page select the main measurement, which will be 
used as the template to display the other measurements.

The list below is rebuilt each time the main measurement is 
changed.

Select from the list which measurement is to be the main 
measurement,  and set the measurement surface area.
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Figure 11-31 Sound Power - page 2

The second page is used for the background noise settings.

It is possible to disable the background noise calculation.

If the background noise setting is enabled, one (or more) 
measurements must be selected that represent the back-
ground noise.
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Figure 11-32 Sound Power - page 3

The last page has the settings for calculating of the environ-
mental correction factor, K2.

If using the K1 factor the calculation of K2 can be disabled.

DNA supports the first two methods described in Annex A 
of the ISO 3744.
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For the approximated method select the mean sound absorp-
tion coefficient from those listed in Annex A. A user 
selected coefficient may also be used.

For the reverberation method you need a reverberation time 
measurement. The default RT60 time is used if no RT mea-
surement is selected or if the one selected does not cover the 
entire measurement range.

The last setting defines the maximum allowed value for the 
K2 coefficient.
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C H A P T E R
12 Curve Editor

Introduction

This chapter describes the Curve Editor. The Curve Editor 
window makes it possible to graphically define a spectrum 
or a weight curve, and then save it to the DNA document or 
to an external weight file.

The Curve Editor can be opened with one of the commands 
in Curve Editor submenu under the Process menu.

Three commands perform the following actions.

Open the Curve Editor window with a new default curve, that is 
a line between 0.1 Hz and 100 kHz with level equal to 0.

Select one of the weight curves in the document and load 
directly in the Curve Editor ready to be modified. This com-
mand is disabled if there are no weight curves in the document 
that can be modified.

The A weight curve, which is always included in every docu-
ment, cannot be modified.

Loading the current spectrum from the selected graph, into the 
Curve Editor will prepare the spectrum to be modified.

If no spectrum is selected then this command is disabled.

Create new curve

Edit Weight

Edit Spectrum
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Figure 12-1 Curve Editor window

The Curve Editor window can be used as a stand-alone 
application, without opening it from DNA. In this case it 
will not be possible to save the curve directly into a DNA 
document.

To use the Curve Editor as a stand-alone application go to 
the DNA installation folder and run the USRCRV applica-
tion.

Curve Editor Features

The Curve Editor has the following features:

• Frequency curve editing. Only curves in the frequency 
domain can be edited.

• The edited curve will always begin at 0.1 Hz and end at 
100 kHz. This is the range that the weight curves must be 
defined over.
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• No two points on the curve can have the same frequency 
value, moreover all points must have increasing fre-
quency value.

• The frequency axis can be logarithmic or linear. In loga-
rithmic mode the axis unit is not Hz (even though it is 
displayed as Hz), but is in units of the ISO 1/3 octave 
defined bands (from -10 to 50).

• Curve points can be edited directly on the graph. One or 
more points can be moved at the same time.

• Curve points can also be edited numerically in a spread-
sheet like window, with the ability to import data from 
another application (e.g. Excel).

• The curve can be Saved as a DNA measurement in all 
recognized octave bands and in FFT.
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Curve Editor Settings

Curve Editor settings can be divide into three categories: 
General, Horizontal Axis and Vertical Axis. The following 
dialog window reflects this subdivision.

Figure 12-2 Curve Editor properties - General page

The following table describes parameters in the General 
page.

Linear abscissa 
round-off

When the horizontal axis is in linear mode, all of the frequency 
values entered will be rounded with this parameter. Unit is Hz.

Logarithmic 
abscissa round-off

When the horizontal axis is in logarithmic mode, all of the fre-
quency values entered will be rounded with this parameter. Unit 
is in ISO 1/3 band number.

Ordinate round-off This setting will round-off all ordinate values entered. The unit 
depends on the selected vertical axis unit.
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Figure 12-3 Curve Editor properties - Horizontal Axis page

The following table describes the parameters in the Horizon-
tal Axis page.

Curve Click here to set the pen used to draw the curve.

Border Click here to set the pen used to draw the graph's border.

Background Click here to set the background color of the graph.

Axis scale mode This parameter allows the axis scale mode to be selected. It is 
possible to switch between Linear and Logarithmic and vice 
versa, using a menu command.

Every time this setting is changed the axis limits are reset to the 
default values.
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Start Axis start value (in Hz or in ISO third octave band).

Stop Axis stop value (in Hz or in ISO third octave band).

Step Axis division value (in Hz or in ISO third octave bands).

This setting is meaningful only for the Linear axis.

Labels - Start Axis first label value (in Hz or in ISO third octave band).

Labels - Stop Axis last label value (in Hz or in ISO third octave band).

Labels - Offset Offset for label position (in pixel). A positive value moves 
labels toward the outside of the graph, a negative value moves 
the labels toward the inside of the graph.

Labels - Font This setting determines the font used to draw the graph labels.

Labels - Tic Tic length (in pixel).

Labels - Rotation Axis label rotation.

Main grid This setting selects the main grid line type.

Secondary grid This setting sets secondary grid line type.
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Figure 12-4 Curve Editor properties - Vertical Axis page

The following table describes the parameters in the Vertical 
Axis page.

Unit Select the desired unit for the ordinate values.

Start Axis start value.

Stop Axis stop value.

Step Axis division value.

Labels - Start Axis first label value.

Labels - Stop Axis last label value.
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The properties dialog box can be opened with the Properties 
command in the Edit menu or from the context menu, or by 
double clicking inside the graph.

Settings for the two axis can be recalled from their respec-
tive context menus.

Curve editing

The curve editing feature has the following restrictions:

• The first point is always set to 0.1 Hz and the last point to 
100kHz. It is not allowed to delete or to change the hori-
zontal position of these points. However the vertical 
position can be changed.

• Two points cannot have the same frequency value, more-
over all point must be ordered by increasing frequency 
values.

Labels - Offset Offset for label position (in pixel). A positive value moves 
labels toward the outside of the graph, a negative value moves 
the labels toward the inside of the graph.

Labels - Font This setting determines the font used to draw the graph labels.

Labels - Tic Tic length (in pixel).

Labels - Rotation Axis label rotation.

Main grid This setting selects the main grid line type.

Secondary grid This setting sets secondary grid line type.
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The following are editing operations that can be performed 
graphically with the mouse:

Activate the selection tool (arrow cursor) from the Tools menu 
or from the toolbar.

Click on the small square around a point to select the desired 
point. To select more points continue clicking on other points 
while holding down the Shift key.

To select a group of points click anywhere inside the graph and 
drag a rectangle to cover the area that contains the points that 
need to be modified. All points inside that rectangle will be 
selected.

Select the Add points tool from the menu Tools or from the tool-
bar. Move the mouse pointer to the desired position and click 
with the left button. When the desired point has been selected,  
drag with the mouse pointer to move the point.

Select the points to delete.

Execute the Delete points command from the Edit menu or click 
on the corresponding button of the toolbar.

Activate the selection tool, click on a point and drag it to the 
new position.

The point can be moved only within the restriction limits 
described above.

Execute the command X Axis Lin <-> Log command under the 
Tools menu.

It is possible to modify the curve in numeric mode with the 
Add points manually command and the Edit Numbers com-
mand in the Edit menu.

Add points manually 

With this command one or more points can be added to the 
curve by typing the coordinate values.

Select one or more 
points

Add a point

Delete one or more 
points

Move a point with 
the mouse

Convert horizontal 
scale between Log 
and Lin mode
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Figure 12-5 Enter points dialog window

The dialog window displays the list of points currently 
defined, and two edit windows to facilitate entry of the new 
coordinate points.

Type the X value, press Enter, type the Y value and press 
Enter again to add the new point.

The points entered manually must observe the restrictions 
listed above.
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Edit numbers 

With this command you can modify the curve data in a 
spreadsheet like window.

Figure 12-6 Edit Curve dialog window

To change a value, double-click on the cell's value or select 
the cell and start typing the number.

This window has a context menu with commands to import 
the numbers from a text file or to paste the data from the 
clipboard.

For a description of these two commands see paragraph 
“Import Selection or Paste into Selection” earlier in this 
manual.
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The Point Inspector window The point Inspector is a floating window displaying the cur-
rent point data.

It is possible to edit every point one by one through the point 
Inspector.

Figure 12-7 Point Inspector window

To change a value, type the value into the correct edit win-
dow and press Enter to confirm and store.

It is possible to change the current point by using the spin 
box control.

Curve file

File operations are available through the commands under 
the File menu.

The Curve Editor can load from a weight file and save as a 
weight file or as a measurement. The Save as a weight curve 
command can be divided into two parts. Save to an external 
file or save directly to the connected DNA document. A 
measurement cannot be saved to an external file and must be 
saved directly into the DNA document.

Weight curve files exist in two formats, recognizable from 
the name extension NWG (old files from version 1.10 and 
before) and extension CWG (the new version). DNA version 
3.00 or greater will recognize both formats while previous 
versions will refuse to load the CWG files.
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Load and Save as external Weight 
file 

The following table illustrates the commands that are used to 
handle external Weight files. They are all included in the 
File menu.

This command opens a weight file and loads its data.  The 
desired format is selected in the File Type combo box.

Saves the current curve in a weight file in format CWG.

If the command is Save as or if the curve is new or it was loaded 
from a NWG file, then the DNA will prompt the user to insert 
the name of the file where the data must be saved.

Saves the current curve in a weight file in format NWG. Use this 
command only if a weight file to be used with a DNA version 
3.00 or before is to be created.

WARNING! This command allows replacement of the predefined DNA 
weight curves. It is strongly suggested that the predefined 
DNA curves not be replaced unless it is absolutely neces-
sary. In the case of replacement of one of the predefined 
weight curves, it is the responsibility of the user to enter the 
correct values again.

Save as weight curve in DNA To save a weight curve directly in the connected DNA docu-
ment execute the command Save as weight in “docname” 
under the File menu. “docname” refers to the document's 
name.

Figure 12-8 Save as Weight curve in DNA document

Open

Save and Save as

Save as weight 
curve (Vers 1)
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The dialog box allows the user to change the name of the 
weight curve and its abbreviation.

A check box enables the user to replace a weight curve with 
the same name already stored in the document.

WARNING! The A weight curve, included in all DNA documents cannot 
be replaced.

Save as measurement in DNA To save the current curve as a measurement directly in the 
connected DNA document execute the command Save as 
measurement in “docname” under File menu, where doc-
name refers to the document's name.

Figure 12-9 Save measure in DNA document dialog window

In the dialog window insert the parameters illustrated in the 
following table.

Name Type the name that the measurement will have once it is saved 
in the DNA document.
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Replace measure 
with the same name

If checked and a measurement with the same name already exist 
in the document, then DNA will replace the old measurement.

Use this option when creating a new measurement through a 
sequence of adjustments, and want to always have the same 
measurement in DNA.

Notes Inserts an optional note to be added to the measurement.

Filter Selects the type of filter for the spectrum of the measurement. 
The choices are the four standard octave bands (1/1, 1/3, 1/12, 
1/24) and FFT.

Start First bin saved for an octave band spectrum.

End Last bin saved for an octave band spectrum.

N. lines When filtering is set to FFT, this setting defines the number of 
lines in the FFT spectrum. The number of lines must be greater 
then 50.

Resolution When filtering is set to FFT, this setting defines the distance 
between two bands in the FFT spectrum. It must be greater then 
0.

Line 0 When filter is set to FFT, this setting defines the frequency of 
the first line (in Hz).

Line n This read-only field reports the frequency of the last line. It is 
calculated using the other FFT parameters.
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C H A P T E R
13 Reference Curve Editor

Introduction

Reference curves are a family of homogeneous curves used 
to evaluate sound spectra. Among the well known curves are 
Loudness (ISO 226) or ISO-NR.

In the Reference Curve Editor window it is possible to 
graphically define a family of curves and then save it to the 
DNA document or to an external file.

The Reference Curve Editor can be opened with one of the 
commands in Reference Curve submenu under the Process 
menu.

The three commands perform the following actions.

This command will open the Reference Curve Editor window 
with a new default curve. The new default curve is a straight 
line between 20 Hz and 20 kHz with all levels equal to 0.

This command allows selection of one of the previously defined 
Reference Curves in the document, and loads it directly into the 
Editor ready to be modified. This command is disabled if there 
are no reference curves currently in the document that can be 
modified.

Create new curve

Edit Reference 
Curve
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Figure 13-1 Reference Curve Editor window

The Reference Curve Editor window can be used as a stand-
alone application, without opening it from DNA. In this 
case, the reference curve will not be able to be saved directly 
in the DNA document.

To use the Reference Curve Editor as a stand-alone applica-
tion go to the DNA installation folder and run the REFCRV 
application.

Reference Curve Editor Features

The following describes the main features of the Reference 
Curve Editor:

• Reference curves can only be edited in the frequency 
domain.

• In order to edit a curve, at least one curve must exist. A 
curve is always defined by at least two points.

• The number of points along the X axis must be the same 
for every defined curve.
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• The horizontal position of the points must be the same 
for every defined curve.

• No two points on the curve can have the same frequency 
value, moreover all points must have increasing fre-
quency value.

• The frequency axis can be logarithmic or linear. In loga-
rithmic mode the axis unit is not Hz (even tough it is dis-
played as Hz), but is in units of the ISO 1/3 octave 
defined bands (from -10 to 50).

• Curve points can be edited directly on the graph. One or 
more points can be moved at the same time.

• A new curve may be inserted by interpolating from an 
existing curve.

• Curve points can also be edited numerically in a spread-
sheet like window, with the ability to import data from 
another application (e.g. Excel).

• Reference curves can have one or more points disabled. 
DNA will ignore disabled points as if the points were 
undefined. In the editor the disabled point must have a 
correct position even if disabled.

• Reference curves can have a reference value used by 
DNA to interpolate the overlapped spectrum in order to 
find a unique value for the spectrum itself. For example 
the loudness (ISO 226) curves are used to calculate the 
phons level of a spectrum.
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Reference Curve Editor Settings

Reference Curve Editor settings can be divide into three cat-
egories: General, Horizontal Axis and Vertical Axis. The 
following dialog window reflects this division.

Figure 13-2 Reference Curve graph properties - General page

The following table describes the parameters contained in 
the General page.

Linear abscissa 
round-off

When the horizontal axis is in linear mode, then all frequency 
values entered are rounded with this parameter. Unit is Hz.

Logarithmic 
abscissa round-off

When the horizontal axis is in logarithmic mode, then all fre-
quency values entered are rounded with this parameter. Unit is 
ISO 1/3 octave band number.
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Ordinate round-off The selection sets the Round-off values for all ordinate values 
entered. The unit depends on the selected vertical axis unit.

Draw labels Show/Hide the curve labels.

Labels font Defined the Font used to draw the curve labels.

Generic Curve Click here to select the pen used to draw the generic unselected 
curve.

Selected Curve Click here to select the pen used to draw the selected curve.

Invalid Curve Click here to select the pen used to draw the invalid (disabled) 
curve.

Border Click here to select the pen to draw the graph's border.

Background Click here to select the graph's background color.
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Figure 13-3 Reference Curve graph properties - Horizontal axis 
page

The following table describes the parameters contained in 
the Horizontal Axis page.

Axis scale mode Select the ordinate axis scale mode here.

Start Axis start value.

Stop Axis stop value.

Step Axis division value.

Labels - Start Axis first label value.

Labels - Stop Axis last label value.
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Figure 13-4 Reference Curve graph properties - Vertical axis 
page

Labels - Offset Offset for label position (in pixels). A positive value moves 
labels toward the outside of the graph, a negative value moves 
the labels toward the inside of the graph.

Labels - Font This setting determines the font used to draw the graph labels.

Labels - Tic Tic length (in pixels).

Labels - Rotation Axis label rotation.

Main grid This setting selects the main grid line type.

Secondary grid This setting sets secondary grid line type.
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The following table describes the parameters contained in 
the Vertical Axis page.

Select the unit desired for the ordinate axis.

Axis start value.

Axis stop value.

Axis division value.

Axis first label value.

Axis last label value.

Offset for label position (in pixels). A positive value moves 
labels toward the outside of the graph, a negative value moves 
the labels toward the inside of the graph.

This setting determines the font used to draw the graph labels.

Tic length (in pixels).

Axis label rotation.

This setting selects the main grid line type.

This setting sets secondary grid line type.

The properties dialog box can be opened with the Graph 
Properties command in the Edit menu or from the context 
menu, or by double clicking inside the graph.

Settings for the two axes can be recalled from the respective 
context menus.

Axis scale mode

Start

Stop

Step

Labels - Start

Labels - Stop

Labels - Offset

Labels - Font

Labels - Tic

Labels - Rotation

Main grid

Secondary grid
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Reference Curve editing

The editing operations on Reference curves depend on two 
different selection modes. The first selection mode enables 
the user to select one curve and act on the points of that 
curve. The second mode enables the user to select entire 
rows of points at the same horizontal position.

There are other parameters that will be used at runtime by 
the DNA application.

Figure 13-5 Curve Properties window

The Curve Properties window can be opened with the com-
mand Curve Properties under the Edit menu.

Name In this box the user can enter the name of the reference curve. 
The name will be used for selection inside the DNA document 
window.

Abbreviation Enter an abbreviation for the Reference Curve.
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While editing a curve there are the following restrictions:

• The reference curves cannot overlap.

• No two points on the curve can have the same frequency 
value, moreover all points must be ordered by increasing 
frequency values.

• In the single curve selection mode it is not possible to 
change the horizontal coordinate of a point.

Editing operations that can be performed graphically with 
the mouse are:

Default label posi-
tion

Select the default label position.

Enable interpola-
tion between refer-
ence values

Set this check box to enable interpolation between a spectrum 
and the adjacent curve. When DNA uses a reference curve with 
this flag set, it calculates the position reached by the spectrum 
and interpolates between the nearest curves in order to get a sin-
gle value for the spectrum.

Interpolation reso-
lution

This parameter sets the numeric resolution when interpolating. 
The calculated value will be rounded to this degree of resolu-
tion.

Reference value 
order inverted

By default, the reference values must increase with the level 
increase. If checked then the order of the reference values will 
be inverted.

Select a curve and 
one or more points

Activate the selection tool (arrow cursor) from the Tools menu 
or from the toolbar.
Click on a curve to select the curve.
Click on the small square around a point to select the desired 
point. To select more points continue clicking on other points 
while holding down the Shift key.
To select a group of points click anywhere inside the graph and 
drag a rectangle to cover the area that contains the points that 
need to be modified. All points inside that rectangle will be 
selected.
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It is possible to modify the curve in numeric mode with the 
Edit Numbers command under the Edit menu.

Select one or more 
points on all curves 
simultaneously

Activate the Selection X tool (arrow cursor with squares) from 
the Tools menu or from the toolbar.
Click on the small square around a point to select it, the same 
point on all curves will be selected. To select more points con-
tinue clicking on the other points while holding down the Shift 
key.
To select a group of points click anywhere inside the graph and 
drag to form a rectangle. All points inside that rectangle will be 
selected.

Add a point Select the Add points tool from the menu Tools or from the tool-
bar. Move the mouse pointer to the desired position and click 
with the left button. When the desired point has been selected,  
drag with the mouse pointer to move the point.

Add a curve Select the Add Curve tool from the Tools menu or from the tool-
bar. Move the mouse pointer to the desired position and click 
with the left button. The new curve will be interpolated between 
the nearest curves.

Delete one or more 
points

Select the points to delete.
Execute the Delete points command from the Edit menu or click 
on the corresponding button of the toolbar.
Points are always deleted simultaneously on all of the curves.

Delete a curve Execute the Delete Curve command from Edit menu to delete 
the selected curve.
This command will work only in the normal selection mode. 
The last curve cannot be deleted.

Move a point with 
the mouse

Activate the selection tool, click on a point and drag it to the 
new position.
The point can be moved only within the restriction limits 
described above.

Move a curve with 
the mouse

Activate the standard selection tool. Execute the Select All 
command in the Edit menu to select all points on the current 
curve. Click on a selected point and begin to drag that point.
The point can be moved only within the restriction limits 
described above.

Convert horizontal 
scale between Log 
and Lin mode

Execute the command X Axis Lin <-> Log command under the 
Tools menu.
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With this command the curve data can be modified in a 
spreadsheet like window.

Figure 13-6 Edit Reference Curve dialog window

To change a value double-click on the cell's value or select 
the cell and start typing the number.

This window has a context menu with commands to import 
the numbers from a text file or to paste the data from the 
clipboard.

For a description of these two commands see paragraph 
"Import Selection or Paste into Selection" earlier in this 
manual.

This window allows the user to modify the reference value 
(if interpolation is enabled) and the levels of each curve.

The horizontal position of the curve, the curve name 
(description string) and the Disable flag cannot be modified 
here.

These last parameters can be modified in the Point Inspector 
window.
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The Point Inspector window 

The Point Inspector is a floating window displaying the cur-
rent point data.

It is possible to edit every point one by one through the point 
Inspector.

Figure 129 - Point Inspector window

NOTE: Each curve has a name and a ref-
erence value (if interpolation is enabled) 
that are not the same thing (though in 
several cases they have the same value). 
The name can contain alphanumeric 
characters, while the reference value 
must be a number.

The upper half holds the curve values, while the lower half 
holds the point values.

To change a value type the correct value into the edit win-
dow and press Enter to confirm and store.

It is possible to change the current point or the current curve 
by using the spin box control.
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Reference Curve file

File management operations are available through the com-
mands under File menu.

The standard open and save commands are used to load and 
store data to and from the external Reference Curve file.

The command Save in “docname” in the File menu, where 
docname is the name of the DNA document, will save the 
reference curve directly into the connected document.

Figure 13-7 Save in DNA document dialog window

In the dialog window the name of the weight curve and its 
abbreviation can be changed.

A check box enables the user to replace a weight curve with 
the same name already stored in the document.
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